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1Abstra
t
Modeling and Software Tools for Freeway Operational PlanningbyAlexandr A. KurzhanskiyDo
tor of Philosophy in Ele
tri
al Engineering and Computer S
ien
esUniversity of California, BerkeleyProfessor Pravin Varaiya, ChairThis dissertation grew out of the author's parti
ipation in the Tools for Operational Plan-ning (TOPl) proje
t. TOPl proje
t started at Berkeley in April 2006. Its purpose is toprovide tools for quantative assessment of operational strategies designed to improve tra�

onditions on 
ongested freeways and surrounding arterials. The elements of su
h strategiesare:demand management, whi
h fo
uses on redu
ing ex
essive demand;in
ident management, whi
h targets resour
es to alleviate a

ident hot spots;traveler information, whi
h potentially redu
es traveler bu�er time; andtra�
 
ontrol, whi
h implements aggressive ramp metering at lo
ations where signi�
ant



2redu
tions in 
ongestion are likely to o

ur.TOPl models tra�
 �ows on road networks in realisti
 
onditions relying on freeway dataprovided by the California freeway Performan
e Measurement System (PeMS). PeMS of-fers an a

ounting framework for tra
king freeway performan
e, and a suite of diagnosti
tools that pinpoint the weaknesses in freeway operations. For arterial data, TOPl uses vari-ous alternative sour
es, su
h as regional planning agen
ies�MTC (Bay Area) and SANDAG(San Diego) for GIS des
ription of road networks, and 
ensus information and demographi
ssurveys for origin-destination travel patterns and demand.Ma
ros
opi
 tra�
 models represent tra�
 as a 
ompressible �uid in terms of �ow, densityand speed, as opposed to mi
ros
opi
 models whi
h seek to reprodu
e the behavior of in-dividual vehi
le as its driver responds to its environment by 
hanging its speed and lane.TOPl uses the ma
ros
opi
 approa
h, as it is based on sound theory, is easy to implement insoftware, and the implementations are fast to run, allowing the user to simulate many dif-ferent tra�
 situations in relatively short time. Our model of 
hoi
e is the 
ell transmissionmodel (CTM)�a spe
ial 
ase of Godunov dis
retization of the Lighthill-Whitham-Ri
hards�rst order model, with triangular fundamental diagram. While simple, CTM adequatelydes
ribes tra�
 �ow on freeways, and the simulation results mat
h well the measurementdata provided by PeMS. Exploring the CTM model from the point of view of nonlineardynami
al systems we des
ribe the stru
ture of its equilibrium points and the behavior ofits traje
tories under di�erent demand patterns. Then we dis
uss the impli
ations of our�ndings for ramp metering.CTMSIM is the intera
tive MATLAB based freeway tra�
 simulator of the CTM model.



3It allows plugging in user-de�ned ramp �ow and ramp queue 
ontrollers, its output results
an be dire
tly 
ompared with PeMS data, and it 
an operate in both graphi
al (intera
-tive) mode and 
ommand line (bat
h) mode. Simple and robust, CTMSIM has proved tobe a handy tool for transportation resear
hers who 
an use it for evaluating ramp meteringalgorithms and for estimating the impa
t of di�erent response times in the in
ident manage-ment. CTMSIM 
an only deal with a single freeway. It does not support arterials, freewaynetworks, or even HOV lanes.The Aurora obje
t-oriented framework over
omes the limitations of the CTMSIM. Its basi
obje
ts, nodes and links, allow the user to 
onstru
t heterogeneous road networks. Variousevent 
lasses make it possible to generate simulation s
enarios. The monitor obje
ts 
ankeep tra
k of the state at sele
ted nodes and links, 
oordinate 
ontrol a
tions at nodes,or generate events at nodes or links when the monitored states rea
h 
ertain thesholds.Monitors and events enable the modeling of the impa
t of traveler information as wellas in
ident management and the 
oordination of signal 
ontrol on arterials with the rampmetering at freeway entries. The analysis module of Aurora, whi
h is still under development,will address the issue of demand management: the goal is to solve the user equilibriumdynami
 tra�
 assignment problem and evaluate various toll me
hanisms.There are other bene�ts of Aurora.It is s
alable: the nodes of Aurora network 
an be networks themselves allowing the user tobuild the network 
on�gurations in
rementally.It is designed to be multi-purpose: the basi
 infrastru
ture and algorithms are generi
 andnot spe
i�
 to transportation; link dynami
s is implemented as interfa
e allowing to plug



4in di�erent models (
urrently only CTM is implemented). Thus, it 
an be used not just formodeling tra�
 on road networks but also for other appli
ations, su
h as irrigation 
anals,oil or gas pipelines, et
.Finally, the Aurora simulator is a standalone Java appli
ation, and as su
h it does notrequire MATLAB.
Professor Pravin VaraiyaDissertation Committee Chair
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1
Chapter 1
Introdu
tion
The Highway Safety, Tra�
 Redu
tion, Air Quality, and Port Se
urity Bond A
t of 2006,approved by the voters of California as Proposition 1B on November 7, 2006, in
ludes aprogram of funding from $4.5 billion to be deposited in the Corridor Mobility Improve-ment A

ount (CMIA). The basi
 obje
tive of CMIA is to improve performan
e on highly
ongested travel 
orridors1.Improvements that relieve 
ongestion by expanding 
apa
ity, enhan
ing operations, or oth-erwise improving travel times or redu
ing the number of daily vehi
le-hours of delay withinhigh-
ongestion travel 
orridors, may be on the state freeway system or on major a

essroutes to the state freeway system.These improvements are addressed by the Transportation Management System (TMS) Mas-ter Plan [99℄ whose system management philosophy is summarized in Figure 1.1. The pyra-

1Road networks 
omprised of freeways and urban arterials



2

Figure 1.1: System management philosophy. Sour
e: [99℄mid rests on the foundation of �System Monitoring and Evaluation�, whi
h in 
onsiderablepart is provided by the freeway Performan
e Measurement System (PeMS) [1℄2.Above this base is the �Maintenan
e and Preservation� layer, emphasizing timely interventionto e
onomi
ally maintain the 
apital assets of the State's freeway system. The middlelayers of the pyramid 
on
ern freeway operations strategies�demand management, in
identmanagement, traveler information and tra�
 
ontrol�that o�er large produ
tivity gainsat low 
ost. The two layers at the top 
on
ern 
apital expenditures: small investments inoperational improvements, su
h as in
reased ramp 
apa
ity or an extended auxiliary lane;
2PeMS provides an a

ounting framework for tra
king California freeway performan
e, and a suite ofdiagnosti
 tools that pinpoint the weaknesses in freeway operations. PeMS was initially to be a simplesystem to 
al
ulate the most basi
 performan
e measures using available sensor measurements and pro
essingalgorithms; in
ur low 
ost; and permit in
remental implementation [106℄. Over several years PeMS hasevolved into a unique database of freeway data, going ba
k to 1998, together with a suite of tools thathelp analyze these data at di�erent s
ales of aggregation and for variety of performan
e measures. At thes
ale of freeway, distri
t or the entire state, PeMS estimates freeway produ
tivity and 
ongestion; traveltime reliability; and the lo
ation, severity and frequen
y of bottlene
ks and 
ollision �hot spots�. At themi
ro-level, PeMS appli
ations reveal the impa
t of an individual 
ollision, lane 
losure or spe
ial event.



3and major investments in long-term system expansion.The Tools for Operational Planning (TOPl) proje
t started at Berkeley in April 20063.Its resear
h is guided by the TMS Master Plan, so its analysis tools mat
h the A
tion Plansthat the Master Plan envisages for the middle layers of the pyramid. A

ordingly,
• the �demand management� layer fo
uses on redu
ing �ex
ess demand�;
• the �in
ident management� layer targets resour
es to alleviate a

ident hot spots;
• the �traveler information� layer seeks to redu
e traveler bu�er time; and
• the �tra�
 
ontrol� layer implements aggressive ramp metering at lo
ations where themaximum redu
tions in 
ongestion are likely to o

ur.The obje
tive of TOPl is to provide a qui
k quantative assessment of the bene�ts that 
anbe gained from these TMS A
tion Plans.The qui
k quantative assessment provided by TOPl, 
an help rank a large set of A
tionPlans in terms of the bene�ts they will yield. Combined with a separate estimate of the
ost of these plans, TOPl 
an serve as the �rst step in sele
ting the most promising of them.This initial sele
tion may be based on bene�t/
ost ratios or the magnitude of bene�ts.The fo
us of TOPl is on operations in freeway 
orridors (road network 
omprised of freewayand surrounding arterials). A 
orridor is the smallest spatial unit that 
an be 
onsistently

3TOPl is supported by the California Department of Transportation through the California PATHprogram.



4analyzed as a self-
ontained system. Suppose, for example, that we wish to 
onsider theimpa
t of a promising new metering algorithm on some ramps on a given freeway. Evidently,this impa
t will depend on how other ramps on this freeway are metered. Furthermore, theimpa
t of metering will a�e
t (and be a�e
ted by) the signaling strategies on adja
entarterials. Thus, a good design of the metering algorithms and its proper assessment musttake the entire freeway 
orridor into a

ount.On the other hand, a major 
apa
ity expansion of a given freeway, su
h as the addition ofa lane or the extension of the HOV fa
ility, will signi�
antly alter trip patterns. That is,the 
apa
ity expansion will have network-wide impa
t, whi
h 
annot be reliably assessed bystudying the freeway alone.Thus, for the A
tion Plans of tra�
 
ontrol, in
ident management, traveler informationsystems and demand management that TOPl seeks to assess, a 
orridor is the appropriateunit of analysis. It may be useful to view TOPl as tools for planning 
orridor management.Figure 1.2 summarizes the expe
ted result of the TMS Master Plan implementation withrespe
t to 
ongestion relief and indi
ates the ni
he for TOPl.The rest of the dissertation is organized as follows.Chapter 2.We start by explaining the di�eren
e between mi
ro and ma
ro approa
hes to tra�
 model-ing and giving basi
 de�nitions relevant for ma
ro modeling. In the literature review we goover 
ontinuous tra�
 �ow models, their dis
retizations (we show how the Godunov s
hemeis applied to the LWR model) and dis
uss the related 
ontrol problem. Then we des
ribe
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Figure 1.2: Impa
t of the TMS Master Plan on 
ongestion relief.the work on ma
ro modeling of arterials. Finally, we dis
uss available software pa
kagesthat 
ould be used for the purposes of the TOPl proje
t.Chapter 3.In TOPl, our tra�
 �ow model of 
hoi
e is the 
ell transmission model (CTM). While simple,it adequatly des
ribes the tra�
 �ow on freeways, as the simulation results mat
h well themeasurement data provided by PeMS.In this 
hapter we �rst des
ribe the CTM model. Then, studying it as a nonlinear dynami
alsystem, we 
hara
terize its equilibrium points. It turns out that the stru
ture of the CTMequilibria 
an be formalized. Moreover, if the demand is stri
tly below 
apa
ity, there is a



6unique, globally asymptoti
ally stable equilibrium point. On
e the equilibrium stru
ture isestablished, we study the dynami
s of the CTM system showing that this system is monotoneand that all traje
tories 
onverge. Finally we dis
uss the impli
ations of these �ndings forramp metering.Chapter 4.Having found no appropriate software implementation of a �rst order tra�
 �ow modelwhose input 
ould be automati
ally generated and whose output 
ould be seamlessly 
om-pared with PeMS data, the TOPl group developed CTMSIM, its own intera
tive freewaytra�
 simulator for MATLAB. CTMSIM employs the CTM model, allows plugging in user-de�ned ramp �ow and ramp queue 
ontrollers. Its output results 
an be dire
tly 
omparedwith PeMS data, and it 
an operate in both graphi
al (intera
tive) mode and 
ommand line(bat
h) mode.In this 
hapter, we provide a thorough des
ription of CTMSIM. We explain its 
omputationalmodel, present its user interfa
e, show how to plug in a user-de�ned ramp 
ontroller, howto build a freeway 
on�guration and how to display the simulation results. Here we alsopresent a 
ase study of the I210-West freeway. This 
hapter 
an be viewed as a manual forCTMSIM.Chapter 5.The ultimate goal of TOPl is to 
reate an instrument for 
orridor management. AlthoughCTMSIM is a simple and 
onvenient tool for freeway modeling, it la
ks 
apabilities for
orridor tra�
 simulation and analysis. Hen
e, the TOPl group started developing Aurora,a framework for simulation and analysis of infrastru
ture networks, whose implementation



7is done in Java.In this 
hapter, we provide a des
ription of Aurora. We list the design goals, introdu
ebasi
 obje
ts used to 
onstru
t road networks and event obje
ts needed to 
reate and runs
enarios, explain the 
omputation algorithm, and des
ribe the organization of 
on�guration�les. Then we present the 
urrent version of the user interfa
e. Finally, we dis
uss the goalsof Aurora development and their priorities. This 
hapter 
an be viewed as an Aurorate
hni
al report.Chapter 6.In this 
hapter we state the problems to be solved and tasks to be a

omplished withinTOPl proje
t or as a side produ
t of TOPl a
tivities.
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Chapter 2
Review of Previous Work
2.1 PreliminariesThere exist two fundamentally di�erent approa
hes to tra�
 modeling. The mi
ros
opi
approa
h seeks to reprodu
e the behavior of an individual vehi
le, as its driver respondsto its environment by adjusting its speed and lane. Mi
ros
opi
 models typi
ally involvevariables su
h as vehi
le position, speed and headway. Thema
ros
opi
 approa
h ignores thedynami
s of the individual vehi
le and instead attempts to repli
ate the aggregate responseof a large number of 
ars. These models represent tra�
 as a 
ompressible �uid in termsof �ow, density and speed. Tra�
 engineering has bene�tted immensely from ma
ros
opi
models. They are widely used in the design of freeway fa
ilities and they are present in nearlyall model-based ramp metering designs. Be
ause of its emphasis on qui
k and quantativeassessment, TOPl's tools and pro
edures are based on ma
ros
opi
 models that are easier



9to assemble, 
alibrate, and automate, as 
ompared with their mi
ros
opi
 
ounterparts1.The Highway Capa
ity Manual 2000 [101℄ provides the following de�nitions of the basi
quantities. Symbols x and t represent position (measured in the dire
tion of tra�
 �ow)and time.Speed v(x, t) is a rate of motion expressed as distan
e per unit of time. Depending on howit is measured, it is referred to as either spa
e mean speed or time mean speed. Spa
e meanspeed is 
omputed by dividing the length of a road by the average time it takes for vehi
les totraverse it. Time mean speed is the average speed of vehi
les observed passing a given point.The latter is easier to measure in the �eld, as it 
an be obtained dire
tly from 
onventionalsensing devi
es.Free �ow speed is the average speed of tra�
 measured under 
onditions of low volume,when vehi
les 
an move freely at their desired speed.Flow f(x, t) is the total number of vehi
les that pass by the point x during a given timeinterval 
ontaining t, divided by the length of the time interval. It is usually expressed asan hourly rate, and is easily measured with road sensors.Density ρ(x, t) is the number of vehi
les o

upying a length of road about point x at timeinstant t. Its measurement is di�
ult be
ause it requires the observation of a stret
h ofroad. Instead, it is often approximated from measurements of �ow and speed as
ρ(x, t) =

f(x, t)

v(x, t)
. (2.1)

1Carrying out mi
ro simulations for all plausible A
tion Plans is not pra
ti
al. For example, a studyun
overed more than 500 bottlene
ks [71℄, the 
ongestion 
aused by whi
h 
ould be mitigated by rampmetering. It is not possible to study all these opportunities by mi
ro simulations.



10Demand is the number of vehi
les that desire to use a given fa
ility during a spe
i�ed timeperiod.Capa
ity is the maximal hourly rate at whi
h vehi
les reasonably 
an be expe
ted to traversea point or a uniform se
tion of a lane or roadway during given time period under prevailingroadway, tra�
 and 
ontrol 
onditions.Bottlene
k is de�ned as any road element where demand ex
eeds 
apa
ity. Freeway bot-tlene
ks sometimes appear near heavy on-ramps, where a lo
alized in
rease in demand is
ombined with a de
rease in 
apa
ity due to lane 
hanging.One of the early attempts to 
orrelate freeway speed, density and �ow was by Greenshields in1934 [53℄. He used photographi
 images to estimate aggregate vehi
ular speeds and densitieson a straight two-lane roadway, and found that they 
ould be reasonably well approximatedby a straight line. Using (2.1) he derived paraboli
 relationship between �ow and densityas shown in Figure 2.1. Fun
tion f = Φ(ρ) is known as the fundamental diagram. Later
Figure 2.1: Greenshields' speed and �ow relations.resear
hers have suggested alternative shapes that provide a better �t to the measured data(see Figure 2.2). All of them share the following 
hara
teristi
s:
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Figure 2.2: Alternative shapes for the Φ(ρ) fun
tion.1. Φ(0) = Φ(ρJ) = 0, where ρJ is 
alled jam density.2. Continuous portions of Φ(ρ) are 
on
ave.3. Criti
al density ρc 
an be de�ned where the maximum �ow is attained. Then, Φ′(ρ) ≥

0 for ρ < ρc and Φ′(ρ) ≤ 0 for ρ > ρcCriti
al density ρc splits the fundamental diagram into two regimes: free �ow (ρ ≤ ρc)and 
ongestion (ρ > ρc) (see Figure 2.1). Measurements on the free �ow side are usuallywell represented by a straight line, whereas measurements in 
ongestion tend to be mores
attered.
2.2 Theoreti
al Ba
kground2.2.1 Continuous Time ModelsFirst order LWR model.The simplest 
ontinuous ma
ros
opi
 model is the s
alar one proposed by Lighthill andWhitham [77℄, and by Ri
hards [93℄. Hen
e, this model is 
alled LWR. Lighthill and



12Whitham in 1955 were the �rst to pose a ma
ros
opi
 dynami
 model of tra�
 using Green-shields' hypothesis of a stati
 �ow/density relationship. LWR is based on 
onservation of
ars and is des
ribed by a single nonlinear hyperboli
 equation, also known as 
onservationlaw :
ρt + (Φ(ρ))x = 0, (2.2)where fun
tion Φ is the �ow. In this model, the average speed v is a fun
tion that dependsonly on density. The relation Φ(ρ) = ρv(ρ) is a fundamental diagram and is 
lassi
allyassumed to be 
on
ave (does not need to be parabola, see Figure 2.3). It is de�ned for

ρ ∈ [0, ρJ ], where ρJ is the jam density and 
orresponds to the density at whi
h tra�
stops. The density ρc for whi
h the �ow rea
hes maximum (the road operates at 
apa
ity),is the 
riti
al density. Tra�
 speed v ≥ Φ(ρc)/ρc is 
alled free �ow speed. When thedensity ex
eeds 
riti
al, the road be
omes 
ongested: the tra�
 speed falls below free �ow,
v < Φ(ρc)/ρc.

Figure 2.3: Fundamental diagram.To in
lude on- and o�-ramps into the LWR model (Figure 2.4), we rewrite (2.2) in integral
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Figure 2.4: Freeway se
tion with on- and o�-ramp.form and a

ount for the on-ramp �ow ri and o�-ramp �ow si:
d

dt

∫ xR

xL

ρ(x, t)dx = Φ(ρ(xL, t)) − Φ(ρ(xR, t)) + ri − si,whi
h 
an be on
e again rewritten as
∫ xR

xL

ρt(x, t)dx =

∫ xR

xL

((Φ(ρ(x, t)))x + δ(x− x̂i)ri(t) − δ(x − x̌i)si(t)) dx, (2.3)where δ(x) is a Dira
 delta fun
tion.For multiple on-ramps (Non ≥ 1) and o�-ramps (Noff ≥ 1) equation (2.3) generalizes to
ρt(x, t) + (Φ(ρ(x, t)))x =

Non
∑

i=1

δ(x− x̂i)ri(t) −

Noff
∑

i=1

δ(x − x̌i)si(t). (2.4)Clearly, in the absen
e of ramps, equation (2.4) be
omes (2.2).Se
ond order Payne-Whitham model.The assumption of the LWR model about the average speed v depending only on densityis not valid for 
ertain tra�
 situations, su
h as 
apa
ity drop, an empiri
al feature offreeway tra�
, whi
h is the di�eren
e of the maximum observed �ow and the �ow exitingthe bottlene
k when there is a 
ongestion upstream of the bottlene
k. Hen
e, Payne [91℄



14introdu
ed an additional equation for v, produ
ing the following system of equations:
ρt + (ρv)x = 0, (2.5)
vt + vvx +

1

ρ
(Ae(ρ))x =

1

τ
(ve(ρ) − v), (2.6)where ve(ρ) is the equilibrium value for the speed, 1

ρ
(Ae(ρ))x is 
alled anti
ipation term, and

1
τ
(ve(ρ)−v) is 
alled relaxation term of v within a 
ertain time τ > 0 towards its equilibriumvalue ve(ρ). Equation (2.5) is the 
ontinuum equation and (2.6) is the a

eleration equation.Whitham himself proposed a generalization of the LWR model [108℄ adding the followinga

eleration equation:

vt + vvx +
D

ρ
ρx =

1

τ
(ve(ρ) − v)with some 
onstant D > 0. Clearly, this last equation is a spe
ial 
ase of (2.6) with Ae(ρ) =

Dρ. Therefore, a model with system (2.5)-(2.6) is 
alled Payne-Whitham model.Payne-Whitham model develops analogy with gas dynami
s. As in the gas dynami
 
ase,the term vvx is 
alled the 
onve
tion term and des
ribes a motion of the speed pro�le. Theanti
ipation term re�e
ts the rea
tion of identi
al drivers to the surrounding tra�
 situation.The relaxation term des
ribes the adaptation of the average speed v to the equilibrium speed
ve(ρ).Severe drawba
ks of the Payne-Whitham model were pointed out by Daganzo in [41℄. Inparti
ular, he showed that unlike in �uids where a parti
le's behavior depends on the parti-
les in front as well as on the parti
les behind, a 
ar parti
le is only a�e
ted by the parti
lesin front; and that in Payne-Whitham model 
ars are allowed to travel with negative speeds,whi
h is unrealisti
.



15Se
ond order ARZ model.In an e�ort to rehabilitate the se
ond order models and address the issues pointed out byDaganzo, Aw and Ras
le in [18℄ and independently Zhang in [110℄ 
ame up with the followingse
ond order, now known as Aw-Ras
le-Zhang (ARZ), model:
ρt + (ρv)x = 0, (2.7)
(v + p(ρ))t + v(v + p(ρ))x = 0, (2.8)where p = p(ρ) is a �pressure� term, an in
reasing fun
tion of density. Aw and Ras
le
onsidered

p(ρ) = ργ , γ > 0,and Zhang used
p(ρ) = −ve(ρ) = −

Φ(ρ)

ρ
.Third order model.The �rst third order model was proposed by Helbing in [54℄. He 
onsiders not only equationsfor density ρ and velo
ity v, but also for the velo
ity varian
e θ. The exa
t model proposedby Helbing is

ρt + (ρv)x = 0, (2.9)
vt + vvx +

1

ρ
(ρθ)x =

1

τ
(ve(ρ) − v) +

µ

ρ
vxx, (2.10)

θt + vθx + 2θvx = 2
µ

ρ
(vx)2 +

k

ρ
θxx +

2

τ
(θe(ρ) − θ), (2.11)where θe and ve are given smooth fun
tions of density ρ, and µ, k, τ are nonnegative 
on-stants. The term −k

ρ
θxx results from the �nite rea
tion and braking time that 
auses a



16delayed adaption of velo
ity to the respe
tive tra�
 situation. The term 2
τ
(θe − θ) resultson one hand from the drivers' attempt to drive with desired speed ve, and on the otherhand - from the drivers' intera
tions, i.e. from de
eleration maneuvers in 
ases when a fastvehi
le 
annot overtake a slow one. The desired velo
ity ve varies from one driver to another.Therefore, even for small values of density ρ a �nite velo
ity varian
e θe(ρ) of the vehi
les isexpe
ted. By analogy with gas dynami
s, it is said that model (2.9)-(2.11) is of Euler type,if 
oe�
ients µ and k both equal 0. Otherwise, this model is said to be of Navier-Stokestype. Stability analysis and numeri
al simulations for the model (2.9)-(2.11) 
an be foundin [55℄. As shown in [54℄, this model is adequate to des
ribe the stop-and-go tra�
 and thevelo
ity varian
e θ 
an be used to predi
t tra�
 jams as its value grows immediately beforethe 
ongestion starts developing.Hyperboli
 phase transition model.A hyperboli
 phase transition model for tra�
 was introdu
ed by Colombo in [35℄. He
onsiders two phases 
orresponding to free and 
ongested �ows. In free �ow phase the LWRequation (2.2) holds. However, when the density goes beyond 
riti
al, the assumption thatthe speed v is a fun
tion only of ρ is no longer valid, and the density-�ow points are s
atteredin a two-dimensional region (see Figure 2.5). Thus, the model is des
ribed by its free �owphase

(ρ, q) ∈ Ωf , (2.12)
ρt + (ρv)x = 0, (2.13)
v = (1 −

ρ

ρJ
)vmax (2.14)



17and by its 
ongested phase
(ρ, q) ∈ Ωc, (2.15)
ρt + (ρv)x = 0, (2.16)
qt + ((q −Q)v)x = 0, (2.17)
v = (1 −

ρ

ρJ
)
q

ρ
(2.18)Here Ωf and Ωc denote free �ow and 
ongested domains, the weighted �ow q is a variable

Figure 2.5: Fundamental diagram for the hyperboli
 phase transition model.originally motivated by the linear momentum in gas dynami
s, the treshold parameter Qdistinguishes between possible behaviors of the �ow (see [36℄), and vmax is the maximumspeed.2.2.2 Dis
retizationAs 
onservation laws 
an have dis
ontinuous solutions, they 
annot be integreated numeri-
ally by standard methods su
h as �nite di�eren
es or �nite elements that 
reate instabilitiesand wrong sho
k speeds [75℄. Among the numeri
al s
hemes for s
alar and systems of 
on-servation laws [75, 49℄ the Godunov s
heme [50℄ is widely used. It is �rst order, 
orre
tly



18predi
ts sho
k propagations, is free of os
illating behavior and has physi
al interpretation.In this approa
h the time is dis
retized into intervals [k∆t, (k + 1)∆t]. The 
omputationaldomain is divided into 
ells2, and at time k∆t, the solution ρ of (2.2) is approximated by apie
ewise 
onstant fun
tion ρ̃ (see Figure 2.6) de�ned as
ρ̃(x, k∆t) = ρk

i , ∀i, ∀x ∈ [xi−1, xi].The 
omputation of the approximation ρ̃(·, (k + 1)∆t) using the approximation ρ̃(·, k∆t)

Figure 2.6: Pie
ewise 
onstant approximation of the state.requires two steps.1. Compute exa
t solution of (2.2) given the initial 
ondition
ρ(x, k∆t) = ρ̃(x, k∆t) = ρk

i , ∀i, ∀x ∈ [xi−1, xi]. (2.19)2. Take the average of ρ(·, (k + 1)∆t) over every 
ell [xi−1, xi]:
ρk+1

i =
1

∆xi

∫ xi

xi−1

ρ(y, (k + 1)∆t)dy.

2Here and throughout the dissertation 
ell numbers in
rease in the dire
tion of tra�
 �ow: 
ell i isupstream of 
ell i + 1.



19These two steps 
an be simpli�ed as follows:
ρk+1

i = ρk
i +

∆t

∆xi
(fk

i−1 − fk
i ) (2.20)with

fk
i =

1

∆t

∫ (k+1)∆t

k∆t

Φ(ρ(xi, s))ds (2.21)being the average �ow 
rossing xi from 
ell i to 
ell i+1 during the time interval [k∆t, (k+

1)∆t]. Finally, sin
e fun
tion Φ is 
on
ave, expression (2.21) 
an be repla
ed by
fk

i =















minρk
i ≤ρ≤ρk

i+1
Φ(ρ), if ρk

i ≤ ρk
i+1,

maxρk
i+1

≤ρ≤ρk
i
Φ(ρ), if ρk

i ≥ ρk
i+1.

(2.22)In summary, the Godunov s
heme leads to a pie
ewise approximation of the state (density)
ρ at ea
h time step, whose evolution 
an be 
omputed for small time intervals if we knowthe solutions of initial value problems with Heaviside initial 
onditions

ρ(x) =















ρ−, x < 0

ρ+, x > 0

. (2.23)Su
h initial value problem is an abstra
tion of the problem (2.2), (2.19), and is 
alled aRiemann problem. It 
an be solved analyti
ally for s
alar 
onservation laws [75℄, and inthe system 
ase, when there is no 
losed form solution, an approximate solver su
h as theRoe average method [75, 49℄ 
an be used. The Godunov s
heme, 
onsisting in solving asu

ession of lo
al Riemann problems, is an e�e
tive method for simulating ma
ros
opi
tra�
 models.An example of Godunov s
heme in a
tion is the STRADA model [27℄, whi
h is based on twoextensions of the basi
 LWR: a simple �rst in, �rst out model for the density dynami
s in
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ells and a ma
ros
opi
 model for the dynami
s of tra�
 through interse
tions, 
onsistentwith the boundary 
onditions resulting from the LWR.Details of the LWR dis
retization via Godunov s
heme 
an be found in [74℄.The 
ell transmission model (CTM) proposed in [39℄ is another spe
ial 
ase of the Godunovdi�eren
e s
heme where the fundamental diagram has triangular form with maximal �ow
F , slope v > 0 for the free �ow speed and slope −w < 0 for the 
ongestion wave speed (see�gure 2.7). In this framework, the Godunov s
heme be
omes
Figure 2.7: The fundamental diagram for CTM is 
hara
terized by the maximum �ow Fand speeds v,w.

ρi(t+ 1) = ρi(t) +
∆t

∆xi
(fi−1(t) − fi(t)),where ∆t is the sampling period, ∆xi is the length of the ith 
ell, and fi, the �ow from 
ell

i to 
ell i+ 1, is given by
fi(t) = min{vρi(t), w(ρJ − ρi(t)), F}.Consequently, 
ell i 
an operate in one of two modes: free �ow mode if fi−1 = min{vρi−1, F},or 
ongested mode if fi−1 = w(ρJ − ρi).



21Variations on the CTM theme 
an be found in literature. In [51℄ the asymmetri
 
elltransmission model (ACTM) is presented. This work also des
ribes a 
onvex optimizationproblem whose solution is an optimal ramp metering strategy.The linear hybrid system approa
h 
alled swit
hing mode model (SMM) based on CTM isintrodu
ed in [86℄.The Godunov method 
an be e�e
tively applied to the se
ond order ARZ models. Thedetails of dis
retization for various types of fundamental diagrams are des
ribed in [59℄.By spatial dis
retization of the Payne-Whitham model (2.5)-(2.6), Smulders [97℄ de�neda ma
ros
opi
 �ow model that is 
ontinuous in time and dis
rete in spa
e. Furthermore,using the theory of martingales, he introdu
ed a sto
hasti
 
omponent based on a 
ountingpro
ess. The �ow f is determined by a 
onvex sum approximation of the average density ρand the speed v of the adja
ent 
ells i and i+ 1: The density dynami
s is given by
dρi = (fi−1 − fi)

dt

∆x
+
dξi−1 − dξi

∆x
, (2.24)where ξi re�e
ts the sto
hasti
 departure pro
ess of vehi
les from segment i, and the out�owof 
ell i is determined by a 
onvex approximation of the average density ρ and the speed vof the adja
ent 
ells i and i+ 1:

fi = (αρi + (1 − α)ρi+1)(αvi + (1 − α)vi+1), (2.25)with 0 ≤ α ≤ 1.The speed dynami
s is given by
dvi =

1

∆x
vi−1(vi−1 − vi)dt +

1

τ
(ve(ρi) − vi)dt −

D

∆x

ρi+1 − ρi

ρi + c
, (2.26)



22with c > 0 being a 
onstant.With respe
t to the 
onservation equation (2.24) this approximation yields the 
onservationof vehi
les. However, unless α = 1, vehi
les may �ow out of an empty downstream 
ellpossibly generating negative density values. Moreover, if the downstream 
ell is 
ongested(ρi+1 = ρJ and vi+1 = 0), vehi
les will still �ow out of the upstream 
ell into the saturateddownstream 
ell.Examples of dis
rete Payne-Whitham type models 
an be found in [92, 102, 89, 66, 84, 80℄.2.2.3 Control of Conservation LawsIn the 
ontext of tra�
 �ow appli
ations, the goal of 
ontrol is to improve the systeme�
ien
y by regulating the number of vehi
les allowed to enter the freeway. Two fundamentalperforman
e measures are used to assess the system e�
ien
y: the total travel distan
e(TTD) and the total travel time (TTT). TTD is de�ned as the sum of distan
es traveledby all vehi
les of the system over a given time period. Equivalently, it is a produ
t of theaverage trip length and the total number of vehi
les, whi
h 
an be 
omputed as the integralof �ow over time and spa
e: TTD =

∫

X

∫

T

f(x, t)dtdx. (2.27)TTT is the sum of all trip times in
urred by vehi
les during a given time period, or thenumber of vehi
les multiplied by the average trip time, whi
h is 
omputed as the integral ofdensity over time and spa
e: TTT =

∫

X

∫

T

ρ(x, t)dtdx. (2.28)



23The goal of 
ontrol is regulating the number of vehi
les entering the freeway either tomaximize TTD or minimize TTT.The optimal 
ontrol theory of partial di�erential equations was initiated in the early 70'sby Lions [79℄. The proposed approa
h 
onsists in 
omputing the ne
essary 
onditions ofoptimality in the form of the system equation, an adjoint equation of the same kind and avanishing �rst variation 
ondition. This analyti
 approa
h that was su

essfully applied tolinear ellipti
, paraboli
 and se
ond order hyperboli
 equations 
an be extended to nonlinearsystems using gradient-based re
ursive algorithms. This method is widely used: in airfoildesign [60, 62, 61℄; �uid steering [23, 56, 34, 47℄; gas steering [48℄; 
ontrol of water wave[94, 32℄; air tra�
 
ontrol [20℄.Very few attempts have been made to stabilize 
onservation laws using feedba
k 
ontrol.In [43, 37℄, the authors propose a feedba
k 
ontroller for open 
hannels but 
onsider onlysmooth solutions and no sho
k waves. Krsti
 [67℄ proposed a feedba
k design for the Burgersequation with small vis
osity parameter. Unfortunately, as the 
ontrol law is inverselyproportional to this parameter, the 
ontroller blows up in the nonvis
ous 
ase. Su

essful
ontrol design using a �nite dimensional dis
retization has been reported in [19℄ for paraboli
partial di�erential equations. The main di�
ulty in applying this method to hyperboli

onservation laws is that the 
lassi
al �nite di�eren
e s
heme 
annot be used for this 
lassof equations due to possible presen
e of sho
k waves.The problem of 
ontrol of a system of 
onservation laws although addressed in the literature,remains di�
ult. A way around the problem, is to dis
retize the system �rst, then solvethe 
ontrol problem for the resulting dynami
al system. An example of su
h approa
h is



24the multirate linear quadrati
 
ontrol with integral a
tion (LQI) [98℄. Ja
quet [59℄ showshow Godunov dis
retization 
an be put in the form of a pie
ewise a�ne system if thefundamental diagram is approximated by a pie
ewise a�ne fun
tion, and suggests that
onstru
tive 
ontroller design methods proposed in [64, 38, 24℄ 
an be used to 
ompute aset of stati
 feedba
k gains for a swit
hed 
ontroller.2.2.4 Arterial ModelsZiliaskopoulos and Lee adapt CTM [40℄ for arterial modeling [113℄. The 
ell length isgenerally mu
h shorter for arterials than for freeways, hen
e the sampling period ∆t mustbe small enough to ensure
v∆t < l,where v is the free �ow speed (Figure 2.7) and l is the 
ell length.Signalized interse
tions are modeled using diverging and merging 
ells3, and the signal phas-ing (red and green). The �ow of the diverging 
ells is 
omputed a

ording to the CTM duringthe green phase and is set to zero during the red phase. In [112℄ CTM is used to formulatethe system optimum dynami
 tra�
 assignment problem4 as a linear programming (LP)problem.In [81℄, Lo transforms CTM into a set of mixed-integer 
onstraints and 
asts the dynami
signal-
ontrol problem5 to a mixed-integer linear program. As a dynami
 platform, this

3Diverging are the 
ells with one prede
essor and two or more su

essors. Merging are the 
ells with twoor more prede
essors and one su

essor.
4See Se
tion 5.4 for de�nition of the system optimum dynami
 tra�
 assignment problem.
5The problem of red/green signal phase assignment so as to minimize total travel time, number of sloweddown vehi
les (vehi
les with speed below free �ow speed), or maximize total out-�ow of the system.



25formulation is �exible in dealing with dynami
 timing plans and tra�
 patterns. It derivesdynami
 as well as �xed timing plans and addresses preexisting tra�
 
onditions and timedependent demand patterns. Dynami
 interse
tion signal 
ontrol optimization (DISCO)that works with time-variant tra�
 patterns and derives signal timing plans is introdu
edin [82℄. The authors 
ompare DISCO with the platoon based TRANSYT model [2℄ and
on
lude that timing plans generated by DISCO outperform those generated by TRANSYTby as mu
h as 33% in delay redu
tion under a variety of demand patterns.Feldman and Maher [45℄ investigate CTM appli
ability to the network of signalized arterialsand 
ompare it with the TRANSYT model [2℄. Modeling the arterial with a pair of tra�
signals with both CTM and TRANSYT, the authors 
on
lude that CTM yields similar orbetter results than TRANSYT does.Amasri and Friedri
h [14℄ also apply CTM to urban arterials and 
ompare it with queueingmodels. They use geneti
 algorithm (GA) to �nd optimal signal timing plan having CTMas an underlying tra�
 �ow model.Ale
sandru in [13℄ suggests modi�
ations to CTM that in
lude some mi
ros
opi
 featuressu
h as disaggregating the tra�
 �ow by lanes and expli
itely modeling the e�e
ts of indi-vidual lane-
hanging maneuvers; repla
ing some of the original parameters in the analyzednetwork with sto
hasti
 variables to 
apture the e�e
t of the random driving behavior; and
hanges to the model equations that allow to keep tra
k of di�erent vehi
le types. He also
ompares this modi�ed CTM with CORSIM [58℄ mi
rosimulation, and shows that the sim-ulation outputs (tra�
 density and total network travel time) of these two models mat
hwell.



26Nie [88℄ presents a polymorphi
 dynami
 network loading (PDNL) framework for modelingroad networks and solving the dynami
 network loading problems6. PDNL employs notionsof links and nodes allowing di�erent ma
ros
opi
 tra�
 �ow models to run on links whiletreating nodes as points of merge, diverge or general interse
tions, signalized or not.Skabardonis and Geroliminis [95℄ propose an analyti
al model for travel time estimation onarterials. Their model is based on CTM, des
ribes the spatial and temporal queuing attra�
 signals and expli
itely 
onsiders the signal 
oordination in estimating tra�
 arrivalsat interse
tions. It estimates the travel time over an arterial link as the sum of free �owtime and the delay at tra�
 signal.In these works authors do not dis
uss 
omputational 
omplexity of the proposed models.The question how the size of a road network a�e
ts the e�
ien
y of the proposed algorithmsremains open.
2.3 Software ToolsFREQ.We start the des
ription of ma
rosimulation software with FREQ [3℄. It was developed inthe University of California, Berkeley, sin
e 1968. FREQ employs a �rst order, LWR, modeland implements the re
ommendations of the HCM [101℄. Current version of the softwareis 12. It in
ludes intera
tive graphi
al user interfa
e with input 
he
king and pre-sele
ted

6Problems that aim at obtaining the link 
umulative arrival/departure 
urves (hen
e time-dependentlink/path travel times) 
orresponding to a given set of temporal path �ow rates on a 
ongested network andover a �xed time period.



27default values, graphi
al representation of simulation results, user-de�ned output optionsin
luding tra�
 performan
e 
ontour maps. The two models 
ontained within FREQ12are: FREQ12PE, an entry 
ontrol ma
ros
opi
 model for analyzing ramp metering; andFREQ12PL, a freeway ma
ros
opi
 model for analyzing HOV fa
ilities7.The FREQ system of models enables the user to analyze geometri
 design improvements,an on-freeway HOV fa
ility, normal and priority entry 
ontrol, or time-varying 
apa
ityredu
tion situations su
h as re
onstru
tion a
tivities or freeway in
idents. The analysisemphasizes tra�
 simulation, traveler responses, and measures of e�e
tiveness.All this said about FREQ12, we must a
knowledge that this tool is not user-friendly and
an hardly be used for pra
ti
al purposes. The main drawba
k is the la
k of do
umentation.Only feature 
hanges from version to version are do
umented, leaving the 
ore of the simula-tor to be treated as bla
k box. Despite some 
ontext help provided by the appli
ation, only aperson thoroughly familiar with HCM [101℄ may feel 
omfortable adjusting parameters andfully using features of FREQ. The se
ond major hindran
e to using FREQ is the fa
t that
on�guration �les for the simulator must be 
reated from within the appli
ation itself. Theformat of the binary 
on�guration �le is proprietary, and thus, the 
on�guration �le 
annotbe automati
ally generated making it ne
essary for the user to manually �ll in the parametervalues for every 
ell and ramp. The same is true for demand and o�-ramp �ow pro�les�theyhave to be manually typed in from within the FREQ appli
ation. Another serious limitationof FREQ is its inability to model ramp 
ontrol. No built-in ramp 
ontrollers are providedand it is impossible to plug in user-de�ned 
ontrollers. This makes FREQ unsuitable for
7We 
ould not �nd any do
umentation des
ribing these models.



28modeling tra�
 responsive ramp metering strategies. Finally, the graphi
al output 
an beprinted but not saved making report generation using FREQ simulation results in
onvenient.The popularity of FREQ 
an be explained by histori
al reason. It was used by transportationengineers for many years for la
k of any better ma
ros
opi
 simulation tool. The developersof FREQ, however, never addressed issues of proper software design adding features in
re-mentally from version to version and not looking at the appli
ation as a whole. The resultis poor user interfa
e and la
k of do
umentation.NETCELL.NETCELL [30℄ is another ma
rosimulator developed at UC Berkeley. It implements theCTM for networks [40℄. The pa
kage 
onsists of two appli
ations: the simulator and theplotter. The simulator produ
es text output, whi
h 
an then be parsed by the plotter whi
hdisplays the simulation results along with the network 
on�guration. NETCELL is free and
an be downloaded from [4℄. As far as we know, NETCELL is 
urrently not supported andis hardly used by anyone be
ause of the la
k of proper user interfa
e.METACOR.METACOR [44℄ is the �rst ma
ros
opi
 simulation tool for 
orridor tra�
, i.e. when free-ways and arterials are modeled together in one network. It emerged as a fusion ofMETANET[85℄ (for freeways) and SSMT [73℄, a ma
ros
opi
 model for urban networks. METACORuses a dis
rete version of the Payne-Whitham se
ond order model. It also in
ludes 
ontroland dynami
 tra�
 assignment modules to simulate ramp metering strategies and routeinformation/guidan
e via 
hangeable message signs. Currently, METACOR is being devel-oped independently by the Te
hni
al University of Crete (TUC) and the Institut National



29de Re
her
he sur les Transports et leur Sé
urité (INRETS). Individual 
opies of the formerversion 
an be obtained from M. Papageorgiou. He warns, though, that the user interfa
eis rather primitive and there is no do
umentation in English. The latter version, knownas PX-Meta
or [5℄ is supposed to be 
ommer
ially available. The advertisement says thatadditionally to Payne-Whitham, it supports LWR and ARZ models as well as mi
ro- andhybrid (ma
ro + mi
ro) simulation, and has quality graphi
al user interfa
e. We were un-able to get hold of PX-Meta
or. It is still under development and has not been released atthe time of this writing.SATURN.SATURN [103, 104℄ was developed at the University of Leeds to evaluate tra�
 managements
hemes on arterial networks. It 
ontains an equilibrium tra�
 assignment algorithm basedon ma
ros
opi
 �ow relationships, where the travel time is an in
reasing fun
tion of �ow. Ithas been widely used to evaluate 
hanges in 
ir
ulation (one-way streets, pedestrianizations
hemes) and other tra�
 management s
hemes. It has also been used to evaluate thee�e
tiveness of route guidan
e systems and road pri
ing studies. The major limitation ofSATURN is that it was developed spe
i�
ally for arterials and is unsuitable for freewaymodeling. SATURN has developed into a 
ommer
ial appli
ation [6℄.CORFLO.CORFLO [76℄ 
ontains the FREFLO [92℄ model for freeways and the NETFLO1, NETFLO2models for arterials. The interfa
e of adjoining subnetworks is a

omplished by de�ning in-terfa
e nodes representing points at whi
h vehi
les leave one subnetwork and enter another.Asso
iated with ea
h subnetwork is a vehi
le holding area where exiting vehi
les are held



30until the next subnetwork 
an re
eive them. Tra�
 may be assigned to the di�erent subnet-works using the TRAFFIC assignment model (a stati
 equilibrium assignment algorithm).FREFLO is based on the Payne-Whitham model. Unfortunately, it had serious errors inimplementation, whi
h 
aused unrealisti
 simulation results and were never �xed. It 
anhandle di�erent vehi
le 
lasses (busses, 
arpools), HOV fa
ilities, and in
idents on the free-way, but it 
annot model ramp operations. NETFLO1 is a mi
ros
opi
 event s
anningsimulator. NETFLO2 models tra�
 using �ow pro�les similar to the TRANSYT model [2℄.Unlike TRANSYT, however, it 
an simulate signals with di�erent 
y
le lengths and queuespillba
ks. There is little information published on the development and appli
ation of theNETFLO models. CORFLO has been designed to evaluate freeway and arterial designand 
ontrol modi�
ations, impa
ts of in
idents and diversion poli
ies. As far as we know,CORFLO is 
urrently obsolete.DYNASMART.DYNASMART [63℄ was developed at the University of Texas at Austin as both simulationand assignment tool. Tra�
 �ow is simulated using the Payne-Whitham model. It 
an sim-ulate tra�
 signals, ramp meters and in
idents. It 
al
ulates optimal travel paths based onthe simulated travel times, and simulates the movements and routing de
isions by individ-ual drivers equipped with in-vehi
le information systems (update of information and desireto swit
h based on thresholds). DYNASMART is available as a resear
h tool and is nowsupported by the University of Maryland [7℄. Two versions of DYNASMART are available:DYNASMART-X for real-time analysis, and DYNASMART-P for planning.
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Chapter 3
CTM: Qualitative Theory
This 
hapter largely reprodu
es [52℄. It studies the 
ell transmission model (CTM) [39, 40℄as a dynami
al system. The freeway is divided into N 
ells, indexed 1, · · · , N . Cell i is
hara
terized by a single state variable, its density ni, so the state of the freeway is the
N -dimensional ve
tor n = (n1, · · · , nN ). Vehi
le movement in a 
ell is governed by thefamiliar triangular fundamental diagram. If the density is below 
riti
al, vehi
les move atfree �ow speed; if it is above 
riti
al, the 
ell is 
ongested, speed is lower, and �ow from theimmediately upstream 
ell is 
onstrained. Thus the state of a freeway obeys a N -dimensionalnonlinear di�eren
e equation. When the exogenous demand pattern of on-ramp and o�-ramp�ows is 
onstant, the di�eren
e equation is time-invariant.CTM is popular for its �exible use in ma
ros
opi
 simulation. Compared with mi
ros
opi
simulators, it requires negligible 
omputational e�ort. It 
an be extended to road networks([27℄) and urban roads with signalized interse
tions ([81, 14℄). It appears well-suited for
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alibration with point measurements of aggregate tra�
 variables that are routinely available([78, 87℄). It is straightforward to formulate questions of ramp metering ([42, 111, 51℄) anddynami
 tra�
 assignment ([28, 112℄) by posing optimization problems within CTM.Proofs for lemmas 
an be found in Se
tion 3.5.
3.1 The ModelFollowing [51℄, �gure 3.1 shows the freeway divided into N 
ells, ea
h with one on- and oneo�-ramp. Vehi
les move from left to right. Cell i is upstream of 
ell i + 1. There are twoboundary 
onditions. Free �ow prevails downstream of 
ell N ; upstream of the freeway isan �on-ramp� with an in�ow of r0. The �ow a

epted by 
ells 1 is f0(k) vehi
les per periodor time step k. The 
umulative di�eren
e leads to a queue of size n0(k) in period k.

Figure 3.1: The freeway has N 
ells. Ea
h 
ell has one on- and one o�-ramp.Table 3.1 lists the model variables and parameters with plausible values. The length ofall 
ells is normalized to 1 by absorbing di�eren
es in length in the speeds vi, wi. To bephysi
ally meaningful one must have 0 < vi, wi < 1. The parameter values in the table
orrespond to the fundamental diagram of Figure 3.2. Its triangular form in
orporates the



33Symbol Name Value Unit
ell length 1 milesperiod (time step) 0.5 minutes
Fi 
apa
ity 20 veh/period
vi free �ow speed 0.5 
ell/period
wi 
ongestion wave speed 0.5/3 
ell/period
n̄i jam density 160 veh/
ell
nc

i 
riti
al density 40 veh/
ell
βi split ratio ∈ [0, 1) dimensionless
β̄i 
omplementary split ratio = 1 − βi ∈ (0, 1] dimensionless
γi on-ramp blending fa
tor ∈ [0, 1] dimensionless
k period number integer dimensionless
fi(k) �ow from 
ell i to i+ 1 in period k variable veh/period
si(k), ri(k) o�-ramp, on-ramp �ow in 
ell i in period k variable veh/period
ni(k) number of vehi
les in 
ell i in period k variable veh/
ellTable 3.1: Model parameters and variables.assumption that is frequently used in our analysis:

Fi = β̄i vi n
c
i = wi (n̄i − nc

i). (3.1)

Figure 3.2: The fundamental diagram is 
hara
terized by the maximum �ow Fi and speeds
vi, wi.O�-ramp �ows are modeled as a portion βi(k) of the total �ow leaving the 
ell:

si(k) = βi(k)(si(k) + fi(k)), or si(k) = [βi(k)/(1 − βi(k))]fi(k).



34We assume 
onstant split ratios βi (βN = 0). With β̄i = 1−βi, the CTM model for k ≥ 0 is
ni(k + 1) = ni(k) − fi(k)/β̄i + fi−1(k) + ri(k) 1 ≤ i ≤ N, (3.2)
fi(k) = min{β̄i vi[ni(k) + γiri(k)], wi+1[n̄i+1 − ni+1(k) − γi+1ri+1(k)], Fi}, 0 ≤ i < N,(3.3)
fN (k) = min{β̄N vN [nN (k) + γNrN (k)], FN}, (3.4)
n0(k + 1) = n0(k) − f0(k) + r0(k). (3.5)Flow 
onservation in 
ell i > 0 is expressed by

ni(k + 1) = ni(k) − fi(k) + fi−1(k) + ri(k) − si(k),whi
h is equivalent to (3.2), using si(k) = βi

β̄i
fi(k). Flow 
onservation at 0 is expressed by(3.5). The �ow fi(k) from 
ell i to i+ 1 is governed by the fundamental diagram (3.3) withthis interpretation: β̄i vi[ni(k) + γiri(k)] is the number of vehi
les that 
an move from 
ell ito i+ 1 in period k; wi+1[n̄i+1 −ni+1(k)− γi+1ri+1(k)] is the number that i+ 1 
an a

ept;and Fi is the 
apa
ity or maximum �ow from 
ell i to i+ 1. Equation (3.4) indi
ates thereis no 
ongestion downstream of 
ell N . Lastly, it is implied that the �ows si(k) are not
onstrained by o�-ramp 
apa
ity.The state of the system is the N -dimensional ve
tor n(k) = (n1(k), · · · , nN (k)). The queuesize n0(k) is not in
luded in the state. Cell i is said to be un
ongested in period k if

ni(k) ≤ nc
i , and 
ongested - otherwise.



353.2 Stru
ture of EquilibriaThe parameters γi ∈ [0, 1] in (3.3), (3.4) re�e
t the relative position of the on-ramp in 
ell
i ([51℄). For simpli
ity we assume γi = 0, indi
ating that the on-ramp is at the beginningof ea
h 
ell as in Figure 3.1. (However, the results below hold for a di�erent 
hoi
e of γi.)With γi = 0, equations (3.2)-(3.5) simplify:

ni(k + 1) = ni(k) − fi(k)/β̄i + fi−1(k) + ri(k), 1 ≤ i ≤ N, (3.6)
fi(k) = fi(n(k)) = min{β̄i vini(k), wi+1[n̄i+1 − ni+1(k)], Fi}, 0 ≤ i < N, (3.7)
fN (k) = fN (n(k)) = min{β̄N vNnN(k), FN}, (3.8)
n0(k + 1) = n0(k) − f0(k) + r0(k). (3.9)In view of (3.1) a useful alternative to (3.7) is

fi(k) = min{β̄i vini(k), Fi − wi+1[ni+1(k) − nc
i+1], Fi}, (3.10)and if 
ell i+ 1 is un
ongested (ni+1(k) ≤ nc

i+1), (3.10) simpli�es to
fi(k) = min{β̄i vini(k), Fi}. (3.11)Split ratios β1 · · · , βN are �xed. Assume stationary demands ri(k) ≡ ri. Ea
h on-ramp de-mand ve
tor r = (r0, · · · , rN ) indu
es a unique equilibrium �ow ve
tor f(r) = (f0, · · · , fN )
al
ulated as

f0 = r0, (3.12)
fi = β̄i (fi−1 + ri), 1 ≤ i ≤ N. (3.13)



36The fun
tion r 7→ f(r) de�ned by (3.12), (3.13) is bije
tive. We say that demand r is feasibleif 0 ≤ fi ≤ Fi, 0 ≤ i ≤ N ; it is stri
tly feasible if 0 ≤ fi < Fi, 0 ≤ i ≤ N . A stri
tly feasibledemand indu
es an equilibrium �ow with ex
ess 
apa
ity in every 
ell.State n = (n1, · · · , nN ) is an equilibrium for a feasible demand r with indu
ed �ow f = f(r),if the 
onstant traje
tory n(k) ≡ n is a solution of (3.6)-(3.8):
fi = min{β̄i vi ni, Fi − wi+1(ni+1 − nc

i+1), Fi}, 1 ≤ i ≤ N − 1, (3.14)
fN = min{β̄N vN nN , FN}. (3.15)At equilibrium n, 
ell i is said to be un
ongested if 0 ≤ ni ≤ nc

i and 
ongested if ni > nc
i .The equilibrium n is un
ongested if all 
ells are un
ongested, otherwise it is 
ongested.Let E = E(r) be the set of equilibria, i.e., all solutions of the system of equations (3.14)-(3.15), 
orresponding to a demand r. This se
tion is devoted to 
hara
terizing E(r) andthe pattern of 
ongested 
ells for ea
h n ∈ E(r). If r is not feasible, there is no solution to(3.14)-(3.15), so E(r) = ∅. Lemma 3.2.1 implies that E(r) 6= ∅ if r is feasible.Lemma 3.2.1 With feasible demand r, system (3.6)-(3.9) has a unique un
ongested equi-librium nu(r).Proposition 3.2.1 Suppose at equilibrium n, 
ell i+ 1 is un
ongested and 
ells i− j, · · · , iare 
ongested. Then

fi = Fi, β̄−1
i Fi − ri = fi−1 < Fi−1, · · · , fi−j−1 < Fi−j−1. (3.16)



37Corollary 3.2.1 The same system with stri
tly feasible demand r has a unique equilibrium,so E(r) = {nu}.The next result is a partial 
onverse to Proposition 3.2.1.Proposition 3.2.2 Suppose fi = Fi, fi−1 < Fi−1, · · · , fi−j < Fi−j . Suppose at equilibrium
n, 
ell i− j is 
ongested. Then 
ells i− j, · · · , i− 1, i are all 
ongested at n.We say that i is a bottlene
k 
ell for demand r (or indu
ed �ow f) if fi = Fi. Suppose thereare K ≥ 0 bottlene
k 
ells at 1 ≤ I1 < I2 · · · < IK ≤ N . Partition the freeway into 1 +Ksegments S1, · · · , SK+1 
omprising 
ontiguous 
ells as follows:

S1 = {1, · · · , I1}, · · · , S
K = {IK−1 + 1, · · · , IK}, SK+1 = {IK + 1, · · · , N}. (3.17)If there are no bottlene
k 
ells, K = 0, and S1 = {1, · · · , N} is the entire freeway. Onthe other hand, if the most downstream 
ell is 
ongested, IK = N , and SK+1 is the emptysegment.Proposition 3.2.3 The 
ells immediately downstream of the segments S1, · · · , SK+1 areun
ongested. Consequently, for k = 1, · · · ,K,

fIk
= min{β̄Ik

vIk
nIk

, FIk
}. (3.18)Partition the N -dimensional state n = (n1, · · · , nN ) into sub-ve
tors n = (n1, · · · , nK+1) in
onformity with the segments S1, · · · , SK+1, so nk has 
omponents {ni, i ∈ Sk}. Sin
e theequilibrium �ow immediately upstream of segment Sk is known (it is equal to 
apa
ity) and



38the 
ell immediately downstream of Sk is un
ongested, the equilibrium 
onditions (3.14)-(3.15) partition into 1 +K de
oupled 
onditions, one for ea
h segment. Thus,
nk satis�es for k = 1, · · · ,K,

fIk
= min{β̄Ik

vIk
nIk

, FIk
}, (3.19)

fi = min{β̄ivini, Fi − wi+1(ni+1 − nc
i+1), Fi}, Ik−1 < i ≤ Ik; (3.20)

nK+1 satis�es
fN = min{β̄N vN nN , FN}, (3.21)
fi = min{β̄i vi ni, Fi − wi+1(ni+1 − nc

i+1), Fi}, IK < i ≤ N. (3.22)These de
oupled 
onditions de
ompose the equilibrium set.Proposition 3.2.4 The set of equilibria E(r) fa
tors into the produ
t set,
E(r) = E1(r) × · · · × EK(r) × EK+1(r), (3.23)in whi
h EK+1(r) is the set of solutions nK+1 of (3.21)-(3.22) and Ek(r) is the set ofsolutions nk of (3.19)-(3.20) for 1 ≤ k ≤ K.We now fully 
hara
terize the 
omponents E1(r), · · · , EK+1(r). Re
all that the �ow in allnon-bottlene
k 
ells is stri
tly below 
apa
ity:

fi < Fi, i 6∈ {I1, · · · , IK}. (3.24)Lemma 3.2.2 EK+1(r) = {nu,K+1} 
onsists of a single point, the 
omponent of the un
on-gested equilibrium nu 
orresponding to segment SK+1. Hen
e nu,K+1 is given by
nu,K+1

i = (β̄ivi)
−1fi, IK < i ≤ N. (3.25)



39The next result gives an expli
it expression for the equilibrium set Ek(r), 1 ≤ k ≤ N .Lemma 3.2.3 nk ∈ Ek(r) if and only if either (i) there is no 
ongested segment at nk and
nk = nu,k, or (ii) there exists j ∈ {Ik−1 +1, · · · , Ik} su
h that at nk 
ells Ik−1 +1, · · · , j− 1are un
ongested, 
ells j, · · · , Ik are 
ongested and nk is given by (see �gure 3.3)

nk
i = nu

i = (β̄ivi)
−1fi, Ik−1 < i < j + 1 (3.26)

nk
i = nc

i + w−1
i (Fi−1 − fi−1), j < i ≤ Ik (3.27)

nk
j−1 ∈ [(β̄j−1vj−1)

−1fj−1, n
c
j−1] and nk

j = nc
j + w−1

j (Fj−1 − fj−1), or (3.28)
nk

j−1 = nu
j−1 = (β̄j−1vj−1)

−1fj−1 and nk
j ∈ (nc

j, n
c
j + w−1

j (Fj−1 − fj−1)] (3.29)
Figure 3.3: Equilibrium satisfying (3.26),(3.27) and (3.28) (top) or (3.29) (bottom).Three densities appear in the expression of Ek(r), namely nu

i = (β̄ivi)
−1fi, the un
ongestedequilibrium density; nc

i , the 
riti
al density; and the 
ongested equilibrium density
ncon

i = nc
i + w−1

i (Fi−1 − fi−1). (3.30)By Lemma 3.2.3
Ek(r) = {nu,k}

⋃

j∈Sk

Ek
j (r), (3.31)



40in whi
h Ek
j (r) is the set of nk satisfying (3.26)-(3.29):

Ek
j (r) = {(nu

Ik−1+1, · · · , n
u
j−1, nj, n

con
j+1, · · · , n

con
Ik

) | nj ∈ (nc
j , n

con
j ]}

⋃

{(nu
Ik−1+1, · · · , n

u
j−2, nj−1, n

con
j , · · · , ncon

Ik
) | nj−1 ∈ [nu

j−1, n
c
j−1]}. (3.32)Observe that fIk−1+1 = FIk−1+1, nu

Ik−1+1 = (β̄Ik−1+1vIk−1+1)
−1Fi = nc

Ik−1+1. So it followsfrom (3.32) that nu,k ∈ Ek
Ik

(r). Hen
e (3.31) simpli�es to
Ek(r) =

⋃

j∈Sk

Ek
j (r). (3.33)Observe next that the �rst set on the right hand side in (3.32) forms a straight line segment

Ek
j,− 
onne
ting the points

nk(j−) = (nu
Ik−1+1, · · · , n

u
j−1, n

c
j , n

con
j+1, · · · , n

con
Ik

) (3.34)and
nk(j) = (nu

Ik−1+1, · · · , n
u
j−1, n

con
j , · · · , ncon

Ik
). (3.35)Denote this line segment in terms of its endpoints as

Ek
j−(r) = (nk(j−), nk(j)]. (3.36)Similarly, the se
ond set on the right hand side in (3.32) forms a straight line segment
onne
ting the points nk(j) and

nk(j+) = (nu
Ik−1+1, · · · , n

u
j−2, n

c
j−1, n

con
j , · · · , ncon

Ik
), (3.37)and denoted as

Ek
j+(r) = [nk(j), nk(j+)]. (3.38)



41The two line segments have exa
tly one point, nk(j), in 
ommon. Thus
Ek

j (r) = Ek
j−(r) ∪ Ek

j+(r), (3.39)and, by 
omparing (3.34) and (3.37) one sees that
nk(j+) = nk(j − 1−), (3.40)so that Ek

j (r) and Ek
(j−1)(r) have exa
tly this point in 
ommon. Lastly, sin
e the densities

nu
i ≤ nc

i ≤ ncon
i are ordered, so are the endpoints:
· · · ≤ nk(j−) ≤ nk(j) ≤ nk(j+) = nk((j − 1)−) ≤ nk(j − 1) ≤ · · · . (3.41)(For ve
tors x and y, x ≤ y means xi ≤ yi for all 
omponents i.)Figure 3.4 depi
ts the proje
tion of Ek

j (r) = Ek
j−(r) ∪Ek

j+(r) on the two dimensional spa
espanned by nk
j−1, n

k
j and the proje
tion of Ek

j−1 = Ek
(j−1)−(r) ∪ Ek

(j−1)+(r) on the spa
espanned by nk
j−2, n

k
j−1. A

ording to (3.40) the two highlighted points in the �gure are thesame.

Figure 3.4: Proje
tion of Ek
j−1(r) on 
oordinates nk

j−2, n
k
j−1 (left) and proje
tion of Ek

j (r)on 
oordinates nk
j−1, n

k
j (right).Observe lastly that the straight line segments E(j−1)− and Ej+ are aligned.Theorem 3.2.1 follows from Proposition 3.2.4, and Lemmas 3.2.2 and 3.2.3.



42Theorem 3.2.1 Let r be a feasible demand, f the indu
ed equilibrium �ow, and E(r) theequilibrium set. If r is stri
tly feasible, E(r) 
onsists of the unique un
ongested equilib-rium nu. Otherwise, partition the freeway into segments S1, · · · , SK+1 
orresponding to thebottlene
k 
ells 1 ≤ I1 < · · · < IK ≤ N . Then E(r) is the dire
t produ
t (3.23):
E(r) = E1(r) × · · · × EK+1(r).Ea
h Ek(r) de
omposes as the union (3.33):

Ek(r) =
⋃

j∈Sk

Ek
j (r), 1 ≤ k ≤ K EK+1(r) = {nu,K+1}.Ea
h Ek

j (r) is the union of two 
onne
ted line segments, given by the `
losed form' expression(3.36), (3.38), (3.39). Ek(r) is the union of |Sk| 
onne
ted straight line segments. (|Sk| =

|Ik+1 − Ik| is the number of 
ells in Sk.)Conse
utive sets Ek
j (r) and Ek

j+1(r) have exa
tly one point in 
ommon, and they are ordered:if nk ∈ Ek
j (r) and n′k ∈ Ek

j+1, then nk ≥ n′k. In parti
ular, the most 
ongested equilibriumin Ek(r) is ncon,k with 
omponents ncon
i , i ∈ Sk, given by (3.30). Every nk ∈ Ek(r) liesbetween the un
ongested equilibrium nu,k and ncon,k, i.e., nu,k ≤ nk ≤ ncon,k. Hen
e for all

n ∈ E(r),
nu ≤ n ≤ ncon,in whi
h the most 
ongested equilibrium is ncon = (ncon,1, · · · , ncon,K, nu,K+1).Lastly, E(r) forms a 
onne
ted, topologi
ally 
losed surfa
e of dimension K in the N -dimensional state spa
e.Proof. Only the last assertion needs proof, whi
h follows from the observation that E(r)is the produ
t of K + 1 sets, E1(r), · · · , EK+1(r), the last of whi
h being a single point has



43dimension 0, and ea
h of the rest being a union of 
onne
ted line segments has dimension1. 2

Figure 3.5: The demand indu
es two bottlene
k 
ells and three segments. S3 is un
ongested.In the depi
ted equilibrium S2 has one 
ongested 
ell and S1 has three 
ongested 
ells.Figure 3.5 illustrates the use of Theorem 3.2.1. The demand indu
es a �ow that givesrise to bottlene
ks at I1, I2 whi
h partition the freeway into three segments S1, S2, S3. S3 isun
ongested. An equilibrium determines the number of 
ongested 
ells in the other segments.The �gure illustrates an equilibrium in whi
h one 
ell in S2 and three 
ells in S1 are 
ongested(depi
ted by shaded re
tangles); the others are un
ongested. The 
ongested 
ells must lieimmediately upstream of the 
orresponding bottlene
k.
3.3 Dynami
 BehaviorTheorem 3.2.1 fully 
hara
terizes the equilibrium behavior of any CTM model. This se
tionis devoted to the 
omplete des
ription of the qualitative behavior of all traje
tories of the N -dimensional di�eren
e equation system (3.6)-(3.8). We assume a 
onstant feasible demand
r and write (3.6)-(3.8) as

ni(k + 1) = gi(n(k)), 1 ≤ i ≤ N. (3.42)Let g = (g1, · · · , gN ). We will 
onsider initial 
onditions
n ∈ Σ = {n | 0 ≤ ni ≤ n̄i, 1 ≤ i ≤ N}. (3.43)



44Ea
h initial 
ondition n(0) ∈ Σ generates a traje
tory {n(k), k ≥ 0} a

ording to n(k+1) =

g(n(k)).For two ve
tors x, y in RN , write
x ≤ y ⇔ xi ≤ yi,

x < y ⇔ x ≤ y, x 6= y,

x≪ y ⇔ xi < yi.Following [57℄ say that g is stri
tly monotone if, for x, y ∈ Σ,
x < y ⇒ g(x) < g(y);

g is strongly monotone if
x ≤ y ⇒ g(x) ≪ g(y).Lemma 3.3.1 The map g is stri
tly monotone, but it is not strongly monotone.[57℄ surveys the theory of monotone maps. The most powerful results, however, requirestrong monotoni
ity, and do not apply to CTM.Let the equilibrium �ow indu
ed by the demand r result in bottlene
ks at 1 ≤ I1 < · · · <

IK ≤ N , and let S1, · · · , SK+1 be the 
orresponding freeway partition. By Theorem 3.2.1every equilbrium lies between the un
ongested equilibrium nu and the most 
ongested equi-librium ncon,
nu ≤ n ≤ ncon, n ∈ E(r). (3.44)



45Let n̂(k), k ≥ 0 be the traje
tory starting with the empty freeway, n̂(0) = 0, and let n̄(k), k ≥

0 be the traje
tory starting with the 
ompletely jammed freeway, n̄i(0) = n̄i, 1 ≤ i ≤ N .Let n(k) be a traje
tory starting in any state n(0) ∈ Σ. The next result shows how mu
hmonotoni
ity of g 
onstrains the traje
tories of the CTM model.Lemma 3.3.2 (i) Every traje
tory lies between {n̂(k)} and {n̄(k)}:
n̂(k) ≤ n(k) ≤ n̄(k), k ≥ 0. (3.45)(ii) The traje
tory starting with the empty freeway 
onverges to the un
ongested equilibrium

nu:
lim

k→∞
n̂(k) = nu. (3.46)(iii) The traje
tory starting with the 
ompletely jammed freeway 
onverges to the most 
on-gested equilibrium ncon:

lim
k→∞

n̄(k) = ncon. (3.47)Lemma 3.3.2 leads to Theorem 3.3.1: If the demand is stri
tly feasible, then nu is a globally,asymptoti
ally stable equilibrium.Theorem 3.3.1 Suppose r is stri
tly feasible. Then every traje
tory 
onverges to nu.Proof. By Lemma 3.2.1 E(r) = {nu}, so ncon = nu. Hen
e both n̂(k) and n̄(k) 
onvergeto nu. By (3.45), every traje
tory n(k) 
onverges to nu as well. 2If r is not stri
tly feasible, the equilibrium set E(r) is in�nite and there is no easy way toanalyze how traje
tories behave. The main result of this se
tion, Theorem 3.3.3, is that



46every traje
tory 
onverges to some equilibrium. Before getting into the 
omplexities of theproof, we study three examples.ExamplesExample 1 is a freeway with two identi
al 
ells, ea
h one mile long. The fundamentaldiagram, equilibrium �ow, and equilibrium set E are shown in Figure 3.6. The 
riti
aldensity nc
i = 100 veh/mile; the jam density n̄i = 400 veh/mile; free �ow speed v = 60 mphand the 
ongestion wave speed w = 20 mph. The demand ve
tor r = (r0 = 4800, r1 =

Figure 3.6: Freeway, equilibrium �ows, fundamental diagram, and equilibrium set E ofExample 1.
0, r2 = 1200), all in vehi
les per hour (vph). The upstream �ow r0 = f0 = 4800 vph, and
f2 = F2 = 6000 vph. Thus 
ell 2 is the only bottlene
k. The un
ongested equilibrium
nu = (80, 100) and the most 
ongested equilibrium ncon = (160, 160). By Theorem 3.2.1,the equilibrium set E 
onsists of two straight line segments shown in the �gure (also seeFigure 3.4).The phase portrait of Figure 3.7 displays the orbits of the two-dimensional state with initial
onditions on the boundary of the square Σ = [0, 400] × [0, 400]. (An orbit is the set of



47states {n(k) | k ≥ 0} traversed by a traje
tory k → n(k).) We analyze the orbit stru
turedisplayed in Figure 3.7. The observations made below hold in general.
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Figure 3.7: Equilibrium set and orbits of Example 1.
1. Every traje
tory 
onverges to an equilibrium point in E. As a 
onsequen
e, the statespa
e Σ is partitioned as

Σ =
⋃

n∈E

Σ(n),in whi
h Σ(n) is the set of all initial states whose traje
tories 
onverge to the equilib-rium n. By monotoni
ity Σ(nu) in
ludes all initial states n ≤ nu, and Σ(ncon) in
ludesall initial states n ≥ ncon. By 
ontrast, for all other equilibrium states Σ(n) is sim-ply a one-dimensional manifold. (In the general 
ase, Σ(n) is a (N −K)-dimensional



48manifold, Corollary 3.3.1.)2. The �gure shows four equi-time 
ontour plots, labeled k = 12s, · · · , 600s. For example,the 
ontour plot k = 60s is the set of points rea
hed by all traje
tories at k = 60se
onds. As k in
reases, the 
ontour plots 
onverge towards the equilibrium set E. Asmight be expe
ted, the 
ontours initially 
onverge rapidly and the 
onvergen
e slowsdown as E is approa
hed. More interestingly, 
onsider the orbit going through thestate n = (50, 340) on the k = 60 
ontour. In this state 
ell 2 is 
ongested but 
ell 1is not. However, by time 200 (whose 
ontour plot is not shown) the state has movedto approximately (150, 250), indi
ating both 
ell are 
ongested. The time di�eren
e of
200 − 60 = 140 se
onds is roughly predi
table: be
ause the 
ongestion wave speed is20 mph it takes about 3 minutes for the 
ongestion wave to travel the one mile-long
ell.3. A

ording to Theorem 3.2.1 the equilibrium set is ordered: if n, n′ are two equilibria,either n ≤ n′ or n′ ≤ n. Consequently, downstream 
ells must get 
ongested beforean upstream 
ell. As seen in the �gure, every traje
tory in whi
h 
ell 1 is getting
ongested also 
ongests 
ell 2.4. All equilibria support the same equilibrium �ows. However at equilibrium nu the speedis v = 60 mph throughout, whereas in ncon the speed is 4800/160 (�ow/density) or
30 mph. Thus, although both nu and ncon a
hieve the same throughput, the freewaytravel time in nu is one-half of that in ncon.In Example 2 the �ow r0 is slightly redu
ed from 4800 to 4750 vph, so the demand be
omes



49stri
tly feasible and the equilibrium set 
ollapses to the single un
ongested equilibrium nu.The resulting phase portrait in Figure 3.8 
an be 
ompared with Figure 3.7. The traje
toriesare nearly identi
al, ex
ept that when they approa
h the equilibrium set of Example 1 theyturn and 
onverge to nu ≈ (80, 100).
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Figure 3.8: Equilibrium set and orbits of Example 2.Example 3 shown in Figure 3.9 is a modi�
ation of Example 1 in that there are threeidenti
al 
ells. The fundamental diagram is the same as in Example 1. The demand r0 =

4800, r1 = r2 = 0, r3 = 1200. Again the most downstream 
ell, 
ell 3, is the only bottlene
k.The equilibrium set now 
omprises three straight line segments, 
onne
ting the un
ongestedequilibrium nu = (80, 80, 100) and the most 
ongested equilibrium ncon = (160, 160, 160).The orbit stru
ture supports the observations made earlier: although it is less apparent inthe �gure, Σ(n) is a 2-dimensional manifold if n 6= nu, ncon.
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Figure 3.9: Freeway, equilibrium set and orbits of Example 3.We resume the general dis
ussion. As before let r be a demand ve
tor and φ the resultingequilibrium �ow ve
tor, i.e., (see (3.12), (3.13))
φ0 = r0, φi = β̄i(φi−1 + ri), 1 ≤ i ≤ N. (3.48)Let 1 ≤ I1 < · · · < IK ≤ N be the bottlene
ks, and S1, · · · , SK+1 the 
orresponding freewaypartition. By Theorem 3.2.1 the equilibrium set de
omposes as
E(r) = E1(r) × · · · × EK(r) × {nu,K+1}. (3.49)Let n̂(k), k ≥ 0, be the traje
tory starting at 0 and 
onverging to nu. Let n̄(k) be thetraje
tory starting at n̄ and 
onverging to ncon.



51Fix an initial 
ondition n ∈ Σ and let n(k), k ≥ 0, be the traje
tory starting at n.We re
all some fa
ts from the general theory of dynami
al systems. The ω-limit set of n isthe set of all limit points of the traje
tory {n(k)}:
ω(n) = {p ∈ Σ | there is a subsequen
e km with lim

m→∞
n(km) = p}.

ω(n) is non-empty, 
ompa
t, and invariant, i.e., if p ∈ ω(n) the traje
tory starting at p stayswithin ω(n). Furthermore the traje
tory 
onverges to ω(n), i.e., limk d(n(k), ω(n)) = 0, with
d(x, ω(n)) = min{|x− p| | p ∈ ω(n)}.Our obje
tive is to prove that the traje
tory {n(k)} 
onverges to an equilibrium, whi
h isa
hieved in two steps. The �rst step shows that ω(n) always 
ontain an equilibrium (Lemma3.3.4). The se
ond step shows that every equilibrium is stable (Theorem 3.3.2).We adopt the following notation. For any p ∈ Σ,

fi(p) =















min{β̄ivipi, wi+1[n̄i+1 − pi+1], Fi}, 1 ≤ i < N

min{β̄NvNpN , FN}, i = N

,and
fi(k) = fi(n(k)).Lemma 3.3.3 (i) Suppose nu ≤ p ≤ ncon. Then

fi(p) ≥ φi, all i, and fi(p) = Fi, i ∈ {I1, · · · , IK}. (3.50)(ii) If p ∈ ω(n), nu ≤ p ≤ ncon.(iii) Along the traje
tory {n(k)}

lim
k→∞

inf fi(k) ≥ φi, all i, and lim
k→∞

fi(k) = Fi, i ∈ {I1, · · · , IK}. (3.51)



52To simplify the dis
ussion we assume that n0, the upstream ramp queue, is always so largeas to maintain
f0(k) ≡ r0 = φ0, k ≥ 0. (3.52)Lemma 3.3.4 ω(n) ∩ E(r) 6= ∅.Re
all the de�nition of (Lyapunov) stability: An equilibrium ne is stable if for every ǫ > 0there is δ > 0 su
h that |n−ne| < δ implies |n(k)− ne| < ǫ for all k, in whi
h {n(k)} is thetraje
tory starting at n.Fix an equilibrium ne. By Theorem 3.2.1 ne has the form

ne = (ne,1, · · · , ne,K, ne,K+1),with ne,K+1 = nu,K+1, ne,m ∈ Em
j (r) for some j ∈ Sm, 1 ≤ m ≤ K + 1.Lemmas 3.3.5-3.3.6 will prove that if |n−ne| < δ, and n(k) = (n1(k), · · · , nK(k), nK+1(k)),

k ≥ 0 is the traje
tory starting at n, then there exists an equilibrium ñe, possibly di�erentfrom ne, su
h that
|ñe,m − ne,m| < ǫ, lim

k→∞
nm(k) = ñe,m, 1 ≤ m ≤ K + 1, (3.53)Lemma 3.3.5 (3.53) holds for m = K + 1. In fa
t

lim
k→∞

nK+1(k) = nu,K+1 = ne,K+1. (3.54)Lemma 3.3.6 Suppose (3.53) holds for m− 1 ≥ 0. Then it holds for m.



53Theorem 3.3.2 Every equilibrium ne ∈ E(r) is stable. In fa
t for ǫ > 0 there is δ > 0 su
hthat if |n − ne| < δ, the traje
tory {n(k)} starting at n 
onverges to an equilibrium ñe with
|ñe − ne| < ǫ.Proof Lemmas 3.3.5-3.3.6 prove the se
ond part of the assertion whi
h implies stability. 2Figure 3.7 illustrates Theorem 3.3.1. Traje
tories starting 
lose to an equilibrium all 
onvergeto some nearby equilibrium.Theorem 3.3.3 The CTM model is a 
onvergent system, i.e. every traje
tory 
onverges tosome equilibrium in E(r).Proof Consider any traje
tory {n(k)}. By Lemma 3.3.4 there is an equilibrium ne and asubsequen
e {km} along whi
h n(km) → ne as m → ∞. By Theorem 3.3.2 the traje
torymust 
onverge to this equilibrium. 2Re
all that the stable manifold Σ(ne) of an equilibrium ne ∈ E(r) 
omprises all n ∈ Σ whosetraje
tories 
onverge to ne. The next result 
hara
terizes the orbit stru
ture.Corollary 3.3.1 If r is stri
tly feasible, E(r) = {nu} and Σ(nu) = Σ. If r is not stri
tlyfeasible, E(r) is a K-dimensional manifold and Σ(ne) is a (N −K)-dimensional manifoldfor ne 6= nu, ncon, whereas Σ(nu),Σ(ncon) are N -dimensional manifolds with boundary.



543.4 Impli
ations for Ramp MeteringWe explore two impli
ations for ramp metering. The �rst 
onsiders the 
ase when thedemand ve
tor r is infeasible, i.e., the asso
iated equilibrium �ow φ given by (3.48) is su
hthat it ex
eeds the 
apa
ity in some 
ell. Peak hour demand may be infeasible in this sense.We begin with an example to illustrate the issues.
Figure 3.10: Freeway, on-ramp and o�-ramp �ows of Example: feasible demand (top); ex
essdemand (bottom).Example. The upper part of Figure 3.10 displays a freeway with four identi
al 
ells, ea
hwith 
apa
ity 6000 vph. The demand ve
tor r = (r0 = 4000, r1 = 2000, r2 = 2700, r3 =

0, r4 = 1200). All split ratios are the same: βi = β = 0.2, so β̄ = 0.8 and α = β[β̄]−1 =

0.25. The demand r is feasible and the equilibrium �ow φ = (φ0 = 4000, φ1 = 4800, φ2 =

6000, φ3 = 4800, φ4 = 6000). The o�-ramp �ow in 
ell i is αφi. Cells 2 and 4 are bottlene
k
ells, with equilibirum �ows equal to 
apa
ity.Now 
onsider the demand r̃ in whi
h r̃4 = 1300 > r4 and r̃i = ri, 0 ≤ i ≤ 3. This demandis not feasible be
ause it would in
rease φ4 to φ3 + r̃4 = 6100, whi
h ex
eeds 
apa
ity.Evidently, the in
reased on-ramp �ow in 
ell 4 will 
reate 
ongestion in 
ell 4 and for
e aredu
tion in the �ow out of 
ell 3 from φ3 = 4800 to φ̃3 = 4700. This redu
tion from φ3 to
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φ̃3 is a
hieved by a redu
tion in the �ow from 
ell 2 from φ2 = 6000 to φ̃2 = 5875, whi
h inturn redu
es the �ow from 
ell 1 from φ1 = 4800 to φ̃1 = 4673.75, and ultimately the �owfrom 
ell 0 from φ0 = 4000 to φ̃0 = 3804.7. As a result the on-ramp queue n0 will grow atthe rate of 4000 − 3804.6875 = 195.3125 vph. All 
ells will be
ome 
ongested.The redu
tions in the equilibrium �ow from φ to φ̃ will proportionately redu
e the dis
hargeat the o�-ramps from αφi to αφ̃i. The new equilibrium �ows are displayed in the lower partof the �gure.The example suggests some observations.1. The infeasible demand r̃ leads to a unique equilibrium �ow φ̃. This is the �ow 
orre-sponding to the feasible demand r̃f , whi
h is the same as r̃, ex
ept that the upstream �owis redu
ed from φ0 = 4000 to φ̃0 ≈ 3804.7. The system 
onverges to the (unique) most
ongested equilibrium 
orresponding to r̃f .2. The redu
tion in the �ow at the upstream ramp of about 196 = 4000− 3804 vph is morethan the `ex
ess' demand of 1300 − 1200 = 100 vph at the ramp in 
ell 4. Suppose thatwe meter the on-ramp in 
ell 4 and admit only 1200 vph. The queue at this ramp will nowgrow at 100 vph, but the resulting equilibrium �ow and the o�-ramp dis
harges will be thesame as in the top of the �gure; hen
e the total dis
harge will be higher by 196 − 100 = 96vph.3. Figure 3.11 shows the phase portrait of the freeway 
onsidered in Figure 3.6. The �gurealso displays the equilibrium set E(r̃f ). All of the traje
tories 
onverge to the most 
ongested



56equilibrium in E(r̃f ). There is a pleasing symmetry with the 
ase of stri
tly feasible demand,in whi
h every traje
tory 
onverges to the un
ongested equilibrium as in Figure 3.8.
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Figure 3.11: Orbits of the infeasible demand example.The next result pla
es the example above in a general setting. The freeway stru
ture is thesame as in se
tions 3.1-3.3. Let r = (r0, · · · , rN ) be a demand ve
tor. Let φ be the solutionof (3.48):
φ0 = r0, φi = β̄i(φi−1 + ri), 1 ≤ i ≤ N.Suppose that r is infeasible, so that φi > Fi for some i.To simplify the notation we make two assumptions. First φN > FN , and if rN = 0 thedemand be
omes feasible. Se
ond, if r0 = 0 (zero in�ow from the upstream ramp) the



57demand again be
omes feasible.Sin
e φN > FN , under demand r the entire freeway will be
ome 
ongested as in the example.Sin
e with r0 = 0 the demand is feasible,
r̃0 = max{ρ ≥ 0 | the demand (ρ, r1, · · · , rN ) is feasible} (3.55)is well-de�ned, i.e., r̃0 ≥ 0. Sin
e with rN = 0 the demand is feasible,
r̂N = max{ρ ≥ 0 | the demand (r0, · · · , rN−1, ρ) is feasible} (3.56)is similarly well-de�ned.Theorem 3.4.1 (i) r̃0 < r0 is the largest upstream �ow for whi
h the demand

r̃ = (r̃0, · · · , rN−1, rN ) is feasible. The 
orresponding equilibrium �ow φ̃ is
φ̃0 = r̃0, φi = β̄i(φ̃i−1 + ri), 1 ≤ i ≤ N.(ii) With demand r, under the no-metering strategy every traje
tory 
onverges to the (unique)most 
ongested equilibrium ncon ∈ E(r̃) 
orresponding to demand r̃. Moreover, the queue

n0(k) at the upstream ramp grows inde�nitely at the rate of (r0 − r̃0) vehi
les per period.(iii) r̂N < rN is the largest �ow for whi
h the demand r̂ = (r0, r1, · · · , r̂N ) is feasible. The
orresponding equilibrium �ow φ̂ is
φ̂0 = r0, φ̂i = β̄i(φ̂i−1 + ri), 1 ≤ i ≤ N − 1, φ̂N = β̄N (φ̂N−1 + r̂N ).Under the ramp metering strategy that redu
es the on-ramp �ow in 
ell N from rN to r̂N ,every traje
tory 
onverges to some equilibrium in E(r̂). The queue at the on-ramp in 
ell N



58grows inde�nitely at the rate of (rN − r̂N ) vehi
les per period.(iv) Flows under the ramp-metering strategy are larger throughout the freeway:
φ̃i < φ̂i, 1 ≤ i < N and φ̃N = φ̂N = FN .Suppose βi > 0 for some 1 ≤ i < N , so that there is non-zero o�-ramp �ow in at least one
ell. Then the total dis
harge under the ramp-metering strategy is stri
tly larger than underthe no-metering strategy. Moreover,
µ =

r0 − r̃0
rN − r̂N

= (β̄1 · · · β̄N−1)
−1 > 1. (3.57)Proof. (i) follows from (3.55) and (3.48). Sin
e the entire freeway be
omes 
ongested under

r, every traje
tory 
onverges to ncon(r̃) by (3.47) and, by (i), vehi
les a

umulate at theupstream ramp at the rate of (r0 − r̃0) per period. This proves (ii).To prove (iii) we solve (3.48) re
ursively for r̃ and r̂, setting β̄0 = 1, to get
φ̃i =

i
∑

j=1

(β̄i · · · β̄j)rj + (β̄0 · · · β̄i)r̃0, 1 ≤ i ≤ N, (3.58)
φ̂i =















∑i
j=1(β̄i · · · β̄j)rj + (β̄0 · · · β̄i)r0, 1 ≤ i ≤ N − 1

β̄N r̂N +
∑N−1

j=1 (β̄j · · · β̄N )rj + (β̄0 · · · β̄N )r0, i = N

. (3.59)Sin
e r̃0 < r0 it follows from (3.58)-(3.59) that φ̃i < φ̂i, 0 ≤ i < N . Also, sin
e r̂N isthe largest �ow that keeps φ̂N ≤ FN , it must be that φ̂N = FN . Similarly φ̃N = FN .Hen
e if βi > 0 for some 1 ≤ i < N , then βiφ̂i > βiφ̃i, i.e., the o�-ramp dis
harge under



59ramp-metering is stri
tly larger in at least one 
ell. Lastly, from (3.58) and (3.59),
FN = φ̃N =

N
∑

j=1

(β̄j · · · β̄N )rj + (β̄0 · · · β̄N )r̃0,

FN = φ̂N = β̄N r̂N +

N−1
∑

j=1

(β̄j · · · β̄N )rj + (β̄0 · · · β̄N )r0,whi
h, upon subtra
tion, gives
β̄N (rN − r̂N ) = (β̄0 · · · β̄N )(r0 − r̃0),and so
rN − r̂N = (β̄1 · · · β̄N−1)(r0 − r̃0),whi
h implies (3.57) be
ause β̄i < 1 for at least one i. 2Theorem 3.4.1 prompts some observations.1. The dis
ussion of infeasible demand above assumes that the on-ramp �ow in a 
ell takespriority over the �ow from the upstream 
ell: the latter 
annot blo
k an on-ramp �ow, evenif the 
ell is 
ongested. This priority is impli
it in the treatment of ri(k) in (3.2).2. The unserved demand under the ramp metering strategy is (rN − r̂N ) vehi
les per period;the unserved demand under the no-metering strategy is (r0− r̃0). By (3.57), the no-meteringstrategy magni�es the unserved demand under the ramp strategy by µ = (β̄1 · · · β̄N−1)

−1.The larger are the split ratios, the larger is the `multiplier' µ, and worse is the no-meteringstrategy. (In the example of Figure 3.10 µ = (0.8 × 0.8 × 0.8)−1 ≈ 2.)3. The ramp metering strategy in
reases speed in every 
ell i (hen
e redu
es travel time).Be
ause φ̂i > φ̃i and the freeway is 
ongested under the no-metering strategy, the funda-



60mental diagram implies that the density n̂i < ñi whi
h, in turn, implies that the speed (=�ow/density) under ramp metering is higher: φ̂i/n̂i > φ̃i/ñi.4. Be
ause of (3.57) the total travel time under the no-metering strategy grows arbitrarilylarger than under the no-metering strategy.5. An intuitive explanation of the in
reased o�-ramp dis
harge under the ramp meteringstrategy might be that the no-metering strategy 
reates a 
ongestion �queue� that blo
ks theo�-ramps. This explanation is too 
rude. Note that under the ramp-metering strategy, thesystem 
an 
onverge to any equilibrium in E(r̂), in
luding the most 
ongested equilibrium
ncon(r̂), and under the no-metering strategy it 
onverges to the most 
ongested equilibrium
ncon(r̃). Thus the entire freeway may be 
ongested under both strategies. Nevertheless,the �ows in every 
ell, and hen
e the o�-ramp �ows, are larger under the ramp meteringstrategy. Thus a more a

urate (but less intuitive) explanation is that the 
ongestion queueunder ramp metering �moves faster� than the queue under the no-metering strategy.While Theorem 3.4.1 is intuitively evident, the se
ond impli
ation of the theory is surprising:Theorem 3.4.2 says that ramp metering 
an redu
e total travel time even when the demandis feasible.Fix a feasible (but not stri
tly feasible demand) r; let φ be its equilibrium �ow given by(3.48) and E(r) its equilibrium set. Re
all that f(ne) = φ for all ne ∈ E(r).To simplify the notation we assume that under r the only bottlene
k is 
ell N; hen
e φN =

FN , φi < Fi, 1 ≤ i < N , φ0 = r0 ≤ F0. Suppose the freeway is initially in a 
ongestedequilibrium n(0) = ne in whi
h 
ells j, · · · , N are 
ongested for some 1 ≤ j < N , with
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ne

i (0) = ncon
i , j ≤ i ≤ N , and 
ells 1, · · · , j− 1 are un
ongested with ne

i = nu
i , 1 ≤ i < j. Forany p ∈ Σ write nu ≺ p ≺ ne if

nu
i < pi < ne

i , j ≤ i ≤ N, and nu
i = pi = ne

i , 1 ≤ i < j. (3.60)Lemma 3.4.1 re�nes Lemma 3.3.3(i).Lemma 3.4.1 If nu ≺ p ≺ ne,
fN(p) = φN = FN , fi(p) > φi, j ≤ i < j, and fi(p) = φi, i > j. (3.61)We assume stri
tly positive demand in the 
ongested 
ells, so

ρ = min{ri, j ≤ i ≤ N} > 0.We 
onstru
t a ramp metering strategy that sele
ts the on-ramp �ow values as follows:
ri(k) =















ri − µi(k), j ≤ i ≤ N

ri, 1 ≤ i < j

. (3.62)(The {µi} are spe
i�ed below in (3.87).) Denote by p(k), k ≥ 0, the traje
tory starting at
p(0) = ne under the metering strategy (3.62).Lemma 3.4.2 There is a �nite time horizon K and a metering strategy {µi(k), k =

0, · · · ,K} su
h that the resulting (
ontrolled) traje
tory p(k), k = 0, · · · ,K, satis�es
nu ≺ p(k) ≺ ne, k = 1, · · · ,K − 1, (3.63)and

p(K) = nu. (3.64)



62In parti
ular, the ramp metering strategy steers the state from the initial 
ongested equilib-rium ne to the un
ongested equilibrium nu.Theorem 3.4.2 Suppose the freeway begins in a 
ongested equilibrium ne in whi
h 
ells
1, · · · , j − 1 are un
ongested and 
ells j, · · · , N are 
ongested. Then there exists a rampmetering strategy over a �nite horizonK at the end of whi
h the freeway is in the un
ongestedequilibrium nu. Furthermore, the �ows during k = 0, · · · ,K are larger than the equilibrium�ows. Finally, if the split ratio βi > 0 for some j ≤ i ≤ N , then the total dis
harge �ow isstri
tly larger and the total travel time is stri
tly smaller than in the no-metering strategy.Proof. By Lemma 3.4.2 in ea
h 
ell i the �ow fi(p(k)) > φi for at least one k. Hen
e thedi�eren
e in the total dis
harge

K
∑

k=0

βiβ̄
−1
i [fi(p) − φi] > 0,from whi
h the assertion follows. 2Two observations are worth making.1. If the split-ratios in the 
ongested 
ells are all zero, βi = 0, i = j, · · · , N , the rampmetering strategy does not in
rease the total dis
harge, but it moves the system to theun
ongested equilibrium nu by `moving' the `ex
ess' vehi
les ∑N

i=j[n
e
i − nu

i ] from the 
on-gested 
ells to their on-ramps. The resulting total travel time is un
hanged but tra�
 inthe freeway moves at free �ow speeds. If some of the tra�
 in the queues is diverted toalternative routes, perhaps along arterials, there will be a de
line in total travel time justas with non-zero split-ratios.



632. There is another 
ompelling reason for maintaining the freeway in free �ow. The exampleof Figure 3.6 illustrates a 
ommon situation in whi
h the 
ongestion density of 160 vehi-
les/mile (and speed of 30 mph) 
ompares with the un
ongested density of 80 vehi
les/mile(and speed of 60 mph) for a three-lane freeway. Storing the 80 additional vehi
les wouldrequire a 3/4 mile-long one-lane on-ramp (at 50 feet vehi
le spa
ing). Clearly 
ongestion
auses the freeway to be used as a very expensive parking pla
e.
Figure 3.12: By 
reating the 
y
le from ncon → nu → ncon a ramp metering strategy 
anin
rease o�-ramp dis
harge.3. A `free lun
h' result lurks behind Theorem 3.4.2. The result 
an be understood withthe help of Figure 3.12 of a two-
ell freeway whose equilibrium set E is shown on theright. By Lemma 3.4.2 the �ow in 
ell 1 is larger than the equilibrium �ow in the re
tangle
{nu < p < ncon}. The `de
ongestion' traje
tory 
onstru
ted in Lemma 3.4.2 moves thesystem from ncon to nu and 
auses some additional vehi
les to leave the freeway from theo�-ramp in 
ell 1. The remainder of the [(ncon

1 − nu
1) + (ncon

2 − nu
2)] vehi
les 
ausing theinitial 
ongestion are `stored' on the on-ramps in 
ells 1 and 2. On
e the 
ells be
omeun
ongested, the ramp metering strategy 
an now be 
hanged to release the stored vehi
lesonto the freeway, thereby 
reating the 
ongestion and moving the state from nu to nconas indi
ated by the `
ongestion' traje
tory in the �gure. Sin
e this traje
tory is inside

{nu < p < ncon} there will again be an additional o�-ramp �ow. Repeating the two-phasede
ongestion-
ongestion 
y
le provides a free lun
h.



643.5 ProofsProof of Lemma 3.2.1.Existen
e: Let f = f(r) be the equilibrium �ow. De�ne
nu

i = (β̄i vi)
−1fi, 1 ≤ i ≤ N. (3.65)Then ni(k) ≡ nu

i satis�es (3.6), be
ause (3.6) is equivalent to (3.13). Next, be
ause 0 ≤ fi ≤

Fi and Fi = β̄i vi n
c
i (see (3.1)), nu

i = (β̄i vi)
−1fi ≤ (β̄i vi)

−1Fi = nc
i . So nu is un
ongested.It remains to prove that nu is an equilibrium, i.e., satis�es (3.14), whi
h simpli�es to (3.11)be
ause nu is un
ongested. From (3.65), fi = β̄i vi n

u
i , and sin
e r is feasible, fi ≤ Fi. So(3.11) holds.Uniqueness: Suppose {0 ≤ ni ≤ nc

i ; 1 ≤ i ≤ N} is an equilibrium, i.e., satis�es (3.14)-(3.15).Sin
e ni ≤ nc
i , β̄i vi ni ≤ β̄i vi n

c
i = Fi, therefore (3.14) redu
es to

fi = min{β̄ivini, wi+1(n̄i+1 − ni+1)}.If fi 6= β̄ivini, it must be that β̄ivini > wi+1(n̄i+1 − ni+1) ≥ wi+1(n̄i+1 − nc
i+1) = Fi. This
ontradi
ts β̄i vi ni ≤ Fi, hen
e fi must equal β̄ivini, so ni = nu

i . 2Proof of Proposition 3.2.1Sin
e ni+1 ≤ nc
i+1, from (3.11),

fi = min{β̄ivini, Fi}.



65Sin
e ni > nc
i , one has β̄ivini > Fi from (3.1); and sin
e r is feasible, Fi ≥ fi. Hen
e fi = Fiand, by (3.13),

fi−1 = β̄−1
i fi − ri = β̄−1

i Fi − ri.Again, as ni > nc
i , (3.14) implies
fi−1 = min{β̄i+1vi−1ni−1, Fi−1 − wi(ni − nc

i), Fi−1} < Fi−1.Lastly, if 
ell i− k is 
ongested, ni−k > nc
i−k, hen
e

fi−k−1 = min{β̄i−k−1vi−k−1ni−k−1, Fi−k−1 + wi−k[n
c
i−k − ni−k], Fi−k−1} < Fi−k−1,and the remainder of the assertion follows. 2Proof of Corollary 3.2.1If the equilibrium n = (n1, · · · , nN ) is un
ongested, then n = nu by Lemma 3.2.1. Sosuppose there is at least one 
ongested 
ell. There are two 
ases to 
onsider. In the �rst
ase, 
ell N is 
ongested. Sin
e fN = min{β̄NvNnN , FN} < FN by stri
t feasibility, so

nN < nc
N , whi
h means 
ell N is not 
ongested. In the remaining 
ase, there must exist apair of adja
ent 
ells i, i+1 with i 
ongested and i+1 un
ongested. But then by Proposition3.2.1, fi = Fi, whi
h 
ontradi
ts stri
t feasibility of r. 2Proof of Proposition 3.2.2Be
ause 
ell i− j is 
ongested, i.e., ni−j > nc

i−j, and fi−j < Fi−j ,
fi−j = min{β̄i−jvi−jni−j, Fi−j − wi−j+1(ni−j+1 − nc

i−j+1), Fi−j}

= Fi−j − wi−j+1(ni−j+1 − nc
i−j+1) < Fi−j ,



66so that ni−j+1 > nc
i−j+1, i.e., 
ell i− j + 1 is 
ongested. The result follows by indu
tion. 2Proof of Proposition 3.2.3The assertion is true of segment SK+1 be
ause downstream of 
ell N is free �ow by assump-tion. Consider segment Sk. Sin
e

fIk
= min{β̄Ik

vIk
nIk

, FIk
−wIk+1(nIk+1 − nc

Ik+1), FIk
} = FIk

,we must have nIk+1 ≤ nc
Ik+1, i.e., 
ell Ik + 1 is un
ongested, and (3.18) holds. 2Proof of Lemma 3.2.2Be
ause of (3.24) the equilibrium �ows fIK+1, · · · , fN are stri
tly below 
apa
ity and so, byCorollary 3.2.1, EK+1(r) = {nu,K+1}, and (3.25) follows from (3.65). 2Proof of Lemma 3.2.3Let nk ∈ Ek(r) be an equilibrium. Then (i) follows from Lemma 3.2.1. Next, a

ordingto Proposition 3.2.2 there exists j su
h that 
ells Ik−1 + 1, · · · , j − 1 are un
ongested and

j, · · · , Ik are 
ongested. Hen
e for i < j − 1,
fi = min{β̄ivin

k
i , Fi −wi+1(n

k
i+1 − nc

i+1), Fi} = β̄ivin
k
i ,be
ause nk

i ≤ nc
i , n

k
i+1 ≤ nc

i+1, whi
h proves (3.26).For i ≥ j + 1,
fi = min{β̄ivin

k
i , Fi − wi+1(n

k
i+1 − nc

i+1), Fi} = Fi − wi+1(n
k
i+1 − nc

i+1),be
ause nk
i > nc

i , n
k
i+1 > nc

i+1, whi
h proves (3.27).



67Lastly, be
ause fj−1 < Fj−1,
fj−1 = min{β̄j−1vj−1n

k
j−1, Fj−1−wj(n

k
j−n

c
j), Fj−1} = min{β̄j−1vj−1n

k
j−1, Fj−1−wj(n

k
j−n

c
j)}Hen
e either fj−1 = Fj−1 −wj(n

k
j − nc

j) and then (3.28) holds, or fj−1 = β̄j−1vj−1n
k
j−1 andthen (3.29) holds. 2Proof of Lemma 3.3.1Suppose x ≤ y. We must show

gi(xi−1, xi, xi+1) ≤ gi(yi−1, yi, yi+1). (3.66)We verify the inequality one 
oordinate at a time. Suppose �rst that xi+1 ≤ yi+1 but
xi−1 = yi−1, xi = yi. Then from (3.6)-(3.7)
gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= −β̄−1
i min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi} + β̄−1

i min{β̄iviyi, wi+1[n̄i+1 − xi+1], Fi} ≤ 0.Suppose next that xi−1 ≤ yi−1 but xi = yi, xi+1 = yi+1. Then from (3.6)-(3.7)
gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= β̄−1
i−1 min{β̄i−1vi−1xi−1, wi[n̄i − xi], Fi+1} − β̄−1

i−1 min{β̄i−1vi−1yi−1, wi[n̄i − xi], Fi−1} ≤ 0.Lastly suppose xi ≤ yi but xi−1 = yi−1, xi+1 = yi+1. To show (3.66) 
onsider three separate
ases.



68Case 1 : xi < yi ≤ nc
i . Then from (3.6)-(3.7) and (3.11)

gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= xi − β̄−1
i min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi} − yi + β̄−1

i min{β̄iviyi, wi+1[n̄i+1 − xi+1], Fi}














= xi − yi if β̄ivixi ≥ min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi}

≤ (1 − vi)xi − (1 − vi)yi if β̄ivixi = min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi}

≤ 0, be
ause 0 < vi < 1.Case 2 : xi ≤ nc
i < yi. Then from (3.6)-(3.7) and (3.11)

gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= xi − β̄−1
i min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi} + min{β̄i−1vi−1xi−1, wi[n̄i − xi], Fi}

− yi + β̄−1
i min{β̄iviyi, wi+1[n̄i+1 − xi+1], Fi} − min{β̄i−1vi−1xi−1, wi[n̄i − yi], Fi}If β̄ivixi ≥ min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi},

gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= xi − yi + min{β̄i−1vi−1xi−1, wi[n̄i − xi], Fi} − min{β̄i−1vi−1xi−1, wi[n̄i − yi], Fi}














≤ xi − yi ≤ 0, if wi[n̄i − xi] ≤ min{β̄i−1vi−1xi−1, Fi}

= (1 − wi)(xi − yi) ≤ 0, if wi[n̄i − xi] = min{β̄i−1vi−1xi−1, Fi}, be
ause 0 < vi < 1,and if β̄ivixi < min{β̄ivixi, wi+1[n̄i+1 − xi+1], Fi},
gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

≤ xi − yi + min{β̄i−1vi−1xi−1, wi[n̄i − xi], Fi} − min{β̄i−1vi−1xi−1, wi[n̄i − yi], Fi}

≤ 0, as before.



69Case 3 : nc
i ≤ xi < yi ≤ nc

i . Then from (3.6)-(3.7) and (3.11)
gi(xi−1, xi, xi+1) − gi(yi−1, yi, yi+1)

= xi − yi + min{β̄i−1vi−1xi−1, wi[n̄i − xi]} − min{β̄i−1vi−1xi−1, wi[n̄i − yi]}














= xi − yi ≤ 0, if wi[n̄i − yi] > β̄i−1vi−1xi−1

≤ (1 − wi)(xi − yi) ≤ 0, if wi[n̄i − yi] ≤ β̄i−1vi−1xi−1, be
ause 0 < vi < 1.Thus g is stri
tly monotone, be
ause if x ≤ y,
gi(xi−1, xi, xi+1) ≤ gi(yi−1, xi, xi+1) ≤ gi(yi−1, yi, xi+1) ≤ gi(yi−1, yi, yi+1);moreover, it is trivial to 
he
k that if x 6= y then g(x) 6= g(y).Lastly g is not strongly monotone, be
ause if x < y but xi−1 = yi−1, xi = yi, xi+1 = yi+1,then gi(x) = gi(y). 2Proof of Lemma 3.3.2(i) Sin
e n̂(0) ≤ n(0) ≤ n̄(0), monotoni
ity implies n̂(1) ≤ n(1) ≤ n̄(1), and then (3.45)follows by indu
tion.(ii) Sin
e n̂(1) ≥ n̂(0) = 0, monotoni
ity implies n̂(2) = g(n̂(1)) ≥ g(n̂(0)) = n̂(1). Byindu
tion, the traje
tory is in
reasing: n̂(k + 1) ≥ n̂(k). Sin
e the traje
tory is boundedabove by the jam density, it must 
onverge to some equilibrium point, say n̂e. Furthermore,sin
e n(k) ≡ nu is also a traje
tory, by (3.45) one must have n̂e ≤ nu, and so (3.44) implies

n̂e = nu.(iii) Sin
e n̄ = n̄(0) ≥ n̄(1), monotoni
ity implies that the traje
tory is de
reasing: n̄(k+1) ≤

n̄(k). Sin
e the traje
tory is bounded below by 0, it must 
onverge to an equilibrium, say
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n̄e. As n(k) ≡ ncon is also a traje
tory, by (3.45) one must have n̄e ≥ ncon, and so (3.44)implies n̄e = ncon. 2Proof of Lemma 3.3.3Evaluate the three alternatives in fi(p) = min{β̄ivipi, wi+1[n̄i+1 − pi+1], Fi}:

fi(p) = β̄ivipi ≥ β̄ivin
u
i = φi, by (3.65), or

= wi+1[n̄i+1 − pi+1] ≥ wi+1[n̄i+1 − ncon
i+1] = φi, by (3.30), or

= Fi ≥ φi, always.Hen
e fi(p) ≥ φi and assertion (i) follows sin
e for bottlene
k 
ells φi = Fi. (ii) followsfrom the observations that n̂(k) ≤ n(k) ≤ n̄(k) and n̂(k) → nu, n̄(k) → ncon by Lemma3.3.2; hen
e every limit point p of {n(k)} satis�es nu ≤ p ≤ ncon. To prove (iii) 
onsidera subsequen
e {km} along whi
h fi(km) → lim inf fi(k) and n(km) → p ∈ ω(n). Then
lim inf fi(k) = fi(p) ≥ φi, by (i) and (ii). 2Proof of Lemma 3.3.4Let p0 ∈ ω(n) and p(k), k ≥ 0, the traje
tory starting at p0. Rewrite (3.6) in terms of thistraje
tory, and (3.48) as

pi(k + 1) = pi(k) − β̄−1
i fi(p(k)) + fi−1(p(k)) + ri

ri = β̄−1
i φi − φi−1.Adding these together gives

pi(k + 1) = pi(k) + β̄−1
i [φi − fi(p(k))] − [φi−1 − fi−1(p(k))].



71Summing this equation for i = 2, · · · , j and using (3.52) leads to
j

∑

i=2

pi(k + 1) =

j
∑

i=2

pi(k) +

j
∑

i=2

β̄−1
i [φi − fi(p(k))] −

j
∑

i=2

[φi−1 − fi−1(p(k))]

=

j
∑

i=2

pi(k) + [φj − fj(p(k))] +

j
∑

i=2

βiβ̄
−1
i [φi − fi(p(k))].By Lemma 3.3.3, and taking j = N , shows that ∑N

2 pi(k) is de
reasing, and sin
e it ispositive, it 
onverges. Hen
e fi(p(k)) → φi for ea
h i. So if p1 ∈ ω(p0),
f(p1) = φ, i.e., p1 ∈ E(r),from whi
h the assertion follows sin
e p1 ∈ ω(p0) ⊂ ω(n), be
ause ω(n) is invariant. 2Proof of Lemma 3.3.5By Lemma 3.3.2, n̂(k) ≤ n(k) ≤ n̄(k), n̂(k) → nu, n̄(k) → ncon. Then (3.54) followsbe
ause, by (3.49), ncon,K+1 = nu,K+1. 2Proof of Lemma 3.3.6Consider (3.53) for m ≥ 1. By Theorem 3.2.1 ne,m ∈ Em

Im−j(r) for some j ≥ 0, so that 
ells
Im − j, · · · , Im are 
ongested and Im−1 + 1, · · · , Im − j − 1 are un
ongested as indi
ated inFigure 3.13.

Figure 3.13: In equilibrium ne,m 
ells Im − j, · · · , Im of Sm are 
ongested.We will prove (3.53) for m, separately analyzing the three 
ases: j = Im−1 + 1, j = Im, and
Im−1 + 1 < j < Im.



72Case (i): j = Im−1 + 1. In this 
ase at ne,m the entire segment Sm is 
ongested. Theindu
tion hypothesis is not used for this 
ase.By Theorem 3.2.1 ne,m = ncon,m and, by (3.30),
ne,m

i = nc
i + w−1

i (Fi−1 − φi−1) > nc
i , i ∈ Sm. (3.67)By (3.51) for η > 0 we 
an sele
t δ > 0 so that

|nm − ne,m| < δ ⇒ 0 ≤ FIm − fIm(k) = η(k) < η. (3.68)Assume for now that
nm

i (k) > nc
i , k ≥ 0, i ∈ Sm, (3.69)so that

fi(k) = min{β̄ivin
m
i (k), Fi − wi+1[n

m
i+1(k) − nc

i+1], Fi}

= Fi − wi+1[n
m
i+1(k) − nc

i+1], i = Im−1, · · · , Im. (3.70)Substituting (3.67), (3.68), (3.70), and (3.48) in
nm

i (k + 1) = nm
i (k) − β̄−1

i fi(k) + fi−1(k) + ri

= nm
i (k) − β̄−1

i [fi(k) − φi] + fi−1(k) − φi−1,gives, for i = Im,
nm

i (k + 1) = nm
i (k) − β̄−1

i [FIm − η(k) − φi] + Fi−1 − wi[n
m
i (k) − nc

i ] − φi−1

= nm
i (k) − wi[n

m
i (k) − nc

i − w−1
i (Fi−1 − φi−1)] + β̄−1

i η(k), as FIm = φIm

= nm
i (k) − wi[n

m
i (k) − ne,m

i ] + β̄−1
i η(k); (3.71)



73and, for i = Im−1 + 1, · · · , Im − 1,
nm

i (k + 1) = nm
i (k) − β̄−1

i [Fi − wi+1(n
m
i+1(k) − nc

i+1) − φi] + Fi−1 − wi[n
m
i (k) − nc

i ] − φi−1

= nm
i (k) + β̄−1

i wi[n
m
i+1(k) − nc

i+1 − w−1
i (Fi − φi)]

−wi[n
m
i (k) − nc

i − w−1
i (Fi−1 − φi−1)]

= nm
i (k) + β̄−1

i wi+1[n
m
i (k) − ne,m

i ] − wi[n
m
i (k) − ne,m

i ]. (3.72)De�ne the ve
tors xm(k) with 
omponents xm
i (k) = nm

i (k)−ne,m
i , i ∈ Sm. In terms of xm(k)the di�eren
e equations (3.71)-(3.72) 
an be written as

xm(k+1) =

























1 − wIm−1+1 β−1
Im−1+1wIm−1+2 · · 0

· · · · ·

0 · · · 0 1 − wIm−1 β−1
Im−1wIm

0 · · · 0 0 1 − wIm

























xm(k)+

























0

·

0

β−1
Im
η(k)

























.

(3.73)The di�eren
e equation (3.73) is of the form
xm(k + 1) = Axm(k) + u(k), xm(0) = nm − ne,m,and has the solution

xm(k) = Ak(nm − ne,m) +
k−1
∑

l=0

Ak−1−lu(l).The eigenvalues of A are (1 − wIm−1+1), · · · , (1 − wIm), all of whi
h lie in (0, 1), sin
e
0 < wi < 1. Hen
e ‖ Ak ‖≤ Mλk for some M < ∞ and 0 < λ < 1. Also |u(l)| ≤ (β̄Im)−1η.It follows that if |nm − ne,m| < δ, su�
iently small, then (3.69) holds and |xm(k)| ≤ ǫ forall k ≥ 0.



74Case (ii): j = Im. In this 
ase 
ells j − 1 = Im−1 + 1, · · · , Im − 1 are not 
ongested; so
φj = Fj , φi < Fi, i < j, i ∈ Sm.By the indu
tion hypothesis, for ǫ > 0 there is δ > 0 su
h that for |n− ne| < δ, there is anequilibrium ñe su
h that

|nm−1(k) − ñe,m−1| < ǫ, k ≥ 0.By Proposition 3.2.3, ñe,m−1
j+1 < nc

j+1; hen
e, for ǫ > 0 small
nm−1

j+1 (k) < ñe,m−1
j+1 + ǫ < nc

j+1. (3.74)Next, by (3.51) we 
an sele
t δ > 0 so that
|n− ne| < δ ⇒ 0 ≤ FIm−1 − fIm−1(k) = η(k) → 0. (3.75)By Lemma 3.2.3, ne,m has the form (see bottom part of Figure 3.3)

ne,m
i =















nc
j + (1 − 2ψ)w−1

j (Fj−1 − φj−1), i = j, for some 0 ≤ ψ ≤ 1/2

nu
i = (β̄ivi)

−1φi < nc
i , i < j, i ∈ Sm

.We now examine the traje
tory {n(k)} starting at n. Assume for now that
nm

j (k) < ne,m
j + ψw−1

j (Fj−1 − φj−1) = nc
j + (1 − ψ)w−1

j (Fj−1 − φj−1), (3.76)
nm

i (k) < ne,m
i + ψ(β̄ivi)

−1(nc
i − ne,m

i ), i < j, i ∈ Sm. (3.77)From (3.74) and (3.76)
fj(k) = min{β̄jvjn

m
j (k), Fj − wj+1(n

m−1
j+1 (k) − nc

j+1), Fj}

= min{β̄jvjn
m
j (k), Fj} =















Fj , if nm
j (k) > nc

j

β̄jvjn
m
j (k), if nm

j (k) ≤ nc
j

. (3.78)



75Next,
fj−1(k) = min{β̄j−1vj−1n

m
j−1(k), Fj−1 − wj(n

m
j (k) − nc

j), Fj+1}. (3.79)From (3.77),
β̄j−1vj−1n

m
j−1(k) < β̄j−1vj−1[n

e,m
j−1 +ψ(β̄j−1vj−1)

−1(nc
j−1 −ne,m

j−1)] = φj−1 +ψ(Fj−1 − φj−1),and from (3.76)
Fj−1 −wj(n

m
j (k) − nc

j) ≥ Fj−1 −wj [(1 − ψ)w−1
j (Fj−1 − φj−1)] = ψFj−1 + (1 − ψ)φj−1.Substituting the pre
eding two inequalities into (3.79) gives

fj−1(k) = β̄j−1vj−1n
m
j−1(k). (3.80)Lastly, for i ≤ j − 2, i ∈ Sm, from (3.77)

fi(m) = min{β̄ivin
m
i (k), Fi −wi+1(n

m
i+1(k) − nc

i+1, Fi} = β̄ivin
m
i (k). (3.81)Substituting (3.78), (3.80), (3.81), and (3.48) in

nm
i (k + 1) = nm

i (k) − β̄−1
i fi(k) + fi−1(k) + ri

= nm
i (k) − β̄−1

i [fi(k) − φi] + [fi−1(k) − φi−1],gives the di�eren
e equation system for {nm(k)}:
nm

j (k + 1) = nm
j (k) − β̄−1

j [min{β̄jvjn
m
j (k), Fj} − β̄jvjn

e,m
j ]

+β̄j−1vj−1[n
m
j−1(k) − ne,m

j−1(k)]

nm
i (k + 1) = nm

i (k) − vi[n
m
i (k) − ne,m

i (k)] + β̄i−1vi−1[n
m
i−1 − ne,m

i−1],

i = Im−1 + 2, · · · , j − 1

nm
Im−1+1(k + 1) = nm

Im−1+1(k) − vIm−1+1(k)[n
m
Im−1+1(k) − ne,m

Im−1+1(k)] − η(k).



76In terms of the variables xm
i (k) = nm

i (k)−ne,m
i , i ≤ j, i ∈ Sm, this system 
an be rewrittenas

xm
j (k + 1) = xm

j (k) − β̄−1
j [min{β̄jvjn

m
j (k), Fj} − β̄jvjn

e,m
j ] + β̄j+1vj+1x

m
j+1(k) (3.82)and

























xIm−1+1(k + 1)

·

xj−2(k + 1)

xj−1(k + 1)

























=

























1 − vIm−1+1 0 · · 0

· · · · ·

0 · · · β̄j−3vj−3 1 − vj−2 0

0 · · · 0 β̄j−2vj−2 1 − vj−1

















































xIm−1+1(k)

·

xj−2(k)

xj−1(k)

























+

























−η(k)

0

·

0

























. (3.83)
The di�eren
e equation (3.83) is of the form

z(k + 1) = Az(k) − bη(k),and has the solution
z(k) = Akz(0) −

k−1
∑

l=0

Ak−1−lbη(l).The eigenvalues of A are (1 − vIm−1+1), · · · , (1 − vj−1), all of whi
h lie in (0, 1), sin
e
0 < vi < 1. By (3.75), η(l) → 0, η(l) ≥ 0. Hen
e z(k) → z∗ ≤ 0, and (3.77) is assured byindu
tion. Furthermore, be
ause η(l) ≥ 0,

xm
j−1(k) ≤Mλk, (3.84)



77for some M <∞ and 0 < λ < 1.Lastly, rewrite (3.82) as
xm

j (k + 1) =















(1 − vj)x
m
j + β̄j−1vj−1x

m
j−1(k), if xm

j ≤ −∆

xm
j (k) + ∆ + β̄j−1vj−1x

m
j−1(k), if xm

j ≥ −∆

, (3.85)in whi
h ∆ = (1 − 2ψ)w−1
j (Fj−1 − φj−1).Be
ause ∆ > 0 and xm

j−1 → 0, the se
ond alternative in (3.85) 
annot hold for k ≥ K, forsome �nite K, and so
xm

j (k) = (1 − vj)
k−Kxm

j (K) +

k−1
∑

l=K

(1 − vj)
k−1−lβ̄j−1vj−1x

m
j−1(l),
an be made arbitrarily small, proving (3.76).Case (iii): Im−1 + 1 < j < Im. In this 
ase at ne,m 
ells j, · · · , Im are 
ongested and 
ells

Im−1 + 1, · · · , j − 1 are un
ongested. The proof for this 
ase 
ombines the argument inCase (i) for the 
ongested 
ells and the argument in Case (ii) for the un
ongested 
ells. Thedetails are omitted. 2Proof of Corollary 3.3.1By Theorem 3.2.1 E(r) is a K-dimensional manifold. By Theorem 3.3.3
Σ =

⋃

ne∈E(r)

Σ(n).By Lemma 3.3.2 every traje
tory starting at n ≤ nu 
onverges to nu and every traje
torystarting at n ≥ ncon 
onverges to ncon. Be
ause E(r) is ordered, it is not very di�
ult



78to show, using monotoni
ity, that the stable manifolds of all equilibria ne 6= nu, ncon aredi�eomorphi
. The assertion then follows. 2Proof of Lemma 3.4.1First,
fN (p) = min{β̄NvNpN , FN} ≥ min{β̄NvNn

u
N , FN} = φN = FN .Next, for j ≤ i < N evaluate the three terms in fi(p) = min{β̄ivipi, Fi−wi+1[n̄i+1−pi+1], Fi}gives

fi(p) = β̄ivipi > β̄ivin
u
i = φi, or

= Fi − wi+1[n̄i+1 − pi+1] > Fi − wi+1[n̄i+1 − ncon
i+1] = φi, or

= Fi > φi,so fi(p) > φi. The last 
lause in (3.61) follows from nu
i = pi, i > j. 2Proof of Lemma 3.4.2Set µi(k) ≡ 0, i < j. Following (3.6), the 
ontrolled traje
tory is given by

pi(k + 1) = pi(k) − β̄−1
i fi(p(k) + fi−1(p(k)) + ri − µi(k), 1 ≤ i ≤ N, k ≥ 0. (3.86)Observe that for i < j, pi(0) = ne

i = nu
i and ri(k) = ri. Hen
e under any metering strategyof the form (3.62), pi(k) ≡ ne

i , i < j. Thus the metering strategy a�e
ts the densities onlyin 
ells j, · · · , N .Rewrite (3.86) as
pi(k + 1) = gi(p(k)) − µi(k), 1 ≤ i ≤ N, k ≥ 0,



79and de�ne the metering strategy by
µi(k) =















ρ, if gi(p(k)) ≥ nu
i + ρ

gi(p(k)) − nu
i , if nu

i ≤ gi(p(k)) < nu
i + ρ

. (3.87)Sin
e ri − µi(k) ≥ ri(k) − ρ ≥ 0, the metering strategy is feasible (on-ramp �ows arenon-negative). By 
onstru
tion of µ, nu ≺ p(k). By monotoni
ity, if p(k) ≺ ne then
p(k + 1) = g(p(k)) − µ(k) ≺ g(ne) − µ(k), so (3.63) holds by indu
tion.We now prove (3.64). Re
all that

ri = β̄−1
i φi − φi−1,and substitute for ri in (3.86) to get

pi(k + 1) = pi(k) + β̄−1
i [φi − fi(p(k)] − [φi−1 − fi−1(p(k))] − µi(k), j ≤ i ≤ N.Adding these equations gives

N
∑

i=j0

pi(k + 1) =

N
∑

i=j

pi(k) +

N
∑

i=j

β̄−1
i [φi − fi(p(k)] −

N
∑

i=j

[φi−1 − fi−1(p(k))] −
N

∑

i=j

µi(k)

=
N

∑

i=j

pi(k) +
N

∑

i=j

(β̄−1
i − 1)[φi − fi(p(k)] −

N
∑

i=j

µi(k)

+β̄−1
N [φN − fN (p(k)] − [φj−1 − fj−1(p(k))]

=

N
∑

i=j

pi(k) +

N
∑

i=j

(β̄−1
i − 1)[φi − fi(p(k)] −

N
∑

i=j

µi(k) < −
N

∑

i=j

µi(k),be
ause fN(p(k)) = φN = FN , fj−1(p(k)) = φj−1 and φi−fi(p(k)) < 0 by (3.61). Moreover,from (3.87), ∑N
i=j µi(k) ≥ ρ for ea
h k for whi
h gi(p(k) ≥ nu

i + ρ for some i. It follows that
p(K) = nu for some K ≤ [

∑

i(n
e
i − nu

i )]/ρ. 2



80
Chapter 4
CTMSIM: Intera
tive CTMSimulator for MATLAB
4.1 MotivationFreeway tra�
 measurement data are 
olle
ted by PeMS [1℄. In addition to �ow, speed ando

upan
y time 
ontours, PeMS provides the following performan
e measures:

• VHT - Vehi
le Hours Traveled, for a given unit of time and a given se
tion of freeway,the amount of time spent by all of the vehi
les on the freeway.
• VMT - Vehi
le Miles Traveled, for a given unit of time and a given se
tion of thefreeway, the sum of the miles of freeway driven by ea
h vehi
le.
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• Delay (vehi
le-hours) - di�eren
e between the a
tual VHT and the VHT that wouldbe in
urred if vehi
les traveled at free �ow speed. The value is positive when the roadis 
ongested, otherwise it is zero.
• Produ
tivity Loss (lane-mile-hours) - the number of lane-mile-hours on the freeway lostdue to redu
ed �ow, while operating under 
ongested instead of free-�ow 
onditions.The value is positive only in 
ongestion, otherwise it is zero.Our �rst requirement for a ma
ros
opi
 freeway tra�
 simulator is the ability to 
omputethese quantities and export the 
omputed data for the purpose of report generation and
omparison with the values provided by PeMS.PeMS is a starting point for any freeway study in TOPl. It allows to extra
t freeway geom-etry, estimate fundamental diagrams, split ratios for the o�-ramps, and generate a demandpro�le for the on-ramps. All these data belong to a 
on�guration �le of a ma
ros
opi
 sim-ulator. Thus, for the user to be able to generate his/her own 
on�guration �les using PeMSdata, the format of su
h �les should be transparent and well do
umented. This is our se
ondrequirement.Ideally, assuming PeMS data were 
onsistent and 
ame from healthy dete
tors, pluggingPeMS on-ramp �ow values into the simulator should produ
e �ow, speed density time 
on-tours as well as VHT and VMT that mat
h those reported by PeMS. This would validatethe tra�
 �ow model used by a simulator.Another important requirement was for the user to be able to plug in his/her own ramp
ontrollers, develop and test his/her own ramp metering strategies and 
ompare them with



82the known ones or with ea
h other.Finally, we wanted the simulation to be intera
tive, so the user 
ould see the evolutionof the freeway state, pause the simulation and 
hange some parameters like fundamen-tal diagram�to simulate an in
ident, or swit
hing 
ertain 
ontrollers on or o�, and then
ontinue. Intera
tivity also helps to 
alibrate the model�adjust fundamental diagrams,on-ramp demands and o�-ramp split ratios where ne
essary. On the other hand, it shouldbe able to exe
ute in a bat
h mode in 
ase the user wanted to run simulations for many
on�gurations automati
ally.Having looked at available ma
ros
opi
 tools (see Se
tion 2.3), the TOPl group made ade
ision to develop its own simulator based on the CTM model that would satisfy the listedrequirements and have an intuitive user interfa
e. CTMSIM [8℄ is implemented in MATLABmaking it useful and easy to handle for transportation resear
hers who 
an qui
kly andseemlessly develop plug-ins and extensions for it in a familiar environment.
4.2 CTMSIM4.2.1 Computational ModelCTMSIM is based on CTM model des
ribed in Chapter 3. Only now the model parametersand variables are more general. They are summarized in Table 4.1. Compare with Table3.1.



83Symbol Name Unit
N number of 
ells dimensionless
∆t sampling period (time step) hours
∆xi 
ell length miles
Fi total 
ell 
apa
ity vehi
les per hour (vph)
Ri on-ramp 
apa
ity vehi
les per hour (vph)
Si o�-ramp 
apa
ity vehi
les per hour (vph)
vi free �ow speed miles per hour (mph)
wi 
ongestion wave speed miles per hour (mph)
ρ̄i jam density vehi
les per mile (vpm)
ρc

i 
riti
al density vehi
les per mile (vpm)
βi split ratio ∈ [0, 1], dimensionless
β̄i 
omplementary split ratio = 1 − βi ∈ (0, 1], dimensionless
γi on-ramp �ow blending fa
tor ∈ [0, 1], dimensionless
ξi on-ramp �ow allo
ation fa
tor ∈ [0, 1], dimensionless
k period number dimensionless
si(k), ri(k) o�-ramp, on-ramp �ow in 
ell i in period k vehi
les per hour (vph)
di(k) on-ramp demand in 
ell i in period k vehi
les per hour (vph)
qi(k) on-ramp queue size in 
ell i in period k vehi
les
fi(k) �ow from 
ell i to i+ 1 in period k vehi
les per hour (vph)
ρi(k) density in 
ell i in period k vehi
les per mile (vpm)
Vi(k) a
tual speed in 
ell i in period k miles per hour (mph)
TT (k) travel time in period k hours
V HT (k) vehi
le hours traveled in period k vehi
le hours
VMT (k) vehi
le miles traveled in period k vehi
le miles
D(k) delay in period k vehi
le hours
PL(k) produ
tivity loss in period k lane mile hours (lmh)Table 4.1: Model parameters and variables used in CTMSIM.The parameter γi determines the in�uen
e of the on-ramp �ow on the mainline �ow thatenters ith 
ell. It re�e
ts the position of the on-ramp within the 
ell, with larger values of

γi 
orresponding to on-ramps that are 
loser to the upstream edge.The parameter ξi determines the allotment of available spa
e to vehi
les entering from theon-ramp. It re�e
ts the geometri
al layout of the 
ell. For example, if the on-ramp is lo
atedat the midpoint, in
oming vehi
les will only have a

ess to the downstream half of the 
ell.



84The on-ramp demand di(k) is the number of vehi
les per unit of time intending to enterfreeway at the ith 
ell, as opposed to on-ramp �ow ri(k)�the number of vehi
les per unitof time a
tually entering freeway at this 
ell.The initial 
ondition for the system is the N -dimensional ve
tor of densities ρ(0) at timestep 0. Given the initial 
ondition, on-ramp demands and o�-ramp split ratios, CTMSIM
omputes the system evolution in time using the following steps.1. Che
k if the user-set value of ∆t is valid. It must satisfy
∆t < min

i

∆xi

vi
. (4.1)2. Set time step k = 0.3. Initialize on-ramp queue size qi(0) = 0, i = 1..N .4. Initialize on-ramp �ow ri(0) = Ri, i = 1..N . In 
ells without on-ramps, Ri is assumedto be 0.5. Compute on-ramp �ows

ri(k + 1) = min
{

di(k + 1) +
qi(k)

∆t
,

ξi(ρ̄i − ρi(k))
∆xi

∆t
,

Ri,

max{C(ri(k)),Q(ri(k))}
}

, i = 1..N, (4.2)where C(ri(k)) denotes �ow value suggested by on-ramp mainline 
ontroller, and
Q(ri(k)) denotes the �ow value 
oming from on-ramp queue 
ontroller.



856. Update queue sizes
qi(k + 1) = max {qi(k) + (di(k + 1) − ri(k + 1)) ∆t, 0} , i = 1..N. (4.3)7. Compute 
ell-to-
ell �ows

fi(k + 1) = min
{

β̄ivi

(

ρi(k) + γiri(k + 1)
∆t

∆xi

)

,

wi+1

(

ρ̄i+1 −

(

ρi+1(k) + γi+1ri+1(k + 1)
∆t

∆xi+1

))

,

β̄i

βi
Si,

Fi

}

, i = 1..(N − 1), (4.4)
fN (k + 1) = min

{

β̄NvN

(

ρN (k) + γNrN (k + 1)
∆t

∆xN

)

,
β̄N

βN

SN , FN

}

. (4.5)8. Compute o�-ramp �ows
si(k + 1) =















βi

β̄i
fi(k + 1), if βi < 1

min
{

vi

(

ρi(k) + γiri(k + 1) ∆t
∆xi

)

, Si

}

, if βi = 1

, i = 1..N. (4.6)9. Compute densities
ρi(k + 1) = ρi(k) +

∆t

∆xi

(fi−1(k + 1) + ri(k + 1) − fi(k + 1) − si(k + 1)) , i = 1..N.(4.7)10. Compute a
tual speeds
Vi(k + 1) = min

{

vi,
fi(k + 1) + si(k + 1)

ρi(k + 1)

}

, i = 1..N. (4.8)



8611. Compute travel time1
TT (k + 1) =

N
∑

i=1

∆xi

Vi(k + 1)
. (4.9)12. Compute VHT. VHT in 
ell i:

V HTi(k + 1) = (ρi(k + 1)∆xi + qi(k + 1)) ∆t. (4.10)Total VHT:
V HT (k + 1) =

N
∑

i=1

V HTi(k + 1) (4.11)13. Compute VMT. VMT in 
ell i:
VMTi(k + 1) = ρi(k + 1)Vi(k + 1)∆t∆xi. (4.12)Total VMT:

VMT (k + 1) =

N
∑

i=1

VMTi(k + 1). (4.13)14. Compute delay. Delay in 
ell i:
Di(k + 1) =















0, if ρi(k + 1) ≤ ρc
i

V HTi − VMTi/vi, if ρi(k + 1) > ρc
i

, i = 1..N. (4.14)Total delay:
D(k + 1) =

N
∑

i=1

Di(k + 1). (4.15)Note: Total delay is the sum of freeway delay and queuing delay, be
ause of (4.10).
1Unless spe
i�ed otherwise, by travel time we understand instantaneous travel time as opposed to a
tualtravel time. Instantaneous travel time is the travel time that would o

ur, if the tra�
 speed in ea
h 
ellstayed 
onstant assuming values at the 
urrent time step. It does not in
lude time spent in queues. A
tualtravel time is the travel time 
omputed using a
tual time-varying tra�
 speed values and in
ludes time spentin a queue.



8715. Compute produ
tivity loss. Produ
tivity loss in 
ell i:
PLi(k + 1) =















0, if ρi(k + 1) ≤ ρc
i

(

1 − fi(k+1)
Fi

)

∆t∆xi, if ρi(k + 1) > ρc
i

, i = 1..N. (4.16)Total produ
tivity loss:
PL(k + 1) =

N
∑

i=1

PLi(k + 1). (4.17)16. Set k = k + 1.17. Go to step 5.4.2.2 User Interfa
eThe 
ore appli
ation of the CTMSIM pa
kage is 
tmsim. It 
an operate in both graphi
aland bat
h mode. To start 
tmsim in graphi
al mode, type>> 
tmsim my
onfigHere it is assumed that my
onfig.mat is a 
on�guration �le with freeway 
ell spe
i�
ation,and optional simulation and display parameters, whose format is des
ribed in Appendix A.As a result of this 
ommand, the main appli
ation window pops up. Figure 4.1a presentsthe look and feel of the 
tmsim GUI. All the quantities 
omputed in (4.2)-(4.17) 
an bedisplayed in the main window as simulation runs. The default display mode is as shown inFigure 4.1a. Plotted in the main area (bla
k and blue) are �ows (4.4)-(4.5) and densities(4.7) in ea
h 
ell at the 
urrent time step. The red line represents 
ell 
apa
ities on the �owplot, and 
riti
al densities on the density plot. Instead of densities, the a
tual speeds (4.8)
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an be plotted (View → Display Speeds, see Figure 4.1b). The red line on the speed plotmarks free �ow speeds.

Figure 4.1: (a) Main window of the 
tmsim appli
ation.(b) Instead of densities, the user may 
hoose to display speeds.
Instead of �ows and densities/speeds, the main area of the appli
ation window 
an be usedto plot:

• On-ramp demands, �ows (4.2) and queue sizes (4.3) (View → On-Ramp Demands andQueues, Figure 4.2a). Demand values are shown as yellow bars, and �ows as blue bars



89in ea
h 
ell. If a user sees only a blue bar in some 
ell, it means that on-ramp �owequals the demand. If, on the other hand, only the yellow bar is visible, it meansthat on-ramp �ow is zero. Otherwise, the user should see both yellow and blue bars.If the yellow bar is higher than the blue, this indi
ates that either some 
ontrol isturned on at this on-ramp, or that the demand ex
eeds ramp 
apa
ity, in whi
h 
asethe queue starts to grow. The situation when the blue bar is higher than the yellowis only possible if there exists a queue at the on-ramp, and the ramp 
an let throughmore vehi
les than the demand, resulting in de
reasing queue size.
• O�-ramp �ows (4.6) and split ratios (View → Off-Ramp Flows and Split Ratios,Figure 4.2b). Split ratios are either 
onstant (user may 
hange them manually as simu-lation runs), or taken from the split ratio pro�le (
on�guration variable betaProfile2).
• VHT (4.10) and VMT (4.12) (View → VHT and VMT, Figure 4.2
). At the VHT plot,the delay portion (4.14) is shown in dark red. At the VMT plot, maximum VMTvalues are marked as empty bars. They are 
omputed by substituting ρi(k + 1) with
ρc

i in (4.12) and visualize how well the 
ell 
apa
ities are utilized. The ultimate goalof any ramp metering strategy is to keep the VMT bars at maximum in 
ongestionperiods.Instead of plotting sele
ted quantities only at the 
urrent simulation step, the user may
hoose to see the history of how the system evolved in time by looking at time 
ontours(View → Timeseries Contours). Figure 4.3 shows an example of �ow and speed time
ontours. It is not re
ommended to display time 
ontours while running the simulation
2All 
on�guration variables are des
ribed in Appendix A.
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Figure 4.2: Display (a) On-ramp demands, �ows and queues.(b) O�-ramp �ows and split ratios.(
) VHT, delay and VMT per 
ell.be
ause drawing the display signi�
antly slows down program exe
ution.Below the main plotting area (Figure 4.1a) there is a display of the freeway broken up into
ells. The arrow spe
i�es the dire
tion of tra�
 �ow: left-to-right when post miles arein
reasing in the same dire
tion as tra�
 �ows (
orresponds to dire
tions north or east onCalifornia freeways), or right-to-left when post miles are de
reasing in the dire
tion of tra�
�ow (south or west on California freeways).
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Figure 4.3: Flow and speed time 
ontours.Color 
oding is used to display the status of ea
h 
ell: green means free �ow, red means
ongested. There are two auxiliary 
olors: yellow indi
ates free �ow at 97% of 
apa
ity,orange indi
ates 
ongested �ow at 97% of 
apa
ity. The theshold 97% is a 
on�gurableparameter (
on�guration variable yoColorRatio).The blue triangular marker (Figure 4.1) shows whi
h on-ramp is 
urrently sele
ted from thelist of on-ramps. The 
yan triangular marker shows whi
h o�-ramp is 
urrently sele
tedfrom the list of o�-ramps.Ramp lists are at the bottom of the 
tmsim window. They may be used to manually 
hangeon-ramp �ows or o�-ramp split ratios, or just to see where a parti
ular ramp is lo
ated onthe freeway.The area at the bottom left 
orner of the 
tmsim window (Figure 4.1a) is dedi
ated toplotting aggregate quantities: travel time (4.9), VHT (4.11) (Figure 4.4a), VMT (4.13)(Figure 4.4b), delay (4.15) (Figure 4.4
), and produ
tivity loss (4.17) (Figure 4.4d).As the simulation runs, all plotted data are updated. The frequen
y of su
h updates (on
e
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Figure 4.4: Display aggregate data. (a) VHT. (b) VMT. (
) Delay (d) Produ
tivity loss.per 5 simulation minutes, or on
e per simulation hour) is de�ned by the user (
on�gurationvariable plotTS).If the demand pro�le is spe
i�ed by the user (
on�guration variable demandProfile), theon-ramp demand values 
an be updated automati
ally (Auto → On-Ramp Demand). If autodemand is turned on, the user 
an toggle the on-ramp 
ontrol swit
h by going to Auto →On-Ramp Control. On
e on-ramp 
ontrol is turned on, the queue 
ontrol swit
h 
an betoggled (Auto → On-Ramp Queue Control).Similarly to the demand pro�le for on-ramps, the user may 
hoose to spe
ify the pro�le of



93split ratios for o�-ramps (
on�guration variable betaProfile). To update split ratios byvalues from the pro�le, go to Auto → Off-Ramp Split Ratio. If instead of split ratios, theuser wants to spe
ify o�-ramp �ows, he/she 
an 
reate a pro�le of o�-ramp �ows (
on�gura-tion variable frflowProfile) and run the simulation with automati
ally updated o�-ramp�ows instead (Auto → Off-Ramp Flow). Not more than one of the two pro�les, split ratioor o�-ramp �ow, 
an be turned on at the same time.At the bottom of the 
tmsim window (Figure 4.1) there are RUN, CLEAR and STOP buttons.To start the simulation, press RUN. STOP button pauses the simulation. At this point theentire simulation run 
an be saved (File → Save Simulation). Pressing RUN again willresume the simulation from the point it has been stopped. To start from the beginning,before RUN press the CLEAR button. When pressed while the simulation is running, CLEARbutton only 
lears the existing data history without resetting the state to initial 
onditionsand time step to zero. One may 
hoose to stop simulation any time, save it, load it againat a later moment (File → Load Simulation) and run it from the point it was left o�.A user 
annot exit 
tmsim while the simulation is running. It has to be stopped �rst. Ifthe simulation was not saved, the user is asked if he/she wishes to save it upon exiting orloading other simulation.To modify simulation and model parameters (Table 4.1 entries that do not depend on timestep k), several editor windows 
an be 
alled dire
tly from 
tmsim.
• Settings editor (Edit → Settings, Figure 4.5). It is used to modify general simulationparameters.
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Figure 4.5: Editor for simulation parameters.Sampling period ∆t (
on�guration variable TS)�user value must satisfy 4.1.Plotting period (
on�guration variable plotTS)�time period for the simulated datato be displayed. It must be not smaller than the sampling period.Timeout (variable timeout)�duration of a pause between plot updates. This param-eter makes a di�eren
e only in graphi
al mode.
• Fundamental diagram editor (Edit → Fundamental Diagram, Figure 4.6). The trian-gular fundamental diagram in 
ell i is determined by either of two triplets: 
apa
ity(maximum �ow) Fi, 
riti
al density ρc

i and jam density ρ̄i; or 
apa
ity Fi, free �owspeed vi and 
ongestion wave speed wi.
• Ramp data editor (Edit → Ramp Data) allows a user to modify on-ramp �ows (Figure
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Figure 4.6: Fundamental diagram editor.4.7a), or o�-ramp split ratios (Figure 4.7b). All 
hanges the user makes in the rampdata editor are overriden by demand or split ratio/o�-ramp �ow pro�les if these areturned on.
• On-ramp parameters editor (Edit → On-Ramp → Parameters, Figure 4.8a).Maximum �ow�on-ramp 
apa
ity Ri.Maximum queue size�number of vehi
les the on-ramp 
an hold. This parameter isused only by queue 
ontrollers.Flow 
oe�
ient�serves to modify on-ramp demands 
oming from the pro�le withoutmodifying pro�le itself.
γi�on-ramp �ow blending 
oe�
ient.



96

Figure 4.7: (a) Editor for on-ramp �ows. (b) Editor for o�-ramp split ratios.
ξi�on-ramp �ow allo
ation 
oe�
ient.

• O�-ramp parameters editor (Edit → Off-Ramp → Parameters, Figure 4.8b).Maximum �ow�o�-ramp 
apa
ity Si.Flow 
oe�
ient�serves to modify split ratios or o�-ramp �ows 
oming from the 
or-responding pro�le without modifying pro�le itself.
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Figure 4.8: (a) Editor for on-ramp parameters. (b) Editor for o�-ramp parameters.Every on-ramp 
an have di�erent mainline and queue 
ontrollers. Assigning parti
ular
ontrollers to on-ramps is done through the 
ontroller editor (Figure 4.9). This editoris also used to modify spe
i�
 
ontroller parameters. To 
all it, go to Edit → On-Ramp
→ Controllers. Se
tion 4.2.3 explains how user 
an plug his/her own 
ontrollers intoCTMSIM.Ea
h editor has SAVE button pressing whi
h user 
an save his/her modi�
ations in the 
urrent
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on�guration �le.Remark. If SAVE was pressed and the updates were saved, pressing CANCEL will not undothe 
hanges to the 
on�guration �le, it only dis
ards the 
hanges for the 
urrent simulation.To undo the 
hanges in the 
on�guration �le, press CANCEL, then 
all a parti
ular editoragain, then press SAVE.To run 
tmsim in bat
h mode, type>> 
tmsim my
onfig 'b'In this 
ase, 
tmsim saves the resulting simulation data in .mat �le spe
i�ed by the dataFile
on�guration variable.4.2.3 Ramp ControllersCTMSIM pa
kage 
ontains �le orml
list.mat that 
arries the information about on-rampmainline 
ontrollers. Currently implemented are ALINEA [90℄, LQI [98℄, SWARM [33℄ andthe so-
alled ideal ramp metering (IRM) strategy.The idea of IRM is simple. In given 
ell i with on-ramp, it sele
ts the input �ow ri as
ri = max {min {(αρc

i − ρi)∆xi, di + qi/(∆t), Ri} , 0} , (4.18)where 
oe�
ient α determines the desired portion of 
riti
al density below whi
h we wouldlike to keep the a
tual density. Default value is α = 0.97. It means, the obje
tive of theIRM 
ontroller is to keep the density in the 
urrent 
ell not higher than 97% of 
riti
al.



99IRM strategy may not be so �ideal� in 
ase there is an o�-ramp in the 
urrent 
ell, or the
apa
ity of the downstream 
ell is larger than that of the 
urrent one. In this situation,keeping the density in the 
urrent 
ell below 
riti
al may result in the underutilization offreeway 
apa
ity in the downstream 
ell. To avoid the underutilization, we implemented themodi�ed version of IRM (MIRM) whi
h, in addition to (4.18), 
onsiders the downstream
apa
ity and adjusts input �ow ri a

ordingly: ρc
i in expression (4.18) is repla
ed by

max {ρc
i , gi/vi} ,with

gi =















β̄−1
i min

{

β̄i

βi
Si, Fi+1

}

, if β < 1,

Si, otherwise.Adding new 
ontrollers to CTMSIM is fairly simple. Suppose, the user wants to implementhis/her own 
ontroller Xyz and plug it into the CTMSIM. The following steps should betaken.1. Perform 
lean up: delete all variables in the workspa
e.>> 
lear all2. Load the list of on-ramp mainline 
ontrollers.>> load orml
listNow, variable ml
list 
ontains the list of already installed 
ontrollers. Other variablesare spe
i�
 
ontroller stru
tures.3. Add Xyz 
ontroller to the list.



100>> strv
at(ml
list, 'Xyz');4. De�ne Xyz 
ontroller stru
ture. Mandatory �elds are listed in Appendix A.>> xyz.id = size(ml
list, 1);>> xyz.name = 'Xyz';>> xyz.TS = 1/120; % 
an be any other nonnegative value>> xyz.Cmin = 0; % 
an be any other nonnegative value>> xyz.Cmax = 5000; % 
an be any other value >= Cmin>>>> % other fields are user spe
ifi
.5. Save updated information in orml
list.mat �le.>> save orml
list6. It remains to implement 
ontroller fun
tion for Xyz. It must satisfy the followingformat.fun
tion new_orflows =
ontroller_xyz(densities, orflows, 
elldata, ts, idx)where densities is a ve
tor of densities, orflows is a ve
tor of on-ramp �ows,
elldata is an array of 
ell data stru
tures (see Appendix A for details), ts is asampling period, and idx - 
ell index. The fun
tion should return the updated ve
torof on-ramp �ows. See 
ontroller_alinea.m for an example of the ALINEA imple-mentation.After performing these steps, the Xyz 
ontroller is ready to use. In the 
tmsim appli
ation,go to Edit → On-Ramp → Controllers. The 
ontroller editor window will pop up. Xyz
ontroller is now in the list and it is possible to assign it to on-ramps (see Figure 4.9). All
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Figure 4.9: On-ramp 
ontroller editor window. Xyz mainline 
ontroller appears in the list.ZYx appears in the list of queue 
ontrollers.
ontroller parameters 
ontained in the xyz stru
ture 
an be adjusted in this window ex
eptid and name.Similarly to orml
list.mat, �le orq
list.mat has information about queue 
ontrollers.Currently implemented queue 
ontrol s
hemes are �queue-override� and proportional [98℄.Adding user-designed ZYx queue 
ontroller to CTMSIM follows similar steps to those formainline 
ontroller.1. Perform 
lean up: delete all variables in the workspa
e.>> 
lear all2. Load the list of on-ramp queue 
ontrollers.



102>> load orq
listNow, variable q
list 
ontains the list of already installed queue 
ontrollers. Othervariables are spe
i�
 queue 
ontroller stru
tures.3. Add ZYx 
ontroller to the list.>> strv
at(q
list, 'ZYx');4. De�ne ZYx 
ontroller stru
ture. Mandatory �elds for queue 
ontrollers are also listedin Appendix A.>> zyx.id = size(q
list, 1);>> zyx.name = 'ZYx';>>>> % other fields are user spe
ifi
.5. Save updated information in orq
list.mat �le.>> save orq
list6. It remains to implement the queue 
ontroller fun
tion for ZYx. It must satisfy thefollowing format.fun
tion new_orflows =
ontroller_zyx(demands, orflows, orqueues, 
elldata, ts, idx)where demands is a ve
tor of on-ramp demands, orflows is a ve
tor of on-ramp �ows,orqueues is a ve
tor of on-ramp queues, 
elldata is an array of 
ell data stru
tures(see Appendix A for details), ts is a sampling period, and idx - 
ell index. The fun
tionshould return the updated ve
tor of on-ramp �ows. See 
ontroller_q_override.mfor an example of �queue override� implementation.



103After these steps are performed, ZYx 
an be assigned to on-ramps through the 
ontrollereditor (Figure 4.9).

Figure 4.10: Freeway 
on�guration editor fw
onfig.
4.2.4 Auxiliary UtilitiesAdditionally to 
tmsim, three other useful utilities are part of CTMSIM pa
kage. These arefw
onfig, plotsim and plotsim3.fw
onfig is a graphi
al freeway 
on�guration utility (see Figure 4.10). It allows users tobuild a freeway from s
rat
h:>> fw
onfig



104and save the result as CTMSIM 
on�guration �le; or edit an existing 
on�guration:>> fw
onfig my
onfigwhere my
onfig.mat is an existing CTMSIM 
on�guration �le.More details about the format of 
on�guration �le 
an be found in Appendix A.

Figure 4.11: Using plotsim to plot (a) speed time 
ontour; and (b) VHT evolution in time;(
) �ow evolution in time in 
ells 31 through 33 in bla
k 
olor.plotsim is a utility that plots requested simulation data in 2D:>> plotsim mysim quantitywhere mysim.mat is a �le where CTMSIM simulation is saved, and the quantity parametermay assume one of the values listed in Table 4.2.See Figure 4.11a,b for examples of plotsim 
ommand:
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Figure 4.12: Using plotsim3 to plot density in 3D. The axes are Post mile, Time (min) andDensity (vpm).>> plotsim mysim 'speed'>> plotsim mysim 'vht'Additional parameters of 
ommand>> plotsim('mysim', quantity, 
ells, 
olor)are 
ells - array of 
ell numbers for whi
h the spe
i�ed quantity should be plotted, and
olor - 
olor for the plots. The result of the 
all>> plotsim('mysim', 'flow', 31:33, 'k')is shown in Figure 4.11
.plotsim3 plots simulated quantities listed in Table 4.2 ex
ept for travel time ('ttime') in3D. For example, the result of the 
all



106Quantity Des
ription'density' Mainline density'flow' Mainline �ow'speed' Tra�
 speed'ttime' Travel time'demand' On-ramp demands'orflow' On-ramp �ows'queue' On-ramp queues'frflow' O�-ramp �ows'beta' O�-ramp split ratios'vht' Vehi
le Hours Traveled'vmt' Vehi
le Miles Traveled'delay' Delay in vehi
le hours'ploss' Produ
tivity loss in lane mile hoursTable 4.2: Admissible values of quantity parameter.>> plotsim3 mysim 'density'is shown in Figure 4.12.
4.3 I210 Case StudyThe �rst task undertaken by TOPl was a study of both dire
tions of I210 freeway in SouthernCalifornia. The segment of interest is beween jun
tion with SR-134, postmile 25 (Westbound) and Baseline Road, postmile 52 (East bound), see Figure 4.13.To study ea
h of the I210 dire
tions, East and West, we went through the following steps.1. We start by extra
ting the freeway geometry from PeMS: vehi
le dete
tor station(VDS) lo
ations (post miles), number of lanes on ea
h VDS-to-VDS segment, on-
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Figure 4.13: Google map of I210.and o�-ramp lo
ations (post miles), number of lanes at ramps. Currently, PeMS'information about freeway geometry is not 
omplete. It only knows about ramps andlanes that have VDS. Therefore, after the freeway geometry is extra
ted from PeMS,we manually 
ompare it with Google map and �ll in missing lanes and ramps.2. We divide the extra
ted freeway into 
ells in su
h a way that(a) any 
ell 
ontains not more than one on-ramp, and if there is one, it is lo
ated atthe beginning of the 
ell;(b) any 
ell 
ontains not more than one o�-ramp, and if there is one, it is lo
ated atthe end of the 
ell;(
) any 
ell 
ontains not more than one VDS;(d) 
ells are not too long�ideally, not longer than 1 mile - to make tra�
 dynami
smore realisti
;(e) 
ells are not too short�ideally, not shorter than .15 to .2 mile�to ensure thatthe sampling period ∆t that has to satisfy (4.1) is not too small and, at the same



108time, the number of 
ells not too large, thus making the simulation exe
ute faster.As Figure 4.14 shows, 
ondition (
) is usually taken 
are of by the nature of VDSpla
ements, whi
h are rarely too 
lose to ea
h other. More often it is the 
ase thatsome 
ells have no VDS at all. If two on-ramps are too 
lose to ea
h other, one may
hoose to treat them as one with demand equal to the sum of the two demands, toensure (a) and (e). Similarly, 
ollapsing two 
lose o�-ramps into one with double
apa
ity, will ensure (b) and (e). If an on-ramp is 
losely followed by a o�-ramp, theway to ful�ll (a), (b) and (e) would be to pla
e them in two separate neighboring 
ells:the o�-ramp into the upstream and the on-ramp into the downstream 
ell.

Figure 4.14: Segment of I210-West between Huntington Drive and Baldwin Avenue dividedinto 
ells, and 
orrespondig VDSs. The 
ell length is in feet: 
ell 16 is 2762 feet long.Abbreviations: ML - mainline VDS, HV - HOV VDS, PM - post mile.
3. On
e the freeway layout is in pla
e, it is time to estimate the fundamental diagramsfor ea
h 
ell i, i = 1..N . This pro
ess is usually 
alled 
alibration and is des
ribed in



109[87, 100, 70℄. In TOPl, we use none of these 
alibration methods in pure form. Rather,ours is a hybrid of several te
hniques and it is yet to be do
umented.To summarize, 
alibration is performed by the following steps(i) For ea
h VDS in the freeway study segment extra
t density and �ow values fromPeMS for those days when this parti
ular dete
tor was in good working 
ondition(PeMS also 
ontains dete
tor health status history).Remark. The distan
e between neighboring VDSs is often larger than the 
ellsize in CTM. Hen
e, the retrieved VDS data may apply (and usually does) tomore than one 
ell (e.g. VDS 717669 
overs 
ells 18 and 19 in Figure 4.14).(ii) Find maximum �ow value. Usually, this will be the 
apa
ity Fi.(iii) Use least squares method to estimate free �ow speed vi. Pra
ti
e shows that free�ow density-�ow pairs give a good �t.(iv) Criti
al density ρc
i = Fi

vi
.(v) Use 
onstrained least squares method to determine 
ongestion wave speed wi.When VDS data are good, steps (i-v) produ
e a de
ent result (Figure 4.15a). If, onthe other hand, VDS data are poor due to malfun
tioning dete
tor or just be
ause the
apa
ity is never rea
hed at this point of freeway as in Figure 4.15b, then we 
an eitheruse fundamental diagrams from the neighboring 
ells, or impute the missing data [31℄and repeat Step 3.4. Determine �good days� for our freeway segment with respe
t to data 
olle
ted byPeMS. �Good day� means a day when all or almost all vehi
le dete
tors were healthy
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Figure 4.15: Estimating fundamental diagram. (a) Good data. (b) Poor data.and 
olle
ted data. In pra
ti
e, it is never the 
ase that all dete
tors are inta
t. Mosto�-ramp VDSs on I210 do not work. Thus, we relax the de�nition of a �good days� tothose when mainline and on-ramp dete
tors were fun
tional.5. Create demand pro�les for �good days� using PeMS �ow data from on-ramp VDSs.Data for ramps without VDSs have to be imputed.6. Compute o�-ramp split ratio pro�les with
βi(t) =

si(t)

fi(t) + si(t)
. (4.19)This is easier to say than to do. If VDS at an o�-ramp doesn't work, we do notknow si(t). A rather rough but simple way around it, is by taking the �ow data fromupstream mainline and on-ramp VDSs (if these data are reliable, of 
ourse), estimatethe sum fi(t) + si(t). Then, fi(t) 
an be obtained from the downstream VDS, andthus, we get si(t).



1117. Run the simulation with ramp 
ontrol turned o� for some of the �good day� demandand split ratio pro�les and 
ompare the results with PeMS data for those days. Be
auseof the imputation of the missing on-ramp data and errors in estimating split ratios,adjustments to demand and split ratio pro�les may be ne
essary. The intera
tivenature of 
tmsim allows to tweak demand 
oe�
ients at parti
ular on-ramps or modifysplit ratios as simulation exe
utes. Figure 4.16 
ompares speed time 
ontour fromPeMS to one generated by 
tmsim, and Figure 4.17 
ompares aggregate quantities:travel time, VHT, VMT and delay for a 14-mile segment of I210-West on a parti
ularday, April 12, 2006.As simulation data mat
hes well the a
tual freeway measurements from PeMS (Figures4.16-4.17), we may 
on
lude that CTM is adequate for tra�
 modeling, and demandsand split ratios are adjusted well enough for given �good days�.8. It is time to start experimenting with on-ramp 
ontrol strategies to see if they helpimprove, and how mu
h, the freeway system performan
e. For example, Figure 4.18shows how travel time and VHT under the no 
ontrol strategy 
ompares with thosein the presen
e of ALINEA at on-ramps. In this example, although travel time alongthe freeway has redu
ed signi�
antly by applying ALINEA, the overall performan
ehas not improved mu
h judging by the VHT 
hart. It means that while the freewayis in free �ow almost all the time, large queues are formed at on-ramps.Note: VHT 
omputed by PeMS does not in
lude ramp delay, whereas they are in-
luded in VHT 
omputed by CTMSIM.9. While it may seem that 
ertain 
ontrol strategies o�er little improvement (Figure



1124.18b) under 
urrent 
onditions, it makes sense to 
he
k what will happen underdi�erent s
enarios.S
enario 1: 5% demand in
rease.We 
an expe
t that two years from now the number of vehi
les on the road will in
reaseby 5%. In terms of our simulation settings, it means that the on-ramp demand valueswill in
rease by 5%. In the editor for on-ramp parameters, we set the value of demand
oe�
ient to 1.05 for every on-ramp, and run the simulation with on-ramp 
ontrol o�and on.Figure 4.19 shows that under in
reased demand, the impa
t of ALINEA is very signif-i
ant. Ramp metering keeps the freeway in free �ow, while delays imposed by queuesat on-ramps are small 
ompared to those resulting from 
ongestion. Un
ontrolled andALINEA speed 
ontours are presented in Figure 4.20.S
enario 2: 2% demand de
rease.Now we 
he
k what happens if the number of vehi
les on the road de
reases. Su
hsituation may be a result of a proper demand management (traveler information, tolls).Say we want to de
rease the demand by 2%. For that, we set the value of the demand
oe�
ient to 0.98 in the editor for on-ramp parameters, and again run the simulationwith on-ramp 
ontrol o� and on.Figure 4.21 shows the travel time and VHT for the un
ontrolled and ALINEA 
on-trolled 
ases, and Figure 4.22 shows the 
orresponding speed 
ontour plots. As we 
ansee, ramp metering does not improve the VHT performan
e. The delays are shifted



113from the freeway to on-ramp queues. Ramp metering may still be bene�
ial, how-ever, sin
e it keeps the freeway in free �ow maintaining a level of servi
e that may berequired by a tolling authority.S
enario 3: a

ident.Suppose, an a

ident o

urred at 3.40 pm (minute 940 on the plot) at post mile 30, nearMi
hllinda Avenue, leaving two of the four lanes blo
ked, and it took 20 minutes to 
learthe freeway. To simulate this a

ident, the user has to stop the running simulationat 940 minutes, open the fundamental diagram editor and modify the fundamentaldiagram of the 
ell where the a

ident took pla
e (in our 
ase, it is 
ell 25). Criti
aldensity, jam density and maximum �ow for the sele
ted 
ell should be redu
ed by
50%. Then the user has to resume the simulation, stop it at 960 minutes, 
hange thefundamental diagram for that 
ell ba
k to the original, resume the simulation againand run it to the end. This simulation has to be run with on-ramp 
ontrol o� and on.Figure 4.23 shows the travel time and VHT for the un
ontrolled and ALINEA 
on-trolled 
ases, and Figure 4.24 shows the 
orresponding speed 
ontour plots. Clearly,ramp metering signi�
antly improves both travel time and VHT at the time of a

identand after and keeps the freeway mostly in free �ow.The user may 
hoose to simulate other variations of this s
enario, su
h as in
reasingor redu
ing the time interval between the a

ident o

urren
e and 
learan
e.
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Figure 4.16: I210-West 14-mile segment beween Vernon Avenue and jun
tion with SR-134,April 12, 2006. Speed time 
ontours (tra�
 �ows from left to right).(a) PeMS data.(b) CTMSIM simulation.
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Figure 4.17: I210-West 14-mile segment beween Vernon Avenue and jun
tion with 134, April12, 2006. Aggregate data 
omparison between PeMS (blue) and CTMSIM (red).(a) Travel time. (b) VHT. (
) VMT. (d) Delay.

Figure 4.18: Freeway performan
e without 
ontrol (blue) vs. with ALINEA 
ontrol (red).(a) Mainline travel time. (b) VHT.
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Figure 4.19: S
enario 1: 5% demand in
rease. Freeway performan
e without 
ontrol (blue)vs. with ALINEA 
ontrol (red). (a) Travel time. (b) VHT.

Figure 4.20: S
enario 1: 5% demand in
rease. Comparison of two speed time 
ontours(tra�
 �ows from right to left). (a) No 
ontrol. (b) ALINEA 
ontrol.
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Figure 4.21: S
enario 2: 2% demand de
rease. Freeway performan
e without 
ontrol (blue)vs. with ALINEA 
ontrol (red). (a) Travel time. (b) VHT.

Figure 4.22: S
enario 2: 2% demand de
rease. Comparison of two speed time 
ontours(tra�
 �ows from right to left). (a) No 
ontrol. (b) ALINEA 
ontrol.
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Figure 4.23: S
enario 3: a

ident at post mile 30 (near Mi
hillinda Avenue). Freewayperforman
e without 
ontrol (blue) vs. with ALINEA 
ontrol (red). (a) Travel time. (b)VHT.

Figure 4.24: S
enario 3: a

ident at post mile 30 (near Mi
hillinda Avenue). Comparisonof two speed time 
ontours (tra�
 �ows from right to left). (a) No 
ontrol. (b) ALINEA
ontrol.
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Chapter 5
Aurora: Simulation and AnalysisFramework for Infrastru
tureNetworks
5.1 MotivationAlthough it is a neat software pa
kage, useful for transportation resear
hers in their stud-ies of freeway tra�
, CTMSIM falls short of providing an appropriate toolset for 
orridormanagement. It handles only one freeway and no arterial networks, 
annot deal with HOV,has no notion of event that triggers 
ertain 
on�guration or input 
hanges at given time orunder given 
onditions allowing to program s
enarios, and requires MATLAB whi
h makesit unusable for the operations sta� in organizations su
h as Caltrans.



120The TOPl group had an option: to �nd a third party ma
ro-simulation pa
kage able tohandle mixed freeway-arterial road network and adapt it to its needs, or develop its ownsoftware solution. Of the third party pa
kages, METACOR [44℄ suited best the needs ofTOPl, but its 
ommer
ial version [5℄ was unavailable to us at the time (De
ember 2006), andit was de
ided to pro
eed with development of our own simulation and analysis frameworkfor tra�
 �ows in freeway 
orridors. Aurora1 [9℄ is the working name given to this proje
t.Listed below are the foundation prin
iples of the Aurora framework.1. Multi-purpose�basi
 stru
tures and algorithms must be generi
 and not road traf-�
 spe
i�
, making the framework reusable for other appli
ations, su
h as irrigation
anals, oil or gas pipelines, et
. Appli
ation spe
i�
 
lasses inherit from these basi
stru
tures. This a�e
ts basi
 data stru
ture de�nitions and general purpose algorithmdevelopment.2. Usability�Aurora tools must be easy to handle: 
reating 
on�guration �les, run-ning simulations, and 
alling analysis routines, must be intuitively 
lear. It is betterto have several di�erent lightweight appli
ations for di�erent tasks rather than oneheavyweight appli
ation for multiple purposes.3. Intera
tivity�simulation and analysis appli
ations must provide 
lear and simple GUIwith good data visualization. This and previous items a�e
t the user interfa
e andvisualization: what data should be displayed and in what way.
1Aurora (short for polar aurora) - glow in the sky, seen often in a ring-shaped region around the magneti
poles ("auroral zone") and o

asionally further toward the equator. The name 
omes from an older one,�aurora borealis�, Latin for �northern dawn�, given be
ause an aurora near the northern horizon (its usuallo
ation when seen in most of Europe) looks like the glow of the sky pre
eding sunrise. Also known as�northern lights�, although it o

urs both north and south of the equator.



1214. S
enario oriented�user should be able to write s
enarios: lists of events that 
hange
on�guration or inputs, with times or 
onditions of their o

urren
e, and feed themto the simulator. This a�e
ts the way events are des
ribed and handled.5. S
alability�user should be able to seemlessly add new roads (
anals, power lines, et
.)to already existing network 
on�gurations, or 
onne
t two or more networks with ea
hother. This a�e
ts basi
 data stru
ture de�nitions and the way 
on�guration �les areorganized.Aurora is implemented in Java. It uses external libraries: JUNG [10℄ for drawing thenetwork, and JFreeChart [11℄ for plotting simulation data.Java pa
kaging of Aurora is organized as follows:
• aurora�generi
 
lasses and interfa
es;
• aurora.hw
�
lasses and interfa
es spe
i�
 to road network appli
ation (HWC standsfor highway 
ontrol);
• aurora.hw
.gui�user interfa
e 
lasses for the road network appli
ation;
• aurora.util�
olle
tion of useful routines, not appli
ation spe
i�
.



1225.2 Ar
hite
ture5.2.1 Basi
 Obje
tsThe basi
 building blo
k of the Aurora system is a network element with a unique integerID. A network element 
an be a link representing a stret
h of road (water 
anal, pipeline,et
.), simple node�point where links merge and/or diverge, 
omplex node�network builtout of network elements, or monitor�an obje
t that monitors the state of spe
i�ed linksand nodes in a network.A link has dire
tion and length. It must have either of the two nodes, begin node or endnode, or both of them, atta
hed to it. Links with no begin nodes are sour
e links. Sour
elinks provide input to a system. In the 
ase of a road network (Aurora HWC2), asso
iatedwith sour
e links are demand values and queues. Links with no end nodes are destinationlinks. In Aurora HWC, we assume that anything downstream of a destination link is in free�ow.Table 5.1 summarizes link types implemented in Aurora HWC together with begin andend nodes that ea
h link type allows. Ea
h of these link obje
ts has asso
iated with it afundamental diagram and dynami
s. Dynami
s is an interfa
e, i.e., any ma
ros
opi
 tra�
model 
an be used to 
ompute the link state, namely, tra�
 density. Currently, only theCTM model is implemented. Density is implemented not as a simple numeri
 type, but asgeneri
 obje
t, allowing us to modify or extend the tra�
 model so it 
ould deal with density
2Aurora for highway 
ontrol



123Link type Admissible begin nodes Admissible end nodesfreeway freeway freewayhighway highway highwayHOV freeway, highway freeway, highwayinter
onne
t freeway, highway freeway, highwayon-ramp signal and stop jun
tions freeway, highwayo�-ramp freeway, highway signal and stop jun
tionsstreet signal and stop jun
tions signal and stop jun
tionsdummy any anyTable 5.1: Aurora HWC link types with 
orresponding admissible begin and end nodes.as a ve
tor of values (say, when tra�
 �ows 
arry additional origin-destination information,or we want to distinguish vehi
les by types, e.g. SOV, HOV, tru
ks), or more 
omplex datastru
ture. For ea
h link, Aurora 
omputes travel time, VHT, VMT, delay and produ
tivityloss. Node type Admissible input links Admissible output linksfreeway freeway, HOV, freeway, HOV,inter
onne
t, o�-ramp on-ramp, inter
onne
thighway highway, HOV, highway, HOV,inter
onne
t, o�-ramp on-ramp, inter
onne
tsignal jun
tion street, o�-ramp street, on-rampstop jun
tion street, o�-ramp street, on-rampTable 5.2: Aurora HWC node types with 
orresponding admissible input and output links.A simple node3 must have one or more input and one or more output links. Aurora HWCnodes are listed in Table 5.2 together with types of input and output links they admit.Lo
al 
ontrollers (su
h as ALINEA [90℄), if any, reside on nodes and are assigned to giveninput links, potentially restri
ting �ows 
oming from these links. When there are multipleoutput links, nodes also 
arry information about what portions of whi
h input �ows must
3We refer to it as node from now on, while referring to a 
omplex node as a network.



124be dire
ted to whi
h output. Currently, for m inputs and n outputs in the node, it isimplemented as an m×n split ratio matrix, where elements are nonnegative and sum up to
1 in ea
h row.Remark. Currently, we do not distinguish between freeways and highways. Highway spe-
i�
 obje
ts are present in Aurora following the road 
lassi�
ation provided by HCM [101℄and are reserved for future use.While links and nodes physi
ally form a network, a monitor is a spe
ial obje
t whose purposeis to monitor the state of spe
i�ed links and nodes, and based on these data, issue instru
tionsto system wide 
ontrollers (su
h as SWARM [33℄). Monitors are ad-ho
 obje
ts designed bythe user together with network wide 
ontrol strategies. They 
an be also used to generate
ertain events (su
h as split matrix 
hange�to simulate traveler information a�e
ting tra�
�ow dire
tions) based on observed 
onditions (more about events in the next Se
tion). Atthis point, no monitors are implemented.All des
ribed network elements�links, nodes and monitors�are always part of a 
omplexnode, a network. There is at least one network in any Aurora system�the top level 
omplexnode, to whi
h all other links, nodes and monitors belong. Network obje
ts are nodes, hen
e,networks 
an 
ontain networks just as they 
ontain simple nodes. It makes the Aurorastru
ture hierar
hi
al, allowing to 
reate 
on�gurations out of building blo
ks that are more
omplex than links and simple nodes, whi
h is faster and more 
onvenient, and opens a doorto parallel 
omputation when simulation steps for di�erent subnetworks 
an be 
omputed
on
urrently by di�erent pro
essors. Another bene�t of using a hierar
hi
al stru
ture isthat di�erent subnetworks may have di�erent sampling periods, that is, simulation steps



125of di�erent duration. It 
an save time if, for example, network 
onsists of roads with longenough links that do not require a small sampling period, and roads with rather short linksthat do (re
all (4.1)). Separating them into subnetworks with di�erent sampling periodsredu
es 
omputation time.Remark. Sampling periods of subnetworks 
annot be greater than sampling period of toplevel network.There are two other basi
 obje
ts. Obje
t path des
ribes route from a node to node as asequen
e of adja
ent links. For ea
h path, Aurora 
omputes travel time, VHT, VMT, delayand produ
tivity loss based on 
orresponding data from links forming the path. Obje
t ODdes
ribes a pair of origin and destination nodes together with list of paths 
onne
ting thetwo. A 
omplex node may 
ontain a list of origin-destination pairs. For 
onsisten
y, it isrequired that every link in every path of every origin-destination pair belongs to the same
omplex node as ODs in the list4.5.2.2 EventsAurora HWC-spe
i�
 events, summarized in Table 5.3, are derived from the generi
 Auroraevent obje
t and are handled by the Aurora event manager. Events that 
hange fundamentaldiagrams 
an be used to simulate tra�
 in
idents by redu
ing 
apa
ity. Changing demand
oe�
ients and split ratio matri
es help imitate spe
ial events, road 
losures, or e�e
ts of
4It may happen that both, origin and destination nodes, belong to the same subnetwork, while some linksat 
ertain paths 
onne
ting them are part of a di�erent subnetwork. This is not a problem be
ause top levelnetwork 
ontains all the links present.



126displaying traveler information. Controller and queue size 
hanges may be part of 
omplexramp 
ontrol strategies. Event: 
hange in Where o

urs
ontroller nodessplit ratio matrix nodesdemand 
oe�
ient sour
e linksqueue size sour
e linksfundamental diagram linksTable 5.3: Aurora HWC events.The event obje
t 
arries the following information: a
tivation time (in terms of simulationhours), ID of a network element where it must o

ur, new parameter values for this networkelement, and an a
tivate() method that 
hanges those parameter values at a networkelement while storing the old values 
oming from the network element in their pla
e. Anevent list is an optional part of the 
on�guration �le, but the user 
an generate new eventsbefore or during the simulation run as well as disable those already in the list.When the simulator reads a 
on�guration �le, it pla
es all events listed there into a queuesorted by event a
tivation time (this queue may be empty, if no events are spe
i�ed). Usergenerated events are added to this queue, their lo
ation in the queue being determinedby their a
tivation time also. Events are triggered by the event manager. Before ea
hsimulation step, it sele
ts those events in the queue that are due (those whose a
tivationtime is smaller than the next simulation time step), and a
tivates them by invoking theira
tivate() methods. Then, it moves these a
tivated events from the event queue to the endof the event history list in the order they o

ured. Thus, events never get deleted. Later,when the user resets the simulation, events are rolled ba
k, or a
tivated in reverse sequen
e



127with reverse a
tion, returning to network element parameters their original values. Su
hmaintenan
e of event queue and history list potentially allowes us to �rewind� simulation toany given point of its exe
ution.5.2.3 Simulation AlgorithmAn obje
t representing a network element 
ontains the dataUpdate() method. It performssimulation step 
omputations spe
i�
 to the parti
ular type of network element. The re
ur-sive algorithm of dataUpdate() in a network is des
ribed next.1. Che
k if at this time step any a
tion is needed:
(k − k0)∆t0 < ∆t, (5.1)where ∆t is sampling period for this network, ∆t0 is the sampling period for the toplevel network, k is the 
urrent time step, k0 is the time step at whi
h the last a
tionwas performed.If k > 1 and inequality (5.1) holds, then return without doing anything. Else, pro
eedto step 2.2. For every monitor in the monitor list, 
all dataUpdate(). If present, ea
h monitorhas its own spe
i�
 task�it may assign 
ontroller parameters, or generate events tobe a
tivated before the next simulation step or later, at pres
ribed time.3. For every node in the node list, 
all dataUpdate(). If the node is 
omplex, start thealgoritm from step 1 with respe
t to this node. Else (the node is simple), 
ompute



128input and output �ows based on demand from upstream and available 
apa
ity ofdownstream links. This 
an be done in many ways.Daganzo in [40℄ introdu
es the 
on
ept of priorities for multiple input �ows and theFIFO5 rule for multiple output �ows.In the Aurora framework priorities are the fra
tions of the input �ows a

epted by thenode, in 
ase the upstream demand ex
eeds the downstream 
apa
ity (if the upstreamdemand is below the downstream 
apa
ity, priorities do not matter sin
e all the vehi
lesfrom the upstream links 
an be a

ommodated by the downstream links). Di�erentpriority 
hoi
es result in di�erent �ow values for the next simulation step. In the
urrent Aurora implementation we assume that the input priorities are proportionateto the input demands.The FIFO rule means that if one of the output links 
annot a

ommodate its allo
ationof �ow, the total output �ow is restri
ted6. In the Aurora framework the FIFO ruleimplies that the input-output �ow relations de�ned by the split ratio matrix must bepreserved.To summarize, we 
ompute the input and output �ows based on the input demands,satisfying the downstream 
apa
ity restri
tions by assuming the input priorities to beproportionate to the demands, while preserving the input-output �ow relations de�nedby the split ratio matrix.Given m > 0 input and n > 0 output links, 
omputation pro
eeds as follows:
5First in, �rst out.
6Vehi
les unable to exit from the upstream link prevent all those behind, regardless of their destination,to 
ontinue.



129(a) Compute input demands
d̃i(k) = min (viρi(k0), C(ρi(k0)), Fi) , i = 1..m, (5.2)where vi is free �ow speed, ρi(k0) is the density at the input link i; C(ρi(k0))denotes �ow value suggested by a 
ontroller, if a 
ontroller is assigned to theinput link i; and Fi is the 
apa
ity of the input link i.(b) From the m×n split ratio matrix B, and the m-dimensional demand ve
tor d̃(k)we get the input-output m× n demand matrix D(k),

Dij(k) = Bij d̃i(k), i = 1..m, j = 1..n, (5.3)and output demands
dj(k) =

m
∑

i=1

Dij(k), j = 1..n. (5.4)(
) Compute available output 
apa
ities
cj(k) = min (wj(ρ̄j − ρj(k0)), Fj) , j = 1..n, (5.5)where wj is 
ongestion wave speed, ρ̄j is the jam density, and Fj is the 
apa
ityof the output link j.(d) Compute input-output demand matrix adjusted by the output link 
apa
ity re-stri
tions, assuming the input priorities to be proportionate to the demands,

D̂ij(k) =
min(dj(k), cj(k))

dj(k)
Dij(k), i = 1..m, j = 1..n, (5.6)and adjusted input demands

d̂i(k) =

n
∑

j=1

D̂ij(k), i = 1..m. (5.7)



130This step ensures that the adjusted input demand does not ex
eed the down-stream 
apa
ity. More pre
isely,
m

∑

i=1

D̂ij(k) ≤ cj(k),with equality being a
hieved if and only if dj(k) ≥ cj(k).Remark. Expression (5.6) makes sense only if dj(k) 6= 0. So, in 
ase dj(k) = 0,we set D̂ij(k) = 0.(e) Compute input �ows̃
fi = d̂i min

j

{

D̂ij

d̂iBij

}

, i = 1..m, j = 1..n. (5.8)In 
ase d̂i = 0 or Bij = 0 for all j = 1..n, we set f̃i = 0.(f) Compute output �ows
fj(k) =

m
∑

i=1

Bij f̃i, j = 1..n. (5.9)Steps (e) and (f) implement the FIFO rule: input and output �ow values areassigned so as to maintain input-output relationship de�ned by matrix B.4. For every link in the link list, 
all dataUpdate().(a) Compute density and speed using model spe
i�
 equations. For CTM, these are
ρ(k) = ρ(k0) +

∆t

∆x
(fu(k) − fd(k)), and V (k) = fu(k)/ρ(k), (5.10)where ∆x is the link length, fu is the upstream �ow (�ow entering the link), fdis the downstream �ow (�ow exiting the link), and V is the speed. If the link is
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e link, fu(k) equals 
urrent demand, otherwise fu(k) is 
omputed in thebegin node of the link as one of its output �ows. If the link is a destination link,
fd(k) = min (vρ(k0), F ) ,where v is the free �ow speed, and F is the 
apa
ity; otherwise fd(k) is 
omputedin the end node of the link as one of its input �ows.(b) Compute travel time
TT (k) = ∆x/V (k). (5.11)(
) Compute VHT, VMT, delay and produ
tivity loss as des
ribed in Se
tion 4.2, byformulas (4.10), (4.12), (4.14), (4.16).5. Set k0 = k and return.5.2.4 Con�gurationFrom TOPl we learned that on
e the pro
ess of a freeway 
orridor study is established, themost tedious and time 
onsuming task is putting together a 
on�guration �le with roadnetwork des
ription. Being the least rewarding, this task requires attention to details andpatien
e. Therefore, e�
ient 
on�guration management was made one of the priorities ofTOPl.General 
on�guration �le 
ontains

• information about network layout: positions and types of nodes, shapes and types oflinks 
onne
ting them, numbers of lanes;
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• des
ription of monitors (if any are present);
• split ratio matri
es and 
ontroller information at nodes and fundamental diagrams atlinks;
• list of origin-destination pairs, ea
h with list of feasible paths;
• demand pro�le for sour
e links;
• event s
enario - list of events des
ribing what o

urs, where and when.The �rst item is the most di�
ult, be
ause there is no single sour
e from whi
h these data
ould be extra
ted. Eventually, PeMS intends to provide this information for arterials aswell as for freeways. To date, however, PeMS only deals with freeways and it knows onlyabout ramps and lanes where dete
tors are installed. Thus, we have to work with GISdata from regional planning agen
ies su
h as MTC (Bay Area) and SANDAG (San Diego),
on�guration �les for di�erent simulators used by other resear
h groups, and ultimatly
onsult Google maps. The pro
edure of network layout extra
tion is not well de�ned yetand requires a �human tou
h�, i.e., a lot of manual 
he
ks and adjustments.Calibration, i.e., 
omputation of fundamental diagrams and split ratio matri
es, and demandgeneration, with the la
k of su�
ient measurement data (espe
ially, for arterials), is these
ond great 
hallenge.All this put together makes us realize that 
omplete 
on�guration �les have signi�
ant value,so that establishing a repository of 
on�gurations makes sense.
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on�guration �les use XML format whose syntax, data sets and validation rules,are de�ned by a s
hema presented in Appendix B. Types of links, nodes, monitors, 
on-trollers and dynami
s are de�ned in 
lass attribute, whi
h spe
i�es what 
lasses Auroramust instantiate upon reading the 
on�guration. Con�guration is modular. That is, origin-destination lists, demand pro�les and event s
enarios, are separate blo
ks that 
an be op-tionally added to a 
on�guration �le or stored on their own. This, plus the hierar
hi
alstru
ture of Aurora in whi
h a network is just another 
omplex node, make the manipula-tion of 
on�guration building blo
ks relatively easy and e�
ient.Another bene�t of XML 
on�guration is that it 
an be read by anyone (the te
hnology isknown and proven) and translated into other formats. That makes it a good 
andidate foran inter
hange format for road network des
riptions.
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eFigure 5.1 presents the fa
e of the Aurora HWC simulator. The appli
ation window isdivided into four frames.

Figure 5.1: Aurora HWC simulator window.1 - network tree frame: lists networks, nodes, links, monitors, ODs, paths.2 - main frame: home to appli
ation subwindows.3 - s
enario frame: lists events and logs.4 - status frame: displays simulation status, and/or instru
tions to the user.
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omponents - nodes, links, monitors, origin-destination pairs and paths in a hierar
hi
al tree stru
ture a la Windows Explorer.Spe
ial i
ons spe
ify their types. Double 
li
king on a 
omponent brings up a subwin-dow in the main frame with details of that parti
ular network element or path.2. Main frame. It is used to host subwindows for sele
ted network elements or paths.
• Network subwindow (Figure 5.2). It is divided into two tabs. One displaysnetwork layout that 
an be zoomed in and out and allows to view details of linksand nodes 
omposing the network. As simulation runs, links are 
olored usingeither their density or speed values (user 
hoi
e). The other tab des
ribes thenetwork together with general settings: sampling period, mainline and queue
ontrol on or o�.
• Node subwindow (Figure 5.3). It is divided into two tabs. One displays simulationdata: input and output �ows. The other displays node 
on�guration: input linkswith 
ontrollers, output links and split ratios. From the 
on�guration tab theuser 
an generate node events (
ontroller and split ratio matrix 
hanges).
• Link subwindow (Figure 5.4). It is divided into three tabs. Simulation tabdisplays �ow, density, speed and travel time. Performan
e tab shows VMT,VHT, delay and produ
tivity loss at the link. Con�guration tab has informationabout link length, number of lanes and fundamental diagram. From here the user
an generate link events (fundamental diagram 
hanges, and demand and queuelimit 
hanges for sour
e links).
• Path subwindow (Figure 5.5). It is divided into three tabs. Layout tab shows
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Figure 5.2: Network subwindow. (a) Layout tab. (b) Con�guration tab.part of network that 
onstitutes a path. It 
an be zoomed in and out and allowsto view details of parti
ipating links and nodes. As the simulation runs, links are
olored using either their density or speed values (user 
hoi
e). Performan
e tabshows travel time, VMT, VHT, delay and produ
tivity loss along the path. Thetime granularity of the plotted VMT, VHT, delay and produ
tivity loss values isdetermined by the display update period, whi
h is part of the general settings.Contour tab displays �ow, density and speed time 
ontours for the path.3. S
enario frame (Figure 5.1). This frame is divided into two tabs. One lists the events
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Figure 5.3: Node subwindow. (a) Simulation tab. (b) Con�guration tab.of the 
urrent simulation s
enario: their type, des
ription, a
tivation time. The user
annot delete an event from the list, only edit it, or disable it. The event editorwindow pops up when the user double 
li
ks on an event. Figure 5.6 shows an editorfor the fundamental diagram 
hange event. Ea
h event type has its own editor window.The other tab is a 
onsole for dumping the appli
ation output: logs and debugginginformation.4. Status frame (Figure 5.1). It displays the status of simulation�running, paused orstopped, and issues short instru
tions to a user.
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Figure 5.4: Link subwindow. (a) Simulation tab. (b) Performan
e tab. (
) Con�gurationtab.The menu on top of the main window (Figure 5.1) 
urrently provides the following options:
• to run simulation (Simulation → Run);
• to stop simulation (Simulation → Stop);
• to save simulation (File → Save Simulation);
• to reset simulation (File → New Simulation);
• to load previously saved simulation (File → Open);
• to toggle mainline and queue 
ontrol swit
hes (Control → Mainline and Control →Queue); to turn mainline 
ontrol on and o�;
• and to edit general settings (Edit → Settings, Figure 5.7).General settings 
omprise su
h parameters as display update period, maximum simu-lation time and timeout between s
reen refreshes.
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Figure 5.5: Path subwindow. (a) Layout tab. (b) Performan
e tab. (
) Contour tab.It is also possible to save the 
urrent 
on�guration (File → Save Configuration). Al-though a user has no dire
t way of 
hanging 
on�guration parameters of network elementsin the simulator, they may 
hange nevertheless, due to a
tivated events. Also, a user 
angenerate new, edit or disable old events, thus modifying event s
enario. These are thereasons why it may be desirable to save 
urrent 
on�guration in a �le.
5.4 GoalsAurora is not a �nished produ
t as of the moment this dissertation is written. As wasmentioned above, it 
onsists of three major modules: 
on�guration, simulation and analysis.Simulation module.Simulation module is a 
enterpie
e of the framework. Signi�
ant progress has been made in
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Figure 5.6: Editor window for the link event that 
hanges fundamental diagram.the simulator development, but several items remain un�nished.
• Modeling of arterial tra�
 requires implementation of signal 
ontrol for nodes rep-resenting signal jun
tions. Until it is implemented, we make trivial assumption thatarterial tra�
 always moves with free �ow speed (25−30 mph) and there are no delaysat signal jun
tions.
• Currently, we use demand values at sour
e links as inputs to the system, while splitratio matri
es at MIMO7 nodes determine how tra�
 �ow is divided between di�erentlinks.Alternative form of input data 
an be used: origin-destination �ow matri
es. That is,instead of demand pro�le and split ratios at jun
tions, there are OD matri
es generatedwith given period (say, every 5 or 15 minutes) that spe
ify how many vehi
les started

7Multiple input, multiple output.
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Figure 5.7: Editor window for the simulation settings.from given sour
e to given destination during that period. Input data in the OD formis useful if we solve dynami
 tra�
 assignment (DTA) problem. Our goal is to makeAurora 
apable of pro
essing input in OD form. This involves adjustments to the
urrent 
on�guration XML s
hema (Appendix B).
• So far, �travel time� through a link or path refers to the instantaneous travel timeas opposed to a
tual travel time. Instantaneous travel time is the travel time thatwould be experien
ed if the tra�
 speed in ea
h link of the path were to stay 
onstantassuming values at 
urrent time step. It 
an be 
omputed every time step as simulationruns. A
tual travel time 
an be only 
omputed after the whole simulation data be
omesavailable. Suppose, we start at a sour
e link 0 at time step k0 and this link has a queue
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q(k0). The time step at whi
h we arrive at link 1 is

k1 = k0 +N0, (5.12)with
N0 = argmaxk

{

k−1
∑

k′=0

fd(k0 + k′)∆t ≤ q(k0)

}

, (5.13)where ∆t is a sampling period, and fd(k0 + k′) is the �ow leaving link 0 at time step
k0 + k′.If we arrive at link i (i > 0) of our path at time step ki, the a
tual travel time throughthis link will be

Ti(k0) = Ni∆t, (5.14)with
Ni = argmaxk

{

k−1
∑

k′=0

Vi(ki + k′)∆t ≤ ∆xi

}

, (5.15)where ∆xi is the length of i-th link, and Vi(ki + k′) is the average tra�
 speed on i-thlink at time step ki + k′.Given (5.12)-(5.15), arrival time at link (i+1) is ki+1 = ki +Ni. Then the total traveltime over the path through links i = 0, 1, · · ·M is
T (k0) = ∆t

M
∑

i=0

Ni, (5.16)with Ni determined from (5.13) and (5.15).
• Last, but not least is how to store the simulation data.In a �le? But then this �le will be too big, and the simulator will require a lot ofmemory while running. It is an obsta
le to making the system truly s
alable.
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ted data, but raises a question aboutdatabase maintenan
e and sharing simulation data.To ta
kle this problem some experiments measuring the system performan
e have tobe made, and the TOPl group should de
ide on the approa
h to be 
hosen.Con�guration module.The 
on�guration module is a 
ornerstone of the framework, without whi
h Aurora remainshandi
apped. At this point, it is impossible to make the 
onstru
tion of 
on�guration �les
ompletely automati
. The main reason is the large variety of 
on�uration sour
es, ea
hwith data in its own format: PeMS with its 
on�guration and measurement data; regionalplanning agen
ies with their GIS databases; 
ensus and demographi
 data that determinesorigin-destination travel patterns; and 
on�guration �les for other (mi
rosimulation) pa
k-ages used by di�erent resear
h groups.Despite the ne
essary manual intervention in the pro
ess of 
on�guration building, the TOPlgroup de
ided to automate it where possible. The fo
us is on GIS databases from regionalplanning agen
ies (SANDAG, MTC) as the most 
onsistent and 
omprehensive sour
es ofinformation about road geometry. On
e the road network is in pla
e, the system must be
alibrated. Fundamental diagrams for freeway links 
an be estimated from PeMS data. Forarterials, some best guess default values have to be used. Finally, demand pro�les and splitratios, or origin-destination matri
es, must be generated using PeMS, 
ensus and surveydata.
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olle
ting data from arterials as well as from freeways, with road
on�gurations 
oming dire
tly from GIS databases. For California, it will then be
ome aunique sour
e of road geometry together with density-�ow data needed for fundamentaldiagram estimation, and demand pro�les and split ratios�everything needed for Aurora
on�guration �les, making the automati
 
reation of su
h �les possible. Until then, the
on�guration module is intended for TOPl internal use only, while sele
ted �les from our
on�guration library are provided as part of the Aurora produ
t release.Analysis module.Analysis module, 
urrently nonexistent, 
an be thought of as a 
olle
tion of spe
ial purposetra�
 appli
ations relying on simulation data. These 
ould in
lude performan
e 
omparisonbetween two or more simulations; shortest path 
al
ulation based on a
tual travel time;demand management; fee 
omputation for tolled lanes or roads, et
.One of TOPl's �rst goals is to implement the dynami
 trip assignment (DTA) appli
ation.We have a model of 
orridor 
omprising freeways and arterials. The 
orridor is modeled asa dynami
al system (CTM). Underlying the dynami
al system is a road network 
onsistingof nodes and links. A subset of node-pairs is identi�ed as a set of origin-destination (OD)pairs. Asso
iated with ea
h OD pair are two entities:1. demand pro�le�fun
tion of time that gives for ea
h t the �ow of vehi
les that startat the origin at t and wish to travel to the destination;2. set of paths or routes through the network that start at the origin and end at thedestination that a vehi
le is likely to take.
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h OD pair and time t, the assignment spe
i�es how many of the vehi
les will travel overea
h path asso
iated with the OD pair.Two types of trip assignments are important.
• User equilibrium (UE)�if no individual vehi
le 
an redu
e its travel time given thateveryone else follows the trip assignment (Wardrop's �rst prin
iple).
• System optimal (SO)�if it minimizes the total travel time summed over all demandpro�les (Wardrop's se
ond prin
iple).In general, UE and SO are di�erent, and

TUE ≥ TSO,where TUE denotes total travel time under UE, and TSO denotes total travel time under SO.Currently, in the literature we 
an �nd des
ription of the standard trip assignment problem[22℄, in whi
h the demand is stationary (does not depend on time) and there are no dynami
s:the delay on a link is simply a fun
tion of �ow on that link. For su
h problems, both, UEand SO trip assignments are 
omputed. Trip assignment problems using dynami
al system(CTM) as a model are presented in [112, 81℄, but they fo
us solely on SO, be
ause 
omputingUE is mu
h more di�
ult.We would like to be able to dynami
ally 
ompute both, UE and SO trip assignments,obtaining �
ost of anar
hy� as (TUE/TSO).
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Chapter 6
Resear
h Plan
The main short term resear
h and development goal is to make Aurora a �produ
t� that 
anbe made available to the users outside the TOPl group. This requires �nishing the simulatorand implementing 
on�guration module. In the initial version, the simulator is missing signal
ontrollers for arterial jun
tions, 
al
ulation of the a
tual travel time for user spe
i�ed paths,and proper simulation data storage fa
ility. The 
on�guration module must be developedas a GIS appli
ation using layer databases provided by regional planning agen
ies as input�les, with additional fo
us on a 
onvenient road network editor that allows bulk provisioningof node and link parameters. Enabling the simulator to handle origin-destination matri
esinstead of demand and split ratio pro�les as alternative input data, and developing dynami
tra�
 assignment appli
ation as a �rst part of the analysis module, 
an be 
onsidered thenext step. This summarizes the short term TODO list for Aurora development.
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ussion in Chapter 3, we 
an pose a problem of �nding a 
ontrol strategythat keeps freeway tra�
 density at desired levels when demands are not known exa
tly, butonly the bounds on demand values are given. CTM 
an be treated as pie
ewise a�ne systemwhose rea
hable set1 
an be 
omputed using available te
hniques. The overview of existingmethods and tools for rea
hability analysis is provided in [68℄. Depending on the systemdimension, it makes sense to use either polytope library of the Multi Parametri
 Toolbox(MPT) [69℄ or Ellipsoidal Toolbox (ET) [68℄2 to 
ompute rea
hable sets and devise 
ontrolstrategies under un
ertain demands. Another problem to be investigated, is the extensionof Chapter 3 results to a network model [40℄.In November, 2006, Caltrans laun
hed an ambitious program to design 
ongestion-redu
ingoperational improvements fo
using on demand and in
ident management, besides rampmetering and traveler information.One way to manage demand is through tolls. The traditional theory of tolls [21, 25℄ o�erslittle pra
ti
al guidan
e. First, it models 
ongestion by stati
 �ow-delay 
urve that doesnot re�e
t queues formed on freeways. Se
ond, the theorem that e�
ien
y requires everylink in a freeway to be tolled so as to equate private and so
ial marginal 
ost is not usefulin the pra
ti
al situation in whi
h only some lanes on a freeway link are tolled. As Kellyobserves in [65℄, �if values of time are heterogeneous or if not all links 
an be tolled, thenthe mathemati
al problem [of �nding optimum tolls℄ be
omes non-
onvex and harder: theremay be several radi
ally di�erent 
andidates for the system optimum, with slight 
hanges
1Set of states to whi
h the system 
an be steered using all admissible inputs from a given initial 
onditionin given number of time steps.
2Currently, ET is distributed as part of MPT, whi
h has evolved into a repository of hybrid systems
ontrol tools.
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i�
ation 
ausing one or another to be preferred.�Queues, missing in the traditional model, were introdu
ed as point queues at bottlene
ks andanalyzed in [107, 96, 17℄. The main theorem is that the dead-weight loss from queuing delay
an be eliminated by a time-varying toll. But, as noted in [107℄, point queues do not modelthe spillover situation in whi
h �the queue ba
ked up from the bottlene
k interferes with the�ow of tra�
 not itself intending to use the bottlene
k fa
ility.� The spillover situation isstudied in [16, 72, 109℄ for a simple network of two origins, one destination and three links,using kinemati
 waves to model 
ongestion propagation. The analysis exhibits situations inwhi
h ramp-metering and tolls both redu
e total travel time. It seems worthwhile to studydi�erent toll strategies and their impa
t on freeway performan
e within Aurora framework[105℄.In
ident management 
omprises four steps as identi�ed by the Federal Highway Adminis-tration: in
ident dete
tion, in
ident response, in
ident 
learan
e, tra�
 management andtraveler information. Studies have shown that approximately 80% of reported in
idents arevehi
le disablements, with minor a

idents a

ounting for only 10% of these in
idents. Therapid 
learan
e of these in
idents, therefore, not only redu
es motorist delays, but also re-du
es the probability of se
ondary in
idents whi
h are often more serious than the primaryones.Aurora is a suitable framework for developing and testing time saving in
ident dete
tionalgorithms as well as investigating the impa
t of 
ertain in
ident response strategies on theoverall freeway performan
e.
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e Aurora is designed as multi-purpose framework, road network is only one of its possibleappli
ations. The goal is to try it for a di�erent problem. For example, modeling irrigationnetworks of open-water 
hannels, that are used throughout the world to support agri
ulturala
tivity. Traditionally, open-water 
hannel dynami
s are des
ribed by the so-
alled Saint-Venant equations [26℄, nonlinear hyperboli
 PDE, whi
h represent a mass and momentumbalan
e along the length of ea
h 
anal. Computational s
heme for su
h equations is dis
ussedin [15℄, while important aspe
ts of automating large-s
ale irrigation networks, in
luding
hannel modeling and 
ontrol, are 
onsidered in [29℄.On
e it is established in pra
ti
e that Aurora is a true multi-purpose framework, i.e., it 
ansupport infrastru
ture networks of di�erent types, it would be interesting to learn how thesedi�erent type networks 
an intera
t and in�uen
e ea
h other. Su
h intera
tion 
an be usedto model the emergen
y response and eva
uation planning for potential disaster areas as inthe Minnesota Eva
uation Proje
t [12℄.Another appli
ation of heterogeneous infrastru
ture would be simultaneous modeling of roadnetwork tra�
 and publi
 transit. It will help to study the in�uen
e of publi
 transit ontra�
 �ow patterns and identify areas where the largest impa
t 
an be made.



150
Appendix A
Con�guration File Format forCTMSIM
Con�guration �le for CTMSIM is a .matMATLAB �le that 
ontains the following variables.

• 
elldata (stru
t, 1 × N) - Array of freeway 
ell data stru
tures. N is the numberof 
ells.
• freeway (
har) - String with freeway name or des
ription.
• TS (double, ≥ 0) - Sampling period. Must be no greater than min

( 
ell lengthfree flow speed).
• plotTS (double, ≥TS) - Time period for plotting simulated data.
• timeout (double, ≥ 0) - Time interval between plot refreshing.
• initialDensities (double, N × 1, ≥ 0) - Ve
tor of initial densities.
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• inflow (double, ≥ 0) - Flow entering the �rst 
ell through mainline.
• outflow (double, ≥ 0) - Flow that is allowed to leave the last 
ell through mainline.
• taxislim (double, ≥ 0) - Upper limit for time axis in time series plots measured inplotted time steps.
• densityCMF (double, 1024 × 3) - Color map for time series density 
ontour.
• flowCMF (double, 1024 × 3) - Color map for time series �ow 
ontour.
• orflowCMF (double, 1024 × 3) - Color map for time series on-ramp �ow 
ontour.
• orqueueCMF (double, 1024 × 3) - Color map for time series on-ramp queue 
ontour.
• frflowCMF (double, 1024 × 3) - Color map for time series o�-ramp �ow 
ontour.
• frbetaCMF (double, 1024×3) - Color map for time series o�-ramp split ratio 
ontour.
• speedCMF (double, 1024 × 3) - Color map for time series speed 
ontour.
• vhtCMF (double, 1024 × 3) - Color map for time series VHT 
ontour.
• vmtCMF (double, 1024 × 3) - Color map for time series VMT 
ontour.
• yoColorRatio (double, [0, 1]) - Array of two numbers that indi
ate fra
tions of 
a-pa
ity the �ow must a
hieve in free �ow or 
ongested mode to make 
ell 
olor yellowor orange.
• demandProfile (double, K × (N + 2), ≥ 0) - Array of on-ramp demand values for Ksamples.
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• demandTS (double, ≥TS) - Sampling time for the on-ramp demands in demandProfile.
• betaProfile (double, K×(N+2), ≥ 0) - Array of o�-ramp split ratios for K samples.
• betaTS (double, ≥TS) - Sampling time for the split ratios in betaProfile.
• frflowProfile (double, K × (N + 2), ≥ 0) - Array of o�-ramp �ows for K samples.
• frflowTS (double, ≥TS) - Sampling time for the o�-ramp �ows in frflowProfile.
• maxSimStep (double, ≥ 0) - Maximum simulation step.
• maxSimTime (double, ≥ 0) - Maximum simulation time.
• dataFile (
har) - Name of the �le where simulation data is to be saved.The only mandatory variable that must be present in a 
on�guration �le is 
elldata -array of freeway 
ell data stru
tures. Other 
on�guration variables are optional. VariablesmaxSimStep, maxSimTime and dataFile make di�eren
e only when CTMSIM runs in bat
hmode.Des
ription of the 
ell data stru
ture follows.
• 
ell.PMstart (double, ≥ 0) - Post mile at 
ell start.
• 
ell.PMend (double, ≥ 0) - Post mile at 
ell end. Condition 
ell.PMstart >
ell.PMend implies that tra�
 moves from right to left.
• 
ell.lanes (double, ≥ 0) - Number of lanes. Auxiliary lanes are represented asfra
tions.



153
• 
ell.FDfmax (double, ≥ 0) - Maximum 
apa
ity.
• 
ell.FDrho
rit (double, ≥ 0) - Criti
al density.
• 
ell.FDrhojam (double, ≥
ell.FDrhojam) - Jam density. All three fundamental dia-gram parameters, 
ell.FDfmax, 
ell.FDrho
rit and 
ell.FDrhojam are 
onsideredto be total, not per lane.
• 
ell.ORname (
har) - Name of the on-ramp. Empty, if the 
ell has no on-ramp.
• 
ell.ORlanes (double, ≥ 0) - Number of on-ramp lanes.
• 
ell.ORflow (double, ≥ 0) - On-ramp �ow.
• 
ell.ORfmax (double, ≥ 0) - On-ramp 
apa
ity.
• 
ell.ORqsize (double, ≥ 0) - On-ramp queue size.
• 
ell.ORgamma (double, ≥ 0) - On-ramp �ow blending 
oe�
ient (default: 1).
• 
ell.ORxi (double, ≥ 0) - On-ramp �ow allo
ation parameter (default: 1).
• 
ell.ORknob (double, ≥ 0) - Coe�
ient that adjusts on-ramp demand.
• 
ell.ORml
ontroller (stru
t) - On-ramp mainline 
ontroller stru
ture (default:null).
• 
ell.ORq
ontroller (stru
t) - On-ramp queue 
ontroller stru
ture (default: null).
• 
ell.FRname (
har) - Name of the o�-ramp. Empty, if the 
ell has no o�-ramp.
• 
ell.FRlanes (double, ≥ 0) - Number of o�-ramp lanes.
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• 
ell.FRbeta (double, ≥ 0) - O�-ramp split ratio.
• 
ell.FRfmax (double, ≥ 0) - O�-ramp 
apa
ity.
• 
ell.FRknob (double, ≥ 0) - Coe�
ient that adjusts o�-ramp �ow.On-ramp mainline 
ontroller stru
tures are expe
ted to have �ve mandatory �elds, whi
hare
• ml
ontroller.id (int) - Controller identi�er. Must 
orrespond to the number in themainline 
ontroller list (see Se
tion 4.2.3).
• ml
ontroller.name (
har) - String with 
ontroller name. Must be nonempty.
• ml
ontroller.TS (double, ≥ 0) - Time period at whi
h 
ontroller must be invoked.
• ml
ontroller.Cmin (double, ≥ 0) - Minimum �ow re
ommended by the 
ontroller(default: 0).
• ml
ontroller.Cmax (double, ≥ 0) - Maximum �ow allowed by the 
ontroller.Other stru
ture �elds 
an be optionally de�ned by the user.On-ramp queue 
ontroller stru
tures are expe
ted to have two mandatory �elds, whi
h are
• q
ontroller.id (int) - Controller identi�er. Must 
orrespond to the number in thequeue 
ontroller list (see Se
tion 4.2.3).
• q
ontroller.name (
har) - String with 
ontroller name. Must be nonempty.Other stru
ture �elds 
an be optionally de�ned by the user.
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Appendix B
XML S
hema for AuroraCon�guration
<?xml version="1.0" en
oding="UTF-8" ?><xs:s
hema xmlns:xs="http://www.w3.org/2001/XMLS
hema"><xs:element name="AuroraHWC"><xs:
omplexType><xs:sequen
e><xs:element ref="network" /><xs:element ref="settings" /><xs:element ref="DemandProfile" /><xs:element ref="EventList" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="network"><xs:
omplexType><xs:sequen
e><xs:element ref="des
ription" /><xs:element ref="MonitorList" /><xs:element ref="NodeList" />



156<xs:element ref="LinkList" /><xs:element ref="ODList" /></xs:sequen
e><xs:attribute name="name" type="xs:string" use="required" /><xs:attribute name="
ontrolled" type="xs:boolean" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /><xs:attribute name="top" type="xs:boolean" use="required"default="false" /><xs:attribute name="tp" type="xs:de
imal" use="required" /><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="settings"><xs:
omplexType><xs:sequen
e><xs:element ref="display" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="DemandProfile" minO

urs="0" maxO

urs="1"><xs:
omplexType><xs:sequen
e><xs:element ref="demand" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="EventList" minO

urs="0" maxO

urs="1"><xs:
omplexType><xs:sequen
e><xs:element ref="event" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="des
ription" type="xs:string" /><xs:element name="MonitorList" minO

urs="0" maxO

urs="1"><xs:
omplexType><xs:sequen
e><xs:element ref="monitor" minO

urs="0" maxO

urs="unbounded" /></xs:sequen
e>



157</xs:
omplexType></xs:element><xs:element name="NodeList"><xs:
omplexType><xs:sequen
e><xs:
hoi
e><xs:element ref="node" maxO

urs="unbounded" /><xs:element ref="network" maxO

urs="unbounded" /></xs:
hoi
e></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="LinkList"><xs:
omplexType><xs:sequen
e><xs:element ref="link" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="ODList" minO

urs="0" maxO

urs="1"><xs:
omplexType><xs:sequen
e><xs:element ref="od" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="monitor"><xs:
omplexType mixed="true"><xs:attribute name="name" type="xs:string" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="node"><xs:
omplexType><xs:sequen
e><xs:element ref="des
ription" /><xs:element ref="outputs" /><xs:element ref="inputs" />



158<xs:element ref="position" /></xs:sequen
e><xs:attribute name="name" type="xs:string" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="link"><xs:
omplexType><xs:sequen
e><xs:element ref="begin" minO

urs="0" maxO

urs="1" /><xs:element ref="end" minO

urs="0" maxO

urs="1" /><xs:element ref="fd" /><xs:element ref="density" /><xs:element ref="dynami
s" /><xs:element ref="position" /><xs:element ref="demand" /><xs:element ref="qmax" /></xs:sequen
e><xs:attribute name="lanes" type="xs:de
imal" use="required" /><xs:attribute name="length" type="xs:de
imal" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="od"><xs:
omplexType><xs:sequen
e><xs:element ref="PathList" /></xs:sequen
e><xs:attribute name="begin" type="xs:integer" use="required" /><xs:attribute name="end" type="xs:integer" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /></xs:
omplexType></xs:element><xs:element name="outputs"><xs:
omplexType><xs:sequen
e><xs:element ref="output" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType>



159</xs:element><xs:element name="inputs"><xs:
omplexType><xs:sequen
e><xs:element ref="input" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="position"><xs:
omplexType><xs:sequen
e><xs:element ref="point" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="begin"><xs:
omplexType><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="end"><xs:
omplexType><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="fd"><xs:
omplexType><xs:attribute name="densityCriti
al" type="xs:de
imal"use="required" /><xs:attribute name="flowMax" type="xs:de
imal" use="required" /><xs:attribute name="densityJam" type="xs:de
imal" use="required" /></xs:
omplexType></xs:element><xs:element name="density" type="xs:de
imal" /><xs:element name="dynami
s"><xs:
omplexType><xs:attribute name="
lass" type="xs:string" use="required" />



160</xs:
omplexType></xs:element><xs:element name="demand"><xs:
omplexType mixed="true"><xs:attribute name="knob" type="xs:de
imal" use="required" /><xs:attribute name="tp" type="xs:de
imal" use="optional" /><xs:attribute name="id" type="xs:integer" use="optional" /></xs:
omplexType></xs:element><xs:element name="qmax" type="xs:de
imal" /><xs:element name="PathList"><xs:
omplexType><xs:sequen
e><xs:element ref="path" maxO

urs="unbounded" /></xs:sequen
e></xs:
omplexType></xs:element><xs:element name="output"><xs:
omplexType><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="input"><xs:
omplexType><xs:sequen
e><xs:element ref="splitratios" /><xs:element ref="
ontroller" /></xs:sequen
e><xs:attribute name="id" type="xs:integer" use="required" /></xs:
omplexType></xs:element><xs:element name="path"><xs:
omplexType mixed="true"><xs:attribute name="name" type="xs:string" use="required" /><xs:attribute name="
lass" type="xs:string" use="required" /></xs:
omplexType></xs:element>



161<xs:element name="display"><xs:
omplexType><xs:attribute name="timeMax" type="xs:de
imal" use="required" /><xs:attribute name="tsMax" type="xs:integer" use="required" /><xs:attribute name="timeout" type="xs:integer" use="required" /><xs:attribute name="tp" type="xs:de
imal" use="required" /></xs:
omplexType></xs:element><xs:element name="event"><xs:
omplexType><xs:
hoi
e><xs:element ref="demand" /><xs:element ref="des
ription" /><xs:element ref="fd" /><xs:element ref="srm" /></xs:
hoi
e><xs:attribute name="tstamp" type="xs:de
imal" use="required" /><xs:attribute name="neid" type="xs:integer" use="required" /><xs:attribute name="enabled" type="xs:boolean" use="required"default="true" /><xs:attribute name="
lass" type="xs:string" use="required" /></xs:
omplexType></xs:element><xs:element name="point"><xs:
omplexType><xs:attribute name="x" type="xs:de
imal" use="required" /><xs:attribute name="y" type="xs:de
imal" use="required" /><xs:attribute name="z" type="xs:de
imal" use="required" /></xs:
omplexType></xs:element><xs:element name="splitratios"><xs:
omplexType mixed="true" /></xs:element><xs:element name="
ontroller"><xs:
omplexType><xs:sequen
e><xs:element ref="parameter" minO

urs="0" maxO

urs="unbounded" /><xs:element ref="limits" /><xs:element ref="q
ontroller" /></xs:sequen
e>



162<xs:attribute name="
lass" type="xs:string" use="required" /><xs:attribute name="tp" type="xs:de
imal" use="required" /></xs:
omplexType></xs:element><xs:element name="parameter"><xs:
omplexType><xs:attribute name="name" type="xs:string" use="required" /><xs:attribute name="value" type="xs:string" use="required" /></xs:
omplexType></xs:element><xs:element name="limits"><xs:
omplexType><xs:attribute name="
min" type="xs:de
imal" use="required" /><xs:attribute name="
max" type="xs:de
imal" use="required" /></xs:
omplexType></xs:element><xs:element name="q
ontroller"><xs:
omplexType><xs:sequen
e><xs:element ref="parameter" minO

urs="0" maxO

urs="unbounded" /></xs:sequen
e><xs:attribute name="
lass" type="xs:string" use="required" /></xs:
omplexType></xs:element><xs:element name="srm"><xs:
omplexType><xs:sequen
e><xs:element ref="splitratios" /></xs:sequen
e></xs:
omplexType></xs:element></xs:s
hema>
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